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Notation 
(L=length, M=mass, T=time) 

ai,j length of the moment arm for the i,j column in a potential failure mass, relative to the axis of 
rotation, (L) 

aFX  one of the parameters describing the shape of the Fredlund and Xing (1994) soil-water  
  characteristic curve, (ML-1T-2) 

A  total area of a trial slip surface, (L2) 

Ac  total area of the trial slip surface for a column in a potential failure mass, (L2) 

Ah  horizontal area of a trial slip surface, (L2) 

  horizontal area of the trial slip surface for the i,j column in a potential failure mass, (L2) 

Ai,j  area of the trial slip surface for the i,j column in a potential failure mass, (L2) 

c  cohesion of an earth material, (ML-1T-2) 

ci,j  cohesion on the trial slip surface for the i,j column in a potential failure mass, (ML-1T-2) 

C(ψ)  correction factor for Fredlund and Xing (1994) soil-water characteristic curve 
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 xii 

cellsize length of one side of a square Esri ASCII raster grid cell in a digital elevation model (DEM), equal 
to Δx and Δy, (L) 

ei,j length of horizontal driving force moment arm for the i,j column in a potential failure mass, 
relative to the axis of rotation, used for pseudo-static analysis of earthquake loading, (L) 

F  factor of safety, (dimensionless) 

Fi  initial estimate of factor of safety, used in Bishop’s simplified method of analysis, (dimensionless) 

Fmin  minimum factor of safety computed during the current search, (dimensionless) 

Fnew current factor of safety computed during the iterative process in Bishop’s simplified method of 
analysis, (dimensionless) 

Fold previous factor of safety computed during the iterative process in Bishop’s simplified method of 
analysis, (dimensionless) 

FO  factor of safety found using the Ordinary (Fellenius) method of analysis, (dimensionless) 

Frel  relative factor of safety defined as F / Fmin , (dimensionless) 

g  magnitude of gravitational acceleration, (LT-2) 

h  pore-water (or fluid) pressure head, (L) 

H  height of hillslope or embankment, (L) 

i integer counter for location of search-lattice node, grid cell, or 3D data in the x-direction, 
(dimensionless) 

j integer counter for location of search-lattice node, grid cell, or 3D data in the y-direction, 
(dimensionless) 

k  integer counter for location of search-lattice node or 3D data in the z-direction, (dimensionless) 

keq horizontal pseudo-acceleration coefficient for earthquake loading, expressed as a fraction of g, 
(dimensionless) 

mα term for part of the computation of normal force acting on a trial slip surface, used in Bishop’s 
simplified method of analysis, (dimensionless) 

term for part of the computation of normal force acting on the trial slip surface of the i,j column in 
a potential failure mass, used in Bishop’s simplified method of analysis, (dimensionless) 

mFX one of the parameters describing the shape of the Fredlund and Xing (1994) soil-water 
characteristic curve, (dimensionless) 

Md  driving moment of a potential failure mass around axis of rotation, (ML2T-2) 

Md,earthquake driving moment due to horizontal force from earthquake loading, (ML2T-2) 

Md,gravity  driving moment due to weight of potential failure mass, (ML2T-2) 

Mr  resisting moment of a potential failure mass around axis of rotation, (ML2T-2) 

nFX one of the parameters describing the shape of the Fredlund and Xing (1994) soil-water 
characteristic curve, (dimensionless) 

nvG one of the parameters describing the shape of the van Genuchten (1980) soil-water characteristic 
curve, a measure of the soil pore-size distribution, (dimensionless) 

Ni,j  normal force acting on the trial slip surface of the i,j column in a potential failure mass, equal to 
  , (MLT-2)           
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ru  pore-pressure ratio, defined as ratio of pore pressure to total vertical stress, (dimensionless) 

R  radius of a sphere containing a trial slip surface, (L) 

Ri,j distance from the axis of rotation to the center of trial slip area for the i,j column in a trial failure 
mass, (L) 

s  shear strength, or mobilized shear resistance, of an earth material, (ML-1T-2) 

si,j mobilized shear strength for the basal slip surface of the i,j column in a potential failure mass,  
(ML-1T-2) 

Se effective degree of saturation of an earth material, used for estimating suction-stress effects, 
(dimensionless) 

Si,j resisting shear force acting against slip on the trial slip surface of the i,j column in a potential 
failure mass, (MLT-2) 

S0, S2 surface areas of the two parallel sides of a partial column above the trial slip surface in a potential 
failure mass, (L2) 

S1 surface area of a vertical cross section through the middle of a partial column above the trial slip 
surface in a potential failure mass, (L2) 

T  average resisting shear force at equilibrium over a trial slip surface, (ML T-2) 

u  pore-water pressure, negative values denote matric suction, (ML-1T-2) 

Vc  volume of each column (partial or full) above a trial slip surface, (L3) 

Wc  weight of a column in a potential failure mass, (MLT-2) 

Wi,j  weight of the i,j column in a potential failure mass, (MLT-2) 

x, y  horizontal orthogonal coordinates, (L) 

xllcorner spatial coordinate in the x-direction of the lower left (southwest) corner of an Esri ASCII raster 
grid, such as a digital elevation model (DEM), (L) 

yllcorner spatial coordinate in the y-direction of the lower left (southwest) corner of an Esri ASCII raster 
grid,   such as a digital elevation model (DEM), (L) 

z  vertical coordinate, (L) 

zpz  vertical depth beneath a piezometric surface, (L) 

α  local apparent dip angle in the direction of slip on a trial surface, (º) 

αi,j apparent dip of the column base in the direction of slip for the i,j column in a potential failure mass, 
(º) 

αm local apparent dip angle in the direction of slip on a trial surface for the column in a potential 
failure mass with the maximum negative θ value, used for computing ß3D when there are negative θ 
values, (º) 

αvG one of the parameters describing the shape of the van Genuchten (1980) soil-water characteristic 
curve, related to the inverse of the air entry suction, (LT2M-1) 

ß3D quantity used for estimating initial factor of safety, Fi, in Bishop’s simplified method of analysis, 
(dimensionless) 

δ azimuthal angle of the slip movement direction, measured counterclockwise from zero in the 
positive x direction, (º) 



 xiv 

ɛ  local dip angle on trial slip surface, positive in the direction of sliding, (º) 

ɛi,j  dip direction on the trial slip surface for the i,j column in a potential failure mass, (º) 

ɛm dip angle on trial slip surface for the column in a potential failure mass with the maximum negative 
ɛ value, used for computing ß3D when negative ɛ values occur, (º) 

ϕ  angle of internal friction of an earth material, (º) 

ϕi,j  angle of internal friction on trial slip surface for the i,j column in a potential failure mass, (º) 

ϕm angle of internal friction on trial slip surface for the column in a potential failure mass with the 
maximum negative θ value, used for computing ß3D when there are negative θ values, (º) 

γ   unit or specific weight of an earth material, weight per unit volume, (ML-2T-2) 

γd  unit weight of a dry earth material, weight per unit volume, (ML-2T-2) 

γps  unit weight of a partially saturated earth material, weight per unit volume, (ML-2T-2) 

γs  unit weight of a saturated earth material, weight per unit volume, (ML-2T-2) 
γ
t  total unit weight (solid plus fluid) of an earth material, weight per unit volume, (ML-2T-2) 

γw  unit weight of pore water (or pore fluid), weight per unit volume, (ML-2T-2) 

λ  ratio of cohesive to frictional material strength, defined as c / γ H tanϕ, (dimensionless) 

θ  volumetric water content of an earth material, (dimensionless) 

θr  residual volumetric water content of an earth material, (dimensionless) 

θs  saturated volumetric water content of an earth material, (dimensionless) 

σn  normal stress acting on a trial slip surface, (ML-1T-2) 

  normal stress acting on the trial slip surface for the i,j column in a potential failure mass, 
  (ML-1T-2) 

τ  shear stress required to maintain equilibrium along a trial slip surface, (ML-1T-2) 

ψ matric suction, note that suction is negative pore pressure relative to atmospheric pressure,  
(ML-1T-2) 

ψr residual matric suction, note that suction is negative pore pressure relative to atmospheric 
pressure, (ML-1T-2) 
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Scoops3D: Software to Analyze Three-Dimensional Slope 
Stability Throughout a Digital Landscape 

By Mark E. Reid, Sarah B. Christian, Dianne L. Brien, and Scott T. Henderson 

Abstract 
The computer program, Scoops3D, evaluates slope stability throughout a digital landscape represented by 

a digital elevation model (DEM). The program uses a three-dimensional (3D) method of columns approach to 

assess the stability of many (typically millions) potential landslides within a user-defined size range. For each 

potential landslide (or failure), Scoops3D assesses the stability of a rotational, spherical slip surface 

encompassing many DEM cells using a 3D version of either Bishop’s simplified method or the Ordinary 

(Fellenius) method of limit-equilibrium analysis. Scoops3D has several options for the user to systematically and 

efficiently search throughout an entire DEM, thereby incorporating the effects of complex surface topography. In 

a thorough search, each DEM cell is included in multiple potential failures, and Scoops3D records the lowest 

stability (factor of safety) for each DEM cell, as well as the size (volume or area) associated with each of these 

potential landslides. It also determines the least-stable potential failure for the entire DEM. The user has a variety 

of options for building a 3D domain, including layers or full 3D distributions of strength and pore-water 

pressures, simplistic earthquake loading, and unsaturated suction conditions. Results from Scoops3D can be 

readily incorporated into a geographic information system (GIS) or other visualization software. This manual 

includes information on the theoretical basis for the slope-stability analysis, requirements for constructing and 

searching a 3D domain, a detailed operational guide (including step-by-step instructions for using the graphical 

user interface [GUI] software, Scoops3D-i) and input/output file specifications, practical considerations for 

conducting an analysis, results of verification tests, and multiple examples illustrating the capabilities of 

Scoops3D. Easy-to-use software installation packages are available for the Windows or Macintosh operating 

systems; these packages install the compiled Scoops3D program, the GUI (Scoops3D-i), and associated 

documentation. Several Scoops3D examples, including all input and output files, are available as well. The source 

code is written in the Fortran 90 language and can be compiled to run on any computer operating system with an 

appropriate compiler. 
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Chapter 1.  Introduction 
1.1. Purpose and Scope 

Scoops3D is a computer program, developed by the U.S. Geological Survey (USGS), for analyzing slope 

stability throughout a digital landscape, as represented by a digital elevation model or DEM. It can systematically 

search a digital landscape and compute the stability of millions of three-dimensional (3D) potential landslides 

encompassing a wide range of depths and volumes that potentially affect different parts of the DEM. After this 

search, every DEM cell (except for those at the edges of the DEM) will have been included in a number of 

potential slope failures (landslides). An example of one potential slip surface intersecting a DEM is shown in 

figure 1.1. Results from Scoops3D analyses show the minimum factor of safety (an indicator of stability) for the 

potential slip surfaces affecting each DEM cell throughout the landscape, as well as the volumes or areas 

associated with these potential slope failures. The results represent an amalgamation of the least-stable 3D 

potential slope failures (fig. 1.2). Scoops3D uses a 3D “method of columns” limit-equilibrium analysis to 

compute the stability of potential slope failures (landslides) with a spherical potential slip surface. The user 

selects the landslide size range (in either area or volume) of interest. Scoops3D has a wide variety of user options: 

it can incorporate complex topography, full 3D distributions of parameters, including subsurface material 

properties and pore-water pressures, and simplistic earthquake loading effects. Our approach was originally 

described in Reid and others (2000) and has been further developed as described in this manual. 

 
 

Figure 1.1. Perspective view of a digital elevation model (DEM) grid showing a potential failure with mass removed. The 
rotational center defining the spherical potential failure surface is a node above the DEM. Scoops3D uses a search lattice 
(one layer is shown) above the DEM to construct and analyze many different potential failures affecting all parts of the model. 
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Figure 1.2. Four perspective views showing stability results from a Scoops3D analysis draped on digital topography and 
examples of three potential slip surfaces with potential failure masses removed. A, Lowest factor of safety found for each 
digital elevation model (DEM) cell. The results represent an amalgamation of the factors of safety computed for many 
potential slope failures. B, Potential slope failure with lowest factor of safety for entire DEM (global minimum). Slip surface 
shown in red with potential failure mass removed. C and D, Two other potential slope failures that are the least stable for 
select cells of the DEM. Note that the potential failures shown in B, C, and D overlap, but only the area encompassed by 
potential failure with the global minimum factor of safety (B) is portrayed in its entirety in A. The other two potential failures are 
only partially present in A; they are superseded in part by other potential failures with lower factors of safety. 

Digital elevation representations of topography are readily available for many parts of the world, and 

Scoops3D uses a DEM as the foundation for its 3D slope-stability analysis. A number of other models use DEM 

topography to compute stability using a one-dimensional (1D) infinite slope analysis on a DEM cell-by-cell basis 

(Montgomery and Dietrich, 1994; Wu and Sidle, 1995; Pack and others, 1998; Baum and others, 2010) or a two-

dimensional (2D) stability analysis on a series of cross sections through a DEM (Miller, 1995; Miller and Sias, 

1998). Some approaches use DEM topography in a Geographical Information System (GIS) framework to 

compute 3D stability (Xie and others, 2006a; Xie and others, 2006b). One- or two-dimensional computations of 

slope stability of uniform hillslopes are commonly more conservative (in other words, indicate lower stability) 

than 3D results (Cavounidis, 1987; Duncan, 1996), and therefore may be useful in engineering design. 

Nevertheless, there are several compelling reasons to use a 3D analysis to assess slope stability. Actual slope 

failures have an inherently 3D geometry, and a potentially more accurate 3D analysis can be advantageous for 

scientific inquiry or back analysis of an actual slope failure. Moreover, a 3D approach can integrate the effects of 
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topography, strength, and pore pressures over potential failure areas larger than a single DEM cell. Lateral 

variation of these properties within a potential failure mass may significantly affect stability and thus render 1D 

and 2D computations inaccurate (Hungr, 1987; Stark and Eid, 1998; Bromhead and others, 2002). Furthermore, 

using 3D analysis provides direct estimates of potential failure volumes—a crucial element for many hazard 

assessments, sediment budgets, or initial conditions for landslide runout models. 

We designed Scoops3D to address several problems. It can compute relative slope stability throughout a 

landscape using the best available information and thereby aid regional evaluations of landslide susceptibility or 

hazard. It can also be used as a screening tool to identify areas within the landscape having low stability that may 

warrant subsequent more detailed stability analysis. In addition, Scoops3D can be used to evaluate the differences 

in stability resulting from a series of plausible scenarios, such as effects of different 3D groundwater flow 

regimes or spatial variations in earth material properties. 

Scoops3D has been used to assess the stability of volcano edifices at Mount Rainer in Washington State 

(Reid and others, 2001), Volcan Casita in Nicaragua (Vallance and others, 2004), Augustine Volcano in Alaska 

(Reid and others, 2010a), and pre-collapse Mount St. Helens (Reid and others, 2000; Reid and others, 2010b). It 

has also been coupled with a 3D regional groundwater flow model and used to analyze the stability of coastal 

bluffs in Seattle, Washington (Brien and Reid, 2007; 2008). 

Scoops3D is written in the Fortran 90 language to enable fast computation and on-the-fly allocation of 

computer memory for variable problem sizes. This approach is more computationally efficient than directly 

performing calculations in a GIS framework. Compiled versions of the program run on a variety of computer 

operating systems, including Microsoft Windows, Apple Macintosh, and Linux. Our graphical user interface, 

Scoops3D-i, is written in the Python language and runs on either Windows or Macintosh systems; a compiled 

version of the interface is provided as part of the installation packages. The Scoops3D program, graphical user 

interface, user’s manual, and associated example files are available for download over the Internet: 

http://pubs.usgs.gov/tm/14/a01. 

This manual covers six areas in different chapters: 

• Chapter 2 - the theoretical basis for the program (including limit-equilibrium analysis methods). 

• Chapter 3 - requirements for building a 3D domain and searching the digital landscape. 

• Chapter 4 - a detailed guide to program operation (including installing and running the program, using the 

graphical user interface [Scoops3D-i], creating input files, and selecting output options). 

• Chapter 5 - practical considerations for performing and assessing the quality of a slope-stability analysis 

with Scoops3D. 

• Chapter 6 - verification tests demonstrating the accuracy of the stability calculations obtained using 

Scoops3D. 

• Chapter 7 - examples illustrating the features of Scoops3D. 

http://pubs.usgs.gov/tm/14/a01
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1.2. Capabilities and Limitations 

Scoops3D has the capability to determine the stability of all parts of a DEM; it does not just identify the 

potential failure with the overall lowest stability, as is common in many geotechnical approaches. This ability to 

thoroughly assess a DEM sets Scoops3D apart from most other 3D slope-stability models. Moreover, options in 

Scoops3D allow the user to easily perform multiple levels of analysis for different scenarios, such as determining 

the effects of topography alone and then adding detailed subsurface data as desired. The following list outlines 

some of the more significant capabilities and features of Scoops3D: 

• Provides map view data of the minimum stability for potential failure surfaces affecting each DEM 

cell and can provide a 3D distribution of stability underlying the DEM. 

• Provides volumes and (or) areas associated with the least-stable potential failure at each DEM cell. 

• Searches for potential failures given user-defined size (area or volume) limits. 

• Can compute the stability of potential failures sliding in any direction in the topography; slip 

directions do not need to be oriented with the axes of the DEM as required in many existing 

geotechnical software packages. 

• Includes partial columns on the boundary of a potential failure mass, enabling more accurate results 

using coarser DEM resolutions and thereby reducing computer memory requirements. 

• Incorporates coarse-to-fine search techniques to enhance computational efficiency; with these 

techniques, the time to search a DEM can be reduced by as much as 90 percent compared to a simple 

full search. 

• Includes the option to represent subsurface material properties as layers in Esri ASCII raster format, 

allowing easy integration with Geographical Information System (GIS) software, such as Esri’s 

ArcGIS. The ASCII format also allows creation of input files without needing a specific software 

package. 

• Includes the option to represent subsurface materials by full 3D distributions of earth material 

strength and weight. 

• Includes the option to simulate earthquake or seismic loading effects in a pseudo-static analysis. 

• Includes options to represent pore-water pressure effects either with pore-pressure ratios (relative to 

vertical stresses), a piezometric surface, or a full 3D distribution of pressure heads. The effects of full 

3D groundwater flow fields can be modeled by coupling results from separate groundwater flow 

models with Scoops3D. 

• Includes the option to incorporate fully 3D variably saturated groundwater flow fields and the effects 

of unsaturated suction stresses. 
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As with all models, Scoops3D has limitations. Because Scoops3D uses conventional limit-equilibrium 

slope-stability approaches, it is subject to the well-known limitations of these approaches, such as the assumption 

of rigid failure masses with a uniform factor of safety along all sections of the pre-defined potential slip surfaces 

(Krahn, 2003; Duncan and Wright, 2005). In Scoops3D, potential failure surfaces are limited to a spherical 

representation undergoing rotational slip. This shape represents the simplest physically plausible 3D slip surface 

and proves useful for a broad assessment of a DEM; however, it may not be appropriate for precise evaluation of 

tabular, dominantly translational slides or more complex slip surfaces geometries. Stability is computed in 

Scoops3D using 3D extensions of either the Ordinary (Fellenius) or Bishop’s simplified method. Neither of these 

methods, which are commonly used in geotechnical practice, computes a full 3D distribution of stresses within a 

hillslope, nor do they compute side forces between the columns in a potential failure mass. However, the 3D 

extension of Bishop’s simplified method does typically provide factors of safety very close to more rigorous 

limit-equilibrium methods (Hungr, 1987; Ugai, 1988; Lam and Fredlund, 1993). Estimates of material 

deformation and strain, progressive failure, and dynamic loading may be better simulated using other 

geotechnical modeling approaches (Duncan, 1996; Duncan and Wright, 2005). Nevertheless, limit-equilibrium 

methods have been used for many years in engineering applications and have been calibrated by experience and 

observations (Krahn, 2003). 

Scoops3D includes an option to analyze a single, specific potential failure surface, but does not include 

options to incorporate site-specific features such as tension cracks, external loads, non-linear strengths, partially 

submerged slopes, or complex failure-surface geometry. For most landscapes, it would be difficult to estimate the 

full 3D distribution of these site-specific features. Scoops3D does not require that potential failure surfaces exit or 

intersect a pre-defined point or layer. If any of these site-specific characteristics are important, then a stability 

analysis might be better performed using a commercially available 3D geotechnical slope-stability program such 

as CLARA-W (O. Hungr Geotechnical Research Inc., 2010), SVSlope (Fredlund and others, 2009), or TSLOPE 

(TAGA Engineering Software Services, 1984). 

In contrast to site-specific engineering analyses, Scoops3D provides a tool to thoroughly assess the 

stability of an entire digital landscape. Interpretation of results from a Scoops3D analysis requires a complete 

understanding of the limits of the methods of stability analysis and the effects of the input data, particularly 

potential failure size limits, material strengths, and pore-water pressures. Although we have tested Scoops3D 

using a variety of published examples, users should take care to determine that Scoops3D is providing reasonable 

results for their applications. To aid in this determination, we suggest that users start their analyses with simple 

cases (such as the assumption of homogeneous properties) to first examine the effects of topography on stability 

and then progressively advance to more complicated scenarios. Practical considerations for performing and 

examining the quality of analyses are provided in chapter 5 of this manual. 
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 Chapter 2. Basis of the Slope-Stability Analysis 
Scoops3D calculates slope stability by extending conventional limit-equilibrium analysis to three 

dimensions (3D) using a method of columns. Many established and well-tested geotechnical analyses rely on 

limit-equilibrium methods to assess slope stability (Duncan, 1996; Duncan and Wright, 2005). Although 2D 

approaches are quite common, fewer applications of the method exist for 3D analysis. In this section, we describe 

our implementation of limit-equilibrium analysis for computing stability in a 3D domain. 

Various 3D method-of-columns approaches have been described by other researchers (Hovland, 1977; 

Chen and Chameau, 1982; Hungr, 1987; Thomaz and Lovell, 1988; Ugai, 1988; Xing, 1988; Hungr and others, 

1989; Lam and Fredlund, 1993; Okimura, 1994; Yamagami and Jiang, 1997; Huang and Tsai, 2000; Huang and 

others, 2002; Chen and others, 2003; Xie and others, 2003a,b; Jiang and Yamagami, 2004; Xie and others, 2006a; 

Cheng and Yip, 2007). Such methods rely solely on assessing the static equilibrium (moments and [or] forces) of 

a predefined potential failure mass; they assume a priori both the geometry of the potential failure and its mode of 

failure (for example, rotational or translational sliding). Limit-equilibrium analyses, including those used in 

Scoops3D, do not determine the strains and (or) displacements affecting the potential failure mass. The 

predefined potential failure or slip surface is termed the trial surface1. Scoops3D uses trial surfaces composed of 

parts of a sphere and assumes rotational slip. A spherical trial surface represents the simplest 3D geometry 

unconstrained by internal structures, making it useful for regional stability analyses in which millions of trial 

surfaces may be examined in a DEM. A spherical arcuate surface has no sharp disruptions and forms a physically 

plausible potential shear surface. In materials without large contrasts or discontinuities in strength, failures are 

commonly arcuate (Hoek and Bray, 1981). 

Limit-equilibrium methods typically divide the potential failure mass into sections (vertical slices in 2D 

and vertical columns in 3D) so that shear resistance on the trial surface can be estimated for each section. Shear 

resistance (strength) provided by friction is a function of the normal stress acting on a trial surface (see section 

2.2). The 3D methods estimate normal stresses (or forces) at the base of each column where it intersects the trial 

surface; each column is assumed to be a rigid mass undergoing no internal deformation. Although dividing a 

potential failure mass into columns solves the issue of estimating normal forces on a curved trial surface, it leads 

to a statically indeterminate problem, in that some of the forces acting on the columns (such as normal and shear 

forces acting on the sides) are unknown. Thus, determining the forces acting on the trial surface of each column 

requires some assumptions about the side forces acting between columns. In this sense, the method is quasi-3D; it 

does not compute a full 3D stress field. Assumptions used to estimate side forces, and thus the basal normal 

forces acting on each section of a potential failure surface, constitute one of the primary distinguishing 

characteristics between different limit-equilibrium methods (for example, Duncan and Wright, 2005). 

                                                 
1Terms in bold italic are defined in section, “Glossary of Selected Terms.” 
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Limit-equilibrium methods assume failure occurs simultaneously along the trial slip surface, with no 

progressive failure. This implies that the factor of safety against sliding, F, is uniform everywhere along the trial 

slip surface and the forces computed for each section (column) are based on this assumption. Although these 

methods may lead to unrealistic local stresses on individual sections of the slip surface (Krahn, 2003), the global 

integration of all forces acting on the trial slip surface typically provides physically plausible values of F. 

Scoops3D allows the user to select between two well-known geotechnical moment equilibrium methods 

to compute the stability of a rotational trial surface: the Ordinary (Fellenius) method and Bishop’s simplified 

method (for example, Duncan and Wright, 2005). The two methods are computationally efficient and work well 

with 3D columns defined by a DEM. Both compute stability using moment equilibrium around an axis of 

rotation. Neither requires the computation of side forces acting between columns, and thus they avoid difficulties 

associated with computing side forces on column faces that are not aligned with the DEM grid (for example, 

Yamagami and Jiang, 1997). The methods differ primarily in how they estimate the normal force acting on the 

trial surface (see sections 2.3.1 and 2.3.2). 

Each method has advantages and disadvantages. The Ordinary (Fellenius) method always provides a 

factor-of-safety value for a given rotational trial surface. It does not require an iterative process to find a factor of 

safety and this speeds computation. Factor-of-safety values computed using the Ordinary method in 3D are 

commonly slightly lower (more conservative) than those determined by other limit-equilibrium methods (Ugai, 

1988; Lam and Fredlund, 1993) and this pattern tends to occur using Scoops3D as well. Although other 

investigators have shown that computed F values using the traditional Ordinary method in 2D can be 

unrealistically low if high pore-water pressures are present on the trial surface (Whitman and Bailey, 1967; 

Duncan and Wright, 1980, 2005), Scoops3D implements a slightly modified version of the Ordinary method (Lei 

and others, 2011) that provides more accurate F values with high pore pressures (see section 2.3.1). 

In comparison, Bishop’s simplified method provides factor-of-safety values similar to those found with 

more rigorous stability methods (such as the Spencer or Morgenstern-Price methods) in both 2D (Fredlund and 

Krahn, 1977; Duncan and Wright, 1980) and 3D (Hungr, 1987; Ugai, 1988; Lam and Fredlund, 1993). Bishop’s 

simplified method requires an iterative solution method to compute F, and the iteration process occasionally fails 

to converge on a solution or converges on a spurious (that is, incorrect) solution – particularly if the trial surface 

includes very steep slip sections or is affected by high pore-water pressures. Scoops3D allows the user to filter 

spurious solutions. In general, we recommend selecting Bishop’s simplified method because it provides more 

accurate solutions of F. If the user elects to use Bishop’s simplified method, Scoops3D will also automatically 

compute values using the Ordinary method for comparison. 
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The following sections in this chapter present more details about how Scoops3D analyzes slope stability, 

including: 

• Defining a potential 3D failure mass, slip direction, and weight distribution. 

• Defining shear strength acting on the potential failure surface. 

• General issues with computing 3D slope stability using a moment equilibrium analysis. 

• Detailed descriptions of both the Ordinary (Fellenius) and Bishop’s simplified methods extended to 

3D. 

• Incorporation of different pore-water pressure distributions and special cases. 

• Slope-stability calculations performed on 2D slices through a 3D mass. 

2.1. Potential Failure Mass, Slip Direction, and Weight 

To assess stability throughout a DEM, Scoops3D typically computes factor of safety values, F, for 

thousands to millions of potential failure masses. Methods for searching the DEM and determining the lowest 

stability for each DEM cell are described in the next chapter (section 3.2). Here, we present the process for 

defining one potential failure mass in the DEM and then computing the stability of this mass. 

Our analysis begins by defining a potential failure mass bounded by a trial surface that is part of a 

sphere. The center of this sphere can be any arbitrary point above the DEM. We then determine the DEM 

columns contained within the potential failure mass above the trial surface and beneath the DEM (fig. 2.1). This 

mass is composed of an ensemble of 3D vertical columns; the locations and horizontal dimensions of full 

columns within the mass are defined by the DEM grid orientation and cell size, allowing easy integration with the 

DEM. Some of the columns along the edge of the potential failure mass may be only partly contained within the 

bounds of the sphere. Scoops3D includes partial columns in the stability computation of the mass if two or three 

corners of the column at the ground surface are contained within the spherical trial surface. Column corner 

elevations are computed as the average of the four surrounding DEM cell elevations. For a given DEM resolution, 

the inclusion of partial columns leads to more accurate approximations of volume, weight, and the slip surface 

area for a potential failure mass, as compared to using only full columns, especially if a potential failure mass 

includes only a small number of full columns. 
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Figure 2.1. Diagram showing a 3D perspective view of a cone-shaped digital elevation model (DEM) and one potential failure 
(trial) surface. The potential failure mass (removed from this diagram) is composed of an ensemble of columns defined by the 
DEM grid with the center of the spherical trial surface and the axis of rotation located above the DEM. Two columns (in brown) 
of the potential failure mass are shown; each column has a different distance from the column base to the axis of rotation 
(Ri,j), where i,j denotes the DEM cell location. Horizontal earthquake loading, if selected by the user, is applied to the center of 
the columns and uses the vertical distance from the rotational axis (еi,j), in the limit-equilibrium calculations (see section 2.3). 
The azimuthal direction of slip (perpendicular to the axis of rotation), δ, is shown in the upper right corner. 
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At the base of each column, the spherical trial surface is approximated locally as a plane dipping at angle 

ε. Given a spherical radius R, the slope of the trial surface through the center of each column is computed by 

taking the partial derivatives (∂z/∂x and ∂z/∂y) of the equation for the spherical surface: 

 2 2 2 2R x y z= + + , (2.1) 

where x, y, and z are orthogonal coordinates relative to the sphere center and defined in space by the DEM. The 

true dip of the trial surface, ε, and the apparent dip in the direction of slide movement, α, are computed using the 

equations: 

 1 2 2cos 1 / 1 ( / ) ( / )z x z y−  = + +  
ε ∂ ∂ ∂ ∂ , and  (2.2) 

 
1tan [( / )cos ( / )sin ]z x z y−= +a ∂ ∂ δ ∂ ∂ δ , (2.3) 

where δ is the azimuthal angle of the slide movement direction, measured counterclockwise from zero in the 

positive x direction (fig. 2.2A). Positive values of ε dip in the direction of potential sliding. 

 

 
 

Figure 2.2. Schematic diagrams showing slip direction and forces acting on a 3D column. A, Diagram showing slip direction 
(green), true dip of the trial surface, ε, apparent dip in the direction of slip, α, and the azimuthal direction of slip, δ (blue). In 
this case the slip direction differs from the true dip direction of the trial surface, ε; this difference is common with 3D trial 
surfaces. Note that the trial surface is approximated as a plane at the base of each column. B, Diagram showing forces acting 
on the 3D column. The weight of the column (W), the normal force perpendicular to the trial slip surface (N), and the resisting 
shear force acting against slip (S) all act on the trial slip surface. The horizontal earthquake loading, keqW, acts at the center 
of the column in the azimuthal direction of slip, δ.  
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As part of the slope-stability analysis, Scoops3D computes the weight, Wc, of each column in the 

potential failure mass. The weight is computed by first determining the volume, Vc, of each column (partial or 

full) above the trial surface using an approximation for prismoids: 

 0 1 2(1 / 6) ( 4 )cV x S S S= ∆ + + , (2.4) 

where Δx represents the DEM grid spacing, S0 and S2 are the surface areas of the two parallel sides of the column, 

and S1 is the surface area of a vertical cross section through the middle of the column (fig. 2.3). Scoops3D 

approximates S1 using the average lengths of the two parallel sides of the column. Surface areas of the sides are 

computed using the ground surface elevations and the slip surface elevations at the corners of the column. Slip 

surface elevations are calculated using the equation of the sphere and the x and y locations of each column corner. 

For full columns, where Δy1 equals Δy2 (fig. 2.3B), the equations for side areas are exact for 

quadrilaterals, where: 

 0 1 4 1(1 / 2)( )S z z y= ∆ + ∆ ∆ , (2.5a) 

 1 1 2 3 4 1 2[(1 / 4)( )][(1 / 2)( )]S z z z z y y= ∆ + ∆ + ∆ + ∆ ∆ + ∆ , and (2.5b) 

 2 2 3 2(1 / 2)( )S z z y= ∆ + ∆ ∆ . (2.5c) 

In this case, the volume is that of a prismoid although both the trial surface area and volume are slightly 

underestimated because the trial surface at the column base is approximated by a planar surface rather than the 

curve of a sphere. For partial columns that include two nodes, as illustrated in figure 2.3A, Δz3 and Δz4 equal zero, 

so the equation for area reduces to that for a triangle and the volume is that of a pyramid. For partial columns that 

include three nodes, the shape of one side is approximately a quadrilateral, whereas the other side is a triangle. 

This represents a more complex solid. In the three-node case, equation 2.4 does not account for the extra volume 

of the pyramid contained outside of the solid defined between the quadrilateral and triangular surfaces; Scoops3D 

calculates this volume separately and adds it to the total. Partial columns with only one corner node within the 

potential failure mass are ignored. By including partial columns in the trial failure mass, Scoops3D can typically 

provide accurate estimates of factor of safety and potential failure volume with only ~200–500 columns in the 

mass (see section 6.6), rather than the thousands of columns that may be needed in other approaches that use only 

full columns (for example, Lam and Fredlund [1993] and Huang and others [2002]). Columns in the potential 

failure mass (full or partial columns with two or three corner nodes) that are used for computations in Scoops3D 

are designated active columns. 
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Figure 2.3. Schematic diagram of 3D partial and full columns showing components used to compute column volume above a 
trial slip surface. Scoops3D assumes a planar trial surface at the base of each partial or full column. A, Partial column 
showing two corner nodes within the potential failure mass. B, Full column encompassing a DEM cell. 

Then column weight is computed using the column volume, 

 ( )c cW V z dz= ∫ γ , (2.6) 

where γ is the unit or specific weight of the material, which may vary with depth, z. If the column contains more 

than one material with different properties, volumes and weights are appropriately integrated piecewise in the 

column above the trial surface. Scoops3D allows different unit weights for each material depending on the 

groundwater configuration selected. When a no groundwater or ru option is selected, Scoops3D applies the user-

defined total unit weight to each material. For stability analyses that include either a piezometric surface or 

positive pore-pressure heads defined in a 3D file, Scoops3D uses partially saturated unit weights above the 

uppermost water table (piezometric surface or zero pressure surface) and saturated weights below. With a 3D 

variably saturated pressure-head file, Scoops3D integrates the column weight by computing partially saturated 

unit weights using the vertical distribution of moisture content. 

A trial surface constructed as part of a sphere could slip in any direction, and the different potential slip 

directions may result in different computed factors of safety. Although the trial surface shape is relatively 

symmetrical (depending on the roughness of the topography intersected by the sphere), the distribution of stresses 

acting on the trial surface may be asymmetrical due to variations in weight and pore pressure acting on different 

columns. Scoops3D always computes a factor of safety for a slip direction, δ, in the overall fall direction, defined 

as the average ground-surface direction for all full DEM cells encompassed by the potential failure mass. 
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This fall direction is calculated using the arctangent of the sum of the slopes for the DEM cells in the x- and y-

directions, 
dz
dx∑  and ∑ dz

dy
 (see section 4.5.1.5 for definitions), converted to degrees from radians, and translated 

to a range of 0 to 360º where 0º coincides with the positive x-axis. Note that this is an azimuthal direction for the 

overall ground-surface slope of the potential failure mass, not the ground-surface slope itself. The user can opt to 

compute stability for additional slip directions on either side of the overall fall direction using the same trial 

surface to search for a minimum factor of safety (see section 4.4.1.1.9). The slip direction that yields the lowest 

factor of safety is a function of the distribution of stresses. 

The axis of rotation (see fig. 2.1) changes orientation to remain perpendicular to any given slip direction 

and does not need to be aligned with the x-y orthogonal coordinates of the DEM. This feature is unlike typical  

3D analyses that constrain slip to one direction parallel to the column grid. Because the stability calculations 

(section 2.3) do not require computation of lateral forces between the columns and because precision is enhanced 

by incorporating the effects of partial columns, Scoops3D can adequately compute stability for slip in any 

direction anywhere in the DEM, not just for slip aligned with x-y orthogonal coordinates. This capability is 

verified by the symmetry test described in section 6.7. 

2.2. Shear Strength 

In performing a slope-stability analysis, Scoops3D calculates the shear strength, s, on the trial surface by 

applying a linear Coulomb-Terzaghi failure rule: 

 ( ) tanns c us φ= + − , (2.7) 

where c is cohesion, ϕ is the angle of internal friction, σn is the normal stress, and u is the pore-water pressure 

acting on the shear surface. This rule can accommodate many standard geotechnical analyses, including total 

stress (where u = 0) and effective stress (u ≠ 0), as well as undrained (ϕ = 0) analyses. This equation allows the 

user to set c, ϕ, and u to any values appropriate for the desired analyses. For example, a geotechnical effective 

stress analysis would use c' and ϕ', where the prime symbol denotes values for effective stress. Depending on the 

analysis, ϕ might represent peak, residual, or critical-state frictional strength (Manzari and Nour, 2000). In the 

following mathematical presentation we use c and ϕ for simplicity, although they may represent total or effective 

stress values as selected by the user. 

Pore pressures in unsaturated materials (or matric suctions having negative values relative to the air 

pressure in the pores) induce suction stresses that can increase frictional strength when mobilized in shear.  
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Previous investigators (Vanapalli and others, 1996; Vanapalli and Fredlund, 2000; Lu and Griffiths, 2004) have  

found that the effects of suction stress can be reasonably approximated solely as a function of the effective degree 

of saturation: 

 ( )
( )

r
e

s r
S −

=
−

θ θ
θ θ

, (2.8) 

where θ is the water content, rθ  is the residual water content, and θs is the saturated water content. The parameter 

Se, which has values <1 in partially saturated materials, directly scales the effects of suction, thereby reducing the 

effects of matric suction (negative pressures) relative to those of equivalent positive pore pressures. The 

Coulomb-Terzaghi failure rule can be combined with Se to obtain a failure rule for partially saturated materials 

(where here, u can be negative and reflects matric suction): 

 ( ) tann es c S u= + −s φ . (2.9) 

Note that in this approach, the same values of c and ϕ are assumed for both saturated and partially saturated 

materials (Vanapalli and Fredlund, 2000; Lu and Likos, 2004; Lu and Godt, 2013); this differs from some other 

approaches (Bishop and Blight, 1963; Fredlund and others, 1978). If the user wants to include pore-pressure 

effects in unsaturated as well as saturated materials, Scoops3D has an option to include 3D variably saturated 

pore-pressure heads and the associated water contents needed to compute values of Se (section 2.4). With this 

option, Scoops3D assumes Se = 1 for saturated materials and thereby computes strength using the standard 

Coulomb-Terzaghi rule. A similar approach has been used in analyses of one-dimensional slope stability (Lu and 

Godt, 2008; Godt and others, 2009; Baum and others, 2010). 

At the base of each 3D column in a potential failure mass, Scoops3D uses the c and ϕ values of the 

material intersected by the trial surface in the center of the column for computation of slope stability. Assignment 

of c and ϕ values is governed by vertical elevation. If the user has defined material layers, then Scoops3D uses the 

values of c and ϕ for the layer at the elevation of the base of each column. If the user has provided a full 3D 

distribution of strengths (section 4.4.2.2), then the precise selection of values depends on the user-defined 

structure of the data. Scoops3D will either interpolate between adjacent vertical point values (if the linear 

interpolation option is selected) or use the value of the block containing the trial surface elevation (if the data is 

treated as discrete finite blocks with fixed parameters– see section 4.4.2.2). 

2.3. General Moment Equilibrium 

Scoops3D computes a factor of safety, F, for a given trial surface using moment equilibrium. This section 

presents the general approach and the two subsequent sections detail the differences between the Ordinary 

(Fellenius) and Bishop’s simplified methods. In general, all limit-equilibrium methods (including moment 
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equilibrium methods) define F as the ratio of the average shear resistance (strength), s, to the shear stress, τ, 

required to maintain limiting equilibrium along a predefined trial surface: 

 sF =
τ

. (2.10) 

Values of F less than one indicate instability. A constant proportion 1/F of the available shear strength resists the 

shear stress at equilibrium (a fundamental assumption of the method), or: 

 s
F

=τ . (2.11) 

For finite areas, such as the total trial surface or the base of an individual column, we need to use 

quantities of force, or stress acting over an area. Thus the average resisting shear force at equilibrium, T, is: 

 (1 / ) [( ) / ]
A

T A sA F dA= ∫ , (2.12) 

where A is the total trial surface area. Discretizing the shear resistance over an ensemble of vertical columns in 

the potential failure mass, defined by a DEM and indexed by i and j in the x and y directions respectively, leads 

to: 

 , ,
1

i j i jT s A
F

= ∑ , (2.13) 

where Ai j is the area of the trial surface at the base of each i, j column. The value of Ai j varies depending on the 

slope of the base and whether the column encompasses a full or partial DEM cell. F is assumed to be the same for 

each column. 

For a potential failure mass bounded by a spherical trial surface, Scoops3D calculates the equilibrium of 

moments about a rotational axis through the center of the sphere. The axis is horizontal and oriented normal to the 

slip direction of the potential failure mass (see fig. 2.1). Note that a given trial surface may rotate around an axis 

oriented in any direction within the horizontal plane. 

In Scoops3D, the driving moment is derived from two types of forces: gravitational weight (W) acting in 

the vertical direction and, if the user selects earthquake or seismic loading, a uniform horizontal force (keqW). 

This force results from a horizontal pseudo-acceleration coefficient, keq, a dimensionless coefficient typically 

expressed as a fraction of g (the magnitude of gravitational acceleration), acting on the weight. This simple 

method of incorporating earthquake loading is commonly termed a pseudo-static analysis. Scoops3D applies a 

uniform value of keq in the horizontal direction aligned with slip. With no earthquake loading, the keq coefficient 

equals zero. 



 17 

The moment arm associated with the gravitational force on each column is equal to the horizontal 

distance from the axis of rotation to the center of mass of the column (approximated as the geometric center of 

the column). Positive distances are directed upslope of the axis of rotation. By geometry: 

 , , ,sini j i j i ja R= a , (2.14) 

where Ri,j is the distance from the axis of rotation to the center of the base of a column and αi,j is the apparent dip 

of the column base in the direction of rotation. Note that in 3D, Ri,j will vary from column to column because it is 

the distance to the rotational axis (see fig. 2.1); in a 2D method of slices, R is constant and equal to the radius of a 

circle. Therefore, the driving moment due to the weight of the columns, Md, is: 

 , , , ,sind gravity i j i j i jM R W=∑ a . (2.15) 

The driving moment due to a uniform horizontal force from earthquake loading is: 

 , , ,d earthquake i j eq i jM W k e=∑ , (2.16) 

where ei,j is the horizontal driving force moment arm for a column (equal to the vertical distance from the center 

of the column to the elevation of the axis of rotation, see fig. 2.1). This horizontal force acts in the azimuthal 

direction of slip. Note that the normal forces on the base of each column act through the axis of rotation and thus 

produce no moment. 

The resisting moment is the sum of the products of the shear stresses on the base of each column 

(equation 2.17) and the resisting moment arms, equal to the distance from the column base to the axis of rotation. 

The total resisting moment for the ensemble of columns becomes: 

 , ,
,

i j i j
r i j

s A
M R

F
=∑ . (2.17) 

Substituting Si,j from equation 2.7 into the resisting moment: 

 
,, , , , ,

,

( ) tan
i ji j i j n i j i j i j

r i j

c A u A
M R

F

+ −
=∑

s φ
, or (2.18) 

 , , , , , ,
,

( ) tani j i j i j i j i j i j
r i j

c A N u A
M R

F
+ −

=∑
φ

, (2.19) 

 

where Ni,j is the normal force, 
, ,i jn i jAs , acting on the column base. Here, values of ci,j and tan ϕi,j are for the trial 

surface at the i,j column. 
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The global moment equilibrium, M, for rotation about the axis through the center of the trial surface 

sphere equals zero, and is defined by: 

 , ,0 r d gravity d earthquakeM M M M= = − − , (2.20) 

or for all columns: 

 , , , , , ,
, , , , , ,

( ) tan
sini j i j i j i j i j i j

i j i j i j i j i j eq i j
c A N u A

M R W R W k e
F

+ −
= − −∑ ∑ ∑ ∑

φ
a . (2.21) 

A factor of safety, F, against rotation can then be defined as: 

 , , , , , , ,

, , , ,

( ( ) tan )
[ sin ]

i j i j i j i j i j i j i j

i j i j i j eq i j

R c A N u A
F

W R k e
+ −

=
+

∑
∑

φ
a

. (2.22) 

If ϕ ≠ 0, then the normal force, Ni,j, acting on the slip surface of each column must be determined. The 

Ordinary (Fellenius) and Bishop’s simplified methods use different procedures to estimate these normal forces, as 

discussed in sections 2.3.1 and 2.3.2. 

2.3.1. Ordinary (Fellenius) Method 

The Ordinary method was first developed by Fellenius (1936) to compute stability on a 2D slip circle 

divided into slices. In Scoops3D, we extend this method to 3D columns and add the capability to include 

earthquake loading effects in a pseudo-static analysis. In contrast to the 2D approach, 3D slip can occur in 

directions other than the true dip of the trial surface (section 2.1). Shear force, Si,j, (positive in the upward 

direction) resists movement in the slip direction and thus is a function of the apparent dip of the trial surface. To 

compute the normal force, Ni,j, acting on the slip surface for a given column (see fig. 2.2B), we resolve the 

vertical (equation 2.23) and horizontal (equation 2.24) force equilibrium equations driven by the weight, Wi,j, 

acting vertically, and earthquake loading, keqWi,j, acting horizontally in the direction of slip: 

 , , , , ,cos sini j i j i j i j i jW N S= +ε a , and (2.23) 

 ,
, , , , ,

,

cos
cos sin

cos
i j

eq i j i j i j i j i j
i j

k W S N= −
ε

a a
a

. (2.24) 

Note that the horizontal force equilibrium (equation 2.24) includes the component of the normal force acting in 

the slip direction. Solving this equation for Si,j gives: 

 ,
, , , ,

, ,

cos1 sin
cos cos

i j
i j i j i j eq i j

i j i j
S N k W

 
= + 

  

ε
a

a a
, (2.25) 
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and substituting Si,j back into the vertical force equilibrium (equation 2.23) produces: 

 , ,
, , , , , ,

, ,

sin cos
cos sin

cos cos
i j i j

i j i j i j i j i j eq i j
i j i j

W N N k W
 

= + + 
  

a ε
ε a

a a
. (2.26) 

Solving for Nij, multiplying each side by cos2αi,j, and simplifying yields: 

 
2

,
, , ,

,

cos
1 tan

cos
i j

i j i j eq i j
i j

N W k = − 
a

a
ε

. (2.27) 

This definition of normal force is based on the assumption that forces on the sides of the column in the 

slip direction act parallel to the base of the column. This assumption is physically implausible (given that each 

column has a base with a different slope), except when the intercolumn forces are zero. Therefore, the Ordinary 

method, and Scoops3D implementation of it, explicitly neglects all side forces on the columns and assumes they 

are zero. Note that, even neglecting side forces, the Ordinary method utilizes moment equilibrium and thus differs 

from the method proposed by Hovland (1977). Hovland’s method, applied to uniform slopes, often leads to lower 

computed factor-of-safety values than either the Ordinary method or more rigorous methods (Ugai, 1988; Xie and 

others, 2006b). 

The Ordinary method in 2D may underestimate F when high pore pressures act on the trial slip surface 

(Whitman and Bailey, 1967; Duncan and Wright, 1980, 2005). To compensate, some investigators have proposed 

using an effective column weight to account for pore-water pressure effects (Turnbull and Hvorslev, 1967). Other 

researchers have examined the ramifications of these different approaches (Lei and others, 2011). On the basis of 

those studies and our own experience, we have chosen to implement the Ordinary method with one modification - 

when the resisting force at the base of any column is negative, we assume the force for this column is zero in the 

overall moment equilibrium (see special cases, in section 2.5). Results obtained using this approach are typically 

closer to those derived from Bishop’s simplified method than results from either the traditional Ordinary method 

or results obtained using modifications based on effective column weight (Turnbull and Hvorslev, 1967; Duncan 

and Wright, 2005), even for cases with high pore pressures (Lei and others, 2011). 

Substituting the 3D Ordinary definition of normal force (equation 2.27) into the general moment 

equilibrium factor-of-safety equation 2.22 gives: 

 

2
,

, , , , , , , , ,
,

, , , ,

cos
tan tan

cos

[ sin ]

i j
i j i j i j i j eq i j i j i j i j i j

i j

i j i j i j eq i j

R c A W k W u A

F
W R k e

  
   + − −     =

+

∑

∑

a
a φ

ε

a
. (2.28) 

Because rotation in 3D is around an axis, values of Ri,j vary between columns and they are retained in the final 

equation for F. In the 2D version of the Ordinary method, R is constant and cancels out of the final equation. 
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2.3.2. Bishop’s Simplified Method 

Bishop’s simplified method was also developed as a 2D method of slices (Bishop, 1955). Bishop’s 

simplified method determines the normal force acting on the slip surface by first computing force equilibrium in 

the vertical direction on the base of each slice. The side forces on the slices are assumed to be horizontal (with no 

net shear stress between slices) and are not explicitly used in the method. Our 3D implementation of this method 

(Reid and others, 2000) makes the same assumptions for columns and follows a procedure similar to that 

presented by Hungr (1987) and Hungr and others (1989). 

Vertical force equilibrium on the base of a column is found using equation 2.23. In the 3D extension of 

this method (Hungr, 1987; Hungr and others, 1989), the vertical normal force component is resolved with respect 

to the true dip of the trial surface at the column base, ɛi,j. The shear force on the base acts parallel to the apparent 

dip in the direction of potential sliding, so the vertical component is resolved with respect to αi,j, as in our 3D 

extension of the Ordinary (Fellenius) method (section 2.3.1). Shear force, Si,j, on the base of the column is a 

function of shear strength and the factor of safety, F: 

 , , , , , , ,
1 [ ( ) tan ]i j i j i j i j i j i j i jS c A N u A
F

= + − φ . (2.29) 

Combining equations 2.23 and 2.29 and rearranging gives: 

 , , , , , , , , , ,
, , ,

tan sin sin tan sin
cos i j i j i j i j i j i j i j i j i j i j

i j i j i j
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and solving for Ni,j: 

 
, , , , , , ,

,
,

, , ,

sin tan sin

[cos (sin tan ) / ]

i j i j i j i j i j i j i j
i j

i j
i j i j i j

c A u A
W

F FN
F

− +
=

+

a φ a

ε a φ
. (2.31) 

For convenience, the denominator of this equation, , is common , , ,cos (sin tan ) /i j i j i j F+ε a φ  is 

commonly termed ,i j
ma . Substituting the normal force, Ni,j, into the moment equilibrium factor-of-safety 

equation 2.22 gives: 
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With considerable simplification, and noting that the horizontal area of the column base, 

, , ,cos
i jh i j i jA A= ε , the equation for F becomes: 
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[ sin ]
i j i j i ji j i j h i j i j h i j

i j i j i j eq i j

R c A W u A m
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W R k e

+ −
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+
∑

∑
aφ

a
. (2.33) 

Because the numerator, or resisting moment, is a function of the factor of safety, F, the solution to 

equation 2.33 is obtained using an iterative method. The method requires an initial estimate of factor of safety, Fi, 

and convergence of the iterative process can be sensitive to Fi; for example, it is possible to converge to an 

inaccurate F value if the trial surface has a steep dip oriented against rotation (negative ɛ). If any column on the 

trial surface has a negative value of dip, ɛ, then Scoops3D uses an initial estimate of factor of safety, Fi: 

 3i O DF F= + β , (2.34) 

where FO is the factor of safety found using the Ordinary Method for the same potential failure mass and: 

 3
( sin tan )

cos
m m

D
m

−= a φβ
ε

, (2.35) 

where m denotes the column with the maximum negative ɛ value. This approach is similar to that proposed by 

Chowdhury and Zhang (1990) for 2D analyses, except that we use FO instead of 1 and a 3D version of their ß. It 

is important in these cases that Fi > ß3D, otherwise some mα values can be negative and the iterations will not 

converge to the correct result. If no columns on the trial surface have a negative ɛ, then Scoops3D uses Fi = FO. 

Using these approaches, most solutions converge in 4–5 iterations. Note that even with the selection of Fi as 

described above, the iterations may not converge for a particular trial surface. This is usually due to the inability 

to obtain a reasonable normal force on the base of a column, typically where the slip surface is very steep and (or) 

affected by high pore pressures. If the solution for F does not converge monotonically in 10 iterations, Scoops3D 

will terminate computations for that trial surface. If solutions converge monotonically, then Scoops3D will 

continue up to a maximum of 25 iterations before terminating and advancing to the next trial surface. Trial slip 

surfaces that do not converge in the allowed number of iterations are assigned an arbitrarily large factor of safety 

value of 111.0 for identification purposes. Scoops3D records all non-converging trial surfaces in an output file for 

inspection by the user (section 4.5.2.3), but does not halt overall program execution. 
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2.4. Pore-Water Pressure Conditions 

Determining the pore-water pressure acting on each column base can be difficult owing to complex 

gravity-driven groundwater flow that creates spatially variable conditions. Therefore, stability analyses 

commonly make simplifying assumptions to characterize the pore-pressure field. Scoops3D allows the user to 

select from several different methods to account for pore-water pressure effects in the stability analysis; these 

include (1) no groundwater pressure, (2) a pore-pressure ratio, ru, (3) a piezometric surface, (4) a 3D distribution 

of saturated pore-pressure heads, or (5) a 3D distribution of variably saturated pore-pressure heads. Each of these 

options makes different assumptions about the distribution of pore pressure, which results in slight variations in 

the factor of safety equation used in Scoops3D. Note that pore pressure, u, is related to pressure head, h (in units 

of length), by: 

 u h= γw . (2.36) 

The equations for each method are summarized in table 2.1. 

 

Table 2.1. Equations for factor of safety, F, given different pore-pressure conditions. 
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(3) Piezometric surface 
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(5) 3D variably saturated pressure heads 
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If the pore-pressure ratio option is selected, then the user enters a ru value for each material layer. The 

pore-pressure ratio, ru, as defined by (Bishop, 1955) is equivalent to: 

 
( )u

ht

u ur
W Azdz

= =
∫γ

, (2.37) 

where γt is the total unit weight of the overlying material. This ratio represents the pore pressure divided by the 

integrated total vertical gravitational stress at the same location, and is typically used to account for relatively 

uniform pore-pressure effects along the trial surface. Note that using one average ru value can over- or 

underestimate actual pore-water pressures (Eid, 2010). 

If the user selects the piezometric surface option, Scoops3D uses a grid containing the elevations of the 

piezometric surface to determine pore pressures acting on the trial surface at the base of each column. This option 

assumes that pore pressures are hydrostatic with vertical depth, where 

 pz wu z= γ  (2.38) 

and zpz is the vertical depth below the piezometric surface and can vary between columns. This option can be used 

to represent horizontal saturated groundwater flow beneath a water table. 

A 3D distribution of pressure heads (for example, from a groundwater flow model) can be used to 

compute pore pressure (using equation 2.37) in Scoops3D. To use this option, the user provides a separate input 

file containing 3D pressure-head values for each DEM cell using the 3D file formats presented in section 4.4.2.2. 

Scoops3D computes the pore pressure acting on the base of each column by linearly interpolating between 

vertical values of pressure head on either side of the trial surface. All values of u < 0 on a column base are set to 

zero when using this option. 

Scoops3D also allows the user to incorporate the pore-pressure effects of a 3D variably saturated 

groundwater flow field, where flow may occur in either or both partially saturated (u < 0) and saturated materials. 

Pore-water pressures in partially saturated materials are negative relative to atmospheric pressure (reflecting 

matric suction), and the relation between water content and pressure is often highly nonlinear (Hillel, 1980). The 

negative pressures impart an inter-particle stress that acts to increase shear resistance (see section 2.2). As with 

the 3D pressure-head option described above, Scoops3D performs a linear interpolation between vertical values 

on either side of the slip base to determine the pore pressure (positive or negative) acting on the base of each 

column. In partially saturated materials, values of water content are needed to compute the effective degree of 

saturation, Se that influences shear strength (section 2.2). Scoops3D has three options to obtain these values: (1) 

provide a 3D file containing locations with corresponding variably saturated pressure head and water content, (2) 

use parameters for a van Genuchten (1980) soil-water characteristic curve (SWCC) as well as a 3D file containing 

variably saturated pressure heads, or (3) use parameters for a Fredlund and Xing (1994) SWCC as well as a 3D 
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file containing variably saturated pressure heads. Use of a SWCC enables direct computation of water content 

given a soil matric suction, ψ (suction is opposite in sign to pore pressure). Note that a SWCC function can be 

obtained by curve fitting measured data or by assuming appropriate parameters. 

The van Genuchten SWCC formula, using the Mualem (1976) model assumption, is: 

 
(1 1/ )

( )( )
[1 ( ) ]vG vG

s r
r n n
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−

−
= +

+
θ θ

θ ψ θ
a ψ

, (2.39) 

where αvG and nvG, are curve parameters. With the van Genuchten SWCC or with the 3D water content file 

options in Scoops3D, if any water content is less than θr, then suction stress effects for this location equal zero in 

the stability calculations. 

 The Fredlund and Xing (1994) SWCC formula, as presented in Fredlund and others (2012), is: 
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where C(ψ), a correction factor, is: 
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, (2.41) 

αFX, nFX, and mFX are curve parameters, and ψr is the soil matric suction at residual conditions. With the Fredlund 

and Xing SWCC option in Scoops3D, if any pore pressure is lower (drier) than ψr, then pore pressure and suction 

stress are set to zero. 

2.5. Special Cases 

During the computation of factor of safety, certain conditions can arise that are physically implausible for 

a given trial surface. Scoops3D attempts to identify and correct for these special cases without halting execution 

of the program. For example, if a negative frictional resisting force is determined at the base of any column, that 

is: 

                                       (Ordinary), or (2.42) 
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then Scoops3D assigns a value of zero frictional resisting force for that column and continues to determine F for 

the trial mass. This special case can occur when pore pressures are very high. When using the Ordinary method, if 

the sum of the resisting forces is less than zero, then Scoops3D sets the sum to zero. Therefore, shear resistance 

cannot create F < 0. In both methods, if the sum of the driving forces is less than zero, then Scoops3D sets F to 

100 for identification purposes. Also, if the computed F in either method is very large (> 100), then Scoops3D 

sets F = 100 (compared to F = 111.0 for nonconverging solutions – see section 2.3.2). 

2.6. Slope Stability of 2D Slice 

For comparative purposes, Scoops3D computes a 2D factor of safety if the user elects to analyze a single 

surface in 3D. The 2D solution is obtained for a vertical section through the estimated center of the 3D mass with 

a trial slip surface oriented in the same direction as the 3D slip direction. The 2D center of rotation is defined by 

the intersection of a line projecting from the estimated center of the 3D mass in the plane defined by the slip 

direction and the 3D axis of rotation. A 2D method of slices, matching the stability method selected for the 3D 

analysis (Ordinary or Bishop’s simplified), is used for the stability computation. Scoops3D determines the width 

of each slice (along the direction of slip) depending on the orientation of the cross section with respect to the 

columns; thus each slice will have a different width and cross-sectional area unless the slip direction coincides 

with either the x or y axis of the DEM. If the slip direction does coincide with one of axis directions, each slice 

will have a width equal to the DEM cell size. The arc length at the base of each 2D slice is found by dividing the 

intersecting slice width by the apparent dip in the slide direction of the 3D column base. Strength and 

groundwater conditions for each slice match those of the corresponding 3D column. The rotational moment arm 

(constant radius), dip and length of the slip base for each slice, and the earthquake moment arm (if using 

earthquake loading) are computed for the 2D analogs. A ratio of 2D cross sectional area to 3D volume is used to 

estimate the weight of each slice. Because of these approximations, the 2D factor of safety computed by 

Scoops3D may not precisely match the 2D factor of safety computed by other programs. 
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Chapter 3. Build and Search a 3D Domain 
Scoops3D computes slope stability for all parts of a 3D domain underlying a digital elevation model 

(DEM). The user has a variety of options for building this 3D domain and configuring its material properties and 

groundwater conditions, ranging from very simple homogeneous earth materials to full 3D distributions of 

subsurface properties. Scoops3D determines the minimum stability associated with each DEM cell in the digital 

landscape. This objective makes Scoops3D different from most other 3D slope-stability models that typically 

search only for the single, least-stable potential failure for a given hillslope or embankment. In this chapter, we 

describe how to construct a 3D domain and how to perform a thorough search of the domain to identify the 

minimum stability for each DEM cell. 

3.1. Construct a 3D Domain 

In all cases, the user must provide a DEM that represents the ground surface of the 3D domain. The DEM 

defines the horizontal extent of the domain, and the DEM cell spacing defines the horizontal dimensions of the 

3D columns used in the slope-stability computations. Scoops3D allows users to select from three approaches to 

define subsurface material properties and different groundwater configurations (table 3.1). In general, if the user 

wants to use layers and (or) 3D distributions of properties, then this information must be contained in separate 

files using the formats listed in section 4.4.2. The graphical user interface, Scoops3D-i (section 4.3), does not 

build these additional files; it does, however, check for their existence if the user has selected options using these 

files. 

Table 3.1. Matrix of material properties and groundwater configuration options selectable in Scoops3D. 
 

  

  

Groundwater configuration 
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To examine the effects of topography alone on slope stability, the user can opt to use a simple 

homogeneous domain beneath the DEM. The user then assigns uniform values for the earth material in this 

domain; these values are contained in the main parameter input file (see section 4.4.1). In this scenario, stability 

will be a function of topography integrated over the size of potential failures analyzed. 

If the location of spatially variable properties in the domain can be represented as a series of layers (each 

having its own properties), Scoops3D can readily accommodate the layered data using files that define the 

lowermost (bottom) elevation of each layer as a surface (in an ASCII raster grid format). This approach allows 

easy integration with Geographic Information System (GIS) or grid software, such as Esri ArcGIS, GRASS GIS, 

Quantum QGIS, or Golden Software Surfer; layers can be readily created and visualized with such software. Very 

simple layers (such as a flat boundary beneath the DEM) may be manually constructed with a text editor or 

spreadsheet program using an ASCII raster file of the DEM as a template. 

For more complex scenarios with a variable 3D distribution of material properties and (or) pore-water 

pressures, Scoops3D reads separate input file(s) having the formats described in section 4.4.2.2. Typically these 

3D data cannot be constructed in surface or layer-oriented GIS software, but instead are derived from 3D 

geophysical (for material properties) or groundwater flow (for pore-water pressure head) models. Manual 

construction of a complex 3D array is difficult. The user must exercise care in creating these files so that 3D data 

are provided for each DEM cell and the horizontal locations of nodes in any 3D data files align with the centers of 

the DEM cells. 

The sections below describe options for defining different aspects of the 3D domain, including 

topography, material properties, pore-water pressures, and earthquake loading effects. Details of the file formats 

for the ASCII raster grid files and 3D data files are contained in section 4.4.2. 

3.1.1. Topography 

Ground-surface topography, denoting the upper boundary of the 3D domain, is represented by a digital 

elevation model (DEM). The DEM format required by Scoops3D contains an orthogonal array of equal sized 

cells, with each cell (raster) containing an elevation value (fig. 3.1). A DEM input file is mandatory for all 

Scoops3D analyses. 
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Figure 3.1. Perspective view of a digital elevation model (DEM) underlain by four material layers and a piezometric surface 
layer. Note that the fourth layer extends from the bottom of layer 3 to infinite depth. Inset shows detail of DEM cells. 

DEM data can be obtained from a variety of sources, such as national elevation databases or lidar (Light 

Detection and Ranging) surveys. The DEM file used by Scoops3D must be structured in the Esri ASCII raster 

format, as described in section 4.4.2.1. If the user’s DEM is in a different format, it must be converted. An 

example of converting a raster dataset using Esri’s ArcGIS software is given in section 4.4.2.1.1. We have found 

that the boundaries of the DEM should extend slightly beyond the slopes of interest for the practical reasons 

discussed in section 5.3.3. Although Scoops3D can analyze a DEM of any grid cell size (resolution), the cell size 

has a considerable influence on both computational accuracy and efficiency. Higher resolution grids lead to more 

accurate calculations of factor of safety and volume, but they increase computational time and computer memory 

requirements. Choosing an appropriate DEM resolution is discussed in detail in section 5.3.4. 
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DEMs that include bodies of water (for example, lakes or oceans) as flat surfaces should be treated 

carefully. Potential failure masses intersecting flat water surfaces in a DEM will produce erroneous computations 

of factor of safety. Generally, the user should remove these flat surfaces from the DEM. Scoops3D does not 

compute the stability of partially submerged slopes. If bathymetry is available for fully submerged areas, 

Scoops3D can perform subaqueous stability computations in these areas if the user enters buoyant (instead of 

total) unit weights for the fully submerged materials. This approach assumes fully saturated, hydrostatic 

conditions in the submerged materials. 

3.1.2. Material Properties in the Subsurface 

Scoops3D requires the user to define properties (table 3.2) for all earth materials underlying the DEM. 

Some of these properties are needed to compute factors of safety for trial surfaces, whereas others are required 

only for specific groundwater configurations (table 3.2). The distribution of these properties can be defined using 

one of three approaches: (1) uniform, homogeneous properties, (2) layered material properties, or (3) 3D spatially 

varying properties (this third option is not available with variably saturated groundwater conditions). Layers and 

3D distributions require additional input files. Only one of these three approaches can be used for a given model. 

3.1.2.1. Homogeneous Properties 

This option is the simplest; the spatial distribution is uniform with one material layer extending to infinite 

depth beneath the DEM. With this option, Scoops3D uses homogeneous properties in computing the factor of 

safety for a given trial surface. Values for both c and ϕ are required; these are contained in the main input file 

(section 4.4.1.1.4). Only total unit weight is required for no groundwater or pore-pressure ratio analyses, whereas 

both partially saturated and saturated unit weights are required for the piezometric surface and 3D pressure-head 

groundwater configurations. Residual and saturated water contents are required only with the 3D variably 

saturated option. 
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Table 3.2. List of properties required by Scoops3D for each earth material. 
 
[Note that all parameters must be in internally consistent units, with length units that match the DEM. The properties 
required depend on the groundwater configuration selected, as indicated in the last seven columns of the table. SWCC is soil-
water characteristic curve. ft, foot; kN, kilonewton; kPa, kilopascal; lb, pound; m, meter] 
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Cohesion  c 
 

cee kPa or lb/ft2 x x x x x x x 

Angle of internal 
friction 

θ 
 

phi degrees x x x x x x x 

Unit weight, total  γt 
 

gamt kN/m3 or lb/ft3 x x      

Unit weight, 
partially saturated 

γps 
 

gamps kN/m3 or lb/ft3   x x    

Unit weight, 
saturated 

γs 
 

gams kN/m3 or lb/ft3   x x x x x 

For variably saturated configurations:         

Residual water 
content 

θr thetares Dimensionless     x x x 

Saturated water 
content 

θs thetasat Dimensionless     x x x 

van Genuchten 
SWCC parameter  

αvG 
 

vgalpha kPa-1 or ft2/lb      x  

van Genuchten 
SWCC parameter  

nvG vgn Dimensionless      x  

Fredlund and Xing 
SWCC parameter  

avG fxa kPa       x 

Fredlund and Xing 
SWCC parameter  

nFX fxn Dimensionless       x 

Fredlund and Xing 
SWCC parameter  

mFX fxm Dimensionless       x 

Fredlund and Xing 
SWCC parameter  

ψr 
 

fxr kPa       x 



 32 

3.1.2.2. Layered Material Properties 

If the user can represent the subsurface distribution of material properties by a series of layers, Scoops3D 

can readily accommodate these layers. Scoops3D uses the strength properties of the layer intersected by the trial 

surface for each column in a potential failure mass to compute stability. Scoops3D vertically integrates the 

weights of multiple layers, if they exist, to determine the total weight acting on each column base in the potential 

failure mass. 

The user defines the elevation of the lower boundary of each layer by an ASCII raster grid, with each grid 

contained in a separate file (section 4.4.1.1.4.1). The user must construct these grids using other software, and the 

grids must exactly match the extent and cell size of the DEM grid. The top of the shallowest layer is the DEM and 

the bottom of the deepest layer is undefined as it is infinitely deep (fig. 3.1). Layers can be discontinuous, 

allowing for some regions of the domain to have a subset of the layers. Each layer has its own properties, as listed 

in table 3.2, that are defined in the main parameter input file. The properties required depend on the groundwater 

configuration option selected (table 3.2). 

3.1.2.3. 3D Properties 

Scoops3D can incorporate a full 3D spatial distribution of subsurface properties using a 3D file. This is 

the most complex option, and the user may need a 3D model (such as a geophysical model) to acquire the 3D 

distribution. The user will need to format the data in the appropriate file format (section 4.4.2.2). In general, each 

3D data point needs an x, y, and z location, as well as material property values for that location. Data must be 

provided for all DEM cell locations; the vertical depths of the data at each DEM cell can be regularly (constant) 

or irregularly spaced. If only some of the required parameters listed in table 3.2 vary in the 3D domain, these can 

be entered in the file and the other parameters can be set to constant values throughout the domain (by defining 

values in the main input file). The user can select how strength (angle of internal friction and [or] cohesion) is 

determined at the base of each column on a trial surface from the 3D data; it can be computed either by linearly 

interpolating between adjacent vertical data points that bracket the base or by using the value within the block 

containing the base. The 3D properties option cannot be combined with the layered material properties option: it 

also cannot be used with 3D variably saturated groundwater configurations. 
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3.1.3. Groundwater Configuration 

Scoops3D offers several methods to include the effects of pore-water pressures on slope stability. These 

options range from no groundwater to pore pressures defined by a piezometric surface or a 3D pore-pressure head 

field. Cases with no groundwater do not require additional files, whereas piezometric surfaces and 3D 

distributions of pressure head require additional input files. Only one of the options described below can be 

selected. 

3.1.3.1. None 

This option is simple and allows the user to compute slope stability for a landscape with no groundwater 

pressures. No additional files or parameters are required; the option is selected in the main input file  

(section 4.4.1.1.3). Only values for total unit weight are used in the slope stability computations. 

3.1.3.2. Pore-Pressure Ratio, ru 

This option allows the use of a pore-pressure ratio, ru, to incorporate the effects of pore-water pressure 

into the slope stability calculations. This value, proposed by Bishop (1955), is defined as the ratio of pore 

pressure to vertical stress at a point (section 2.4, equation 2.37); it is widely used in geotechnical analyses. The 

use of ru is an easy way to include pore-pressure effects in a stability analysis; however, ru is unlikely to be 

constant throughout a hillslope or along a trial surface. Scoops3D allows the user to enter different ru values for 

each material layer (if the layer option is selected). No additional input files for ru are needed. For this option, 

only values for total unit weight are used in the slope-stability computations. 

3.1.3.3. Piezometric Surface 

This option allows the user to incorporate a relatively simple 3D distribution of pore pressure by using a 

piezometric surface that represents the water table with vertically hydrostatic pressure heads beneath the surface. 

Such an assumption is unlikely to be valid throughout hilly topography but it is widely used in geotechnical 

analyses and is more conservative (that is, more destabilizing) than a slope-parallel flow field (for example,  

Reid, 1997). In this option, pore pressure acting on the trial surface of a column is defined by the vertical depth 

beneath the piezometric surface multiplied by the unit weight of water (section 2.4, equation 2.38). For a column 

with the trial surface above the piezometric surface, pore pressure is zero. To use this option, the user needs to 

provide an ASCII raster file containing the elevations of the piezometric surface at each DEM cell location 

(section 4.4.2.1.5). Values for saturated unit weight, γs, are used for the potential failure mass beneath the 

piezometric surface and partially saturated unit weights, γps, are used for mass above the piezometric surface. The 

total weight of a given column in the potential failure mass is derived from the vertical integration of these 

components. 
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3.1.3.4. 3D Pressure Heads 

The 3D pressure-head option allows the user to assess the effects of a complex groundwater flow field on 

slope stability in Scoops3D. The spatial variation in pressure head underlying convoluted topography will likely 

be complex; thus the user will probably obtain the data from a 3D groundwater flow model (such as the USGS 

model MODFLOW [Harbaugh and others, 2000]) and modify the data to fit formats acceptable to Scoops3D (see 

Seattle example, section 7.5). For this option, the user must provide a separate 3D file containing a list of 

locations with corresponding pressure head, in one of the file formats given in section 4.4.2.2. As with the 3D 

material properties file, data must be provided for each DEM cell location; the vertical depths of the data at each 

cell can be regularly (constant) or irregularly spaced. Pore pressure for the stability calculations is computed from 

pressure heads contained in the file (section 2.4). The pressure value acting on the trial surface of each column is 

derived by linearly interpolating between adjacent vertical data points that bracket the base of the column. Values 

for saturated unit weight, γs, are used for the potential failure mass with positive pressures heads and partially 

saturated unit weights, γps, are used for mass with non-positive pressure heads. The total weight of a given column 

in the potential failure mass is derived from the vertical integration of these components. With this option,  

any negative pressure heads contained in the 3D file are assumed to equal zero in the stability calculations 

(section 2.4). 

3.1.3.5. 3D Variably Saturated Configurations 

If the user wants to include the effects of both saturated and partially saturated pore-water pressure on 

slope stability, Scoops3D can incorporate a 3D distribution of variably saturated pressure head (both negative and 

positive relative to atmospheric pressure) using one of three approaches (section 2.4). For these approaches, the 

user will need to provide either: (1) a 3D file containing locations with corresponding variably saturated pressure 

head and water content, (2) parameters for a van Genuchten soil-water characteristic curve (SWCC) as well as a 

3D file containing variably saturated pressure heads, or (3) parameters for a Fredlund and Xing SWCC as well as 

a 3D file containing variably saturated pressure heads. These approaches can also be used for unsaturated 

conditions. 3D files should be in one of the formats given in section 4.4.2.2. Typically, a variably saturated 

groundwater flow model will be needed to obtain a complex distribution of pressure head and (or) water content. 

If selected, a SWCC can be used to derive water content from a given soil-water suction, thereby eliminating 
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the need for a 3D distribution of water content. In all these approaches, as with the 3D pressure-head option 

(section 3.1.3.4), pore pressure acting on the trial surface of each column is derived by linearly interpolating 

between adjacent vertical data points that bracket the base of the column. The total weight of a given column in 

the potential failure mass is derived from the vertical integration of the unit weights defined by the vertical 

distribution of water contents (obtained directly from the 3D file or from the SWCC, depending on the option 

selected). This option cannot be used with a 3D material properties file. 

3.1.4. Earthquake Loading 

Stability calculations in Scoops3D can include simplistic effects of earthquake or seismic loading in a 

pseudo-static analysis by adding a specified pseudo-acceleration, keq. This coefficient scales weight and is applied 

as a uniform horizontal force, to represent the effects of ground acceleration from an earthquake (Seed, 1973; 

Chowdhury, 1978). To implement this option, the user defines a horizontal pseudo-acceleration coefficient 

(dimensionless and scaled as a fraction of gravity, g). The additional horizontal force is applied in the direction of 

slip and added to the stability calculations for all trial surfaces in the analysis. 

3.2. Search of the 3D Domain 

To adequately assess the slope stability of all parts of a 3D domain underlying a DEM, Scoops3D must 

perform a complete search. This section describes the important controls used to define and control the search. 

Practical considerations for implementing search procedures and assigning search parameters are given in  

chapter 5. 

Scoops3D computes slope stability using limit-equilibrium analysis for a predefined trial surface, as 

described in section 2.1. Therefore, assessing slope stability throughout the DEM requires determining the 

stability of a wide variety of trial surfaces at different depths, with all parts of the DEM included in at least some 

trial surfaces. A thorough search with many trial surfaces is necessary because: (1) the minimum factor of safety 

needs to be determined for each DEM cell in the digital landscape, and (2) variations in local topography, 3D 

material properties, and 3D pore-water pressures create opportunities for many local minima in factor of safety. 

Depending on the search parameters selected by the user, Scoops3D might compute slope stability for thousands 

to millions of valid trial surfaces intersecting the DEM. 
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The search process is aided by the requirement that each trial surface is part of a sphere defined by a 

rotational center point located above the DEM and a given radius. Using a finite 3D orthogonal array of 

rotational centers (here called the search lattice, fig. 3.2), Scoops3D can create and analyze multiple trial 

surfaces, with some surfaces affecting each part of the DEM. This approach is analogous to the grid of rotational 

centers commonly used to determine a critical potential failure surface in 2D geotechnical analyses (Boutrup and 

Lovell, 1980; Krahn, 2004). Although other geotechnical software might allow the user to specify that all trial 

surfaces intersect a specified layer or exit at a specified location, such site-specific controls on stability are 

typically unknown over a DEM. Therefore, Scoops3D does not provide the user with these options. A spherical 

failure surface shape is maintained for all trial surfaces; Scoops3D does not attempt to optimize the trial surface 

shape to determine a minimum factor of safety, as some researchers have done in 2D and 3D (Boutrup and 

Lovell, 1980; Chen and Shao, 1988; Duncan, 1996; Yamagami and Jiang, 1997; Chen and others, 2001; Zhu, 

2001; Jiang and Yamagami, 2004). 

 

 
Figure 3.2. Diagram showing a 3D search lattice above a DEM. Each green dot represents the center of multiple spherical 
trial surfaces. 
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During the search process, Scoops3D keeps track of the minimum factor of safety computed for each 

DEM cell, out of all the trial surfaces encompassing that cell. The trial surface with the minimum factor of safety 

is defined here as the critical surface for that DEM cell. Scoops3D also retains the size of the potential failure 

mass associated with that critical surface, called the critical size. When the overall search is complete, Scoops3D 

produces 2D map-view grids of the minimum factor-of-safety values and associated critical sizes (volume or area 

depending on user-specified primary size criteria - see section 4.4.1.1.10). The size grids do not portray the 

complete spatial extent of every critical potential failure mass at a given DEM cell because adjacent DEM cells 

may have been affected by a different critical surface with a lower factor of safety. Scoops3D also provides an 

output file containing summary parameters for all the critical surfaces (see section 4.5.1.4). Cells on the 

boundaries of the DEM that cannot be included in any valid trial surfaces are assigned null values. The main 

output file lists the trial surface with the overall or global minimum F value found during the search. 

To limit the infinite number of permutations for searching a DEM, Scoops3D allows the user to select 

some search restrictions. These options include: (1) conducting a search using a rectangular box-like search grid 

aligned with the DEM (Box search option), (2) analyzing a single, user-selected trial surface (Single surface 

option), or (3) performing a variant of a box search constrained by lateral limits defined in a file (File search 

option). Details of the input parameters for each option are presented in section 4.4.1.1.9. Practical considerations 

for constructing a thorough search are discussed in chapter 5. 

For a box or file search, the user can elect to perform either a simple search or a coarse-to-fine search. 

Although the simple search option can provide the most thorough search, it can be quite time-consuming and is 

typically unnecessary. The coarse-to-fine search method greatly reduces computational effort, commonly 

reducing run times by as much as 90 percent. These options are described in the following sections. 
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3.2.1. Simple Box Search 

A simple box search in Scoops3D (fig. 3.2) analyzes spherical trial surfaces generated with a rotational 

center at each node in the search lattice, and then proceeds to analyze trial surfaces generated at the next node in 

the search lattice in a systematic fashion until all nodes have been searched. Thus, to perform a thorough search 

of a digital landscape, the user must define the lateral and vertical extent and resolution (node spacing) of the 3D 

search lattice (details are given in section 4.4.1.1.9.1). Table 3.3 lists the user-defined parameters that control a 

simple box search. 

 

Table 3.3. List of user-specified parameters required for simple box searches.  
 
[Details can be found in section 4.4.1.1.9.1. Note that these parameters can be readily selected and adjusted in the Search 
Configuration window found in the user interface program, Scoops3D-i (section 4.3.3.5)] 
 

Parameter name Controls Comments 
A. Size criteria   
vacriterion Primary size criterion Can be volume or area 
armin or vmin Minimum size In units of primary size criterion 
armax or vmax Maximum size In units of primary size criterion 
tol Size tolerance In units of primary size criterion 
dr Radius increment In length units of DEM 
   
B. Slip directions   
numdir Number of directions Odd integer required 
degmax Maximum deviation from fall 

 
Degrees 

deginc Interval size Degrees 
   
C. Vertical extent   
zsmin Minimum z In length units of DEM 
zsmax Maximum z In length units of DEM 
zsrchres Vertical resolution In length units of DEM 
   
D. Horizontal extent   
ismin Minimum i x-direction, DEM cell counter 
ismax Maximum i x-direction, DEM cell counter 
jsmin Minimum j y-direction, DEM cell counter 
jsmax Maximum j y-direction, DEM cell counter 
nsrchres Horizontal multiplier Search every nth horizontal node 
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There are an infinite number of trial surfaces in the domain beneath a DEM; Scoops3D therefore  

utilizes size limits (volume and [or] area) defined by the user to constrain the size of potential failure masses. 

Users are typically interested in the potential stability of masses in a certain size range, rather than those 

that are comparatively very small or very large. Defining appropriate potential failure size limits is crucial  

to a satisfactory stability analysis of the entire DEM (section 5.3.2). Scoops3D has two limits for valid  

potential failure masses: a volume range and a horizontal (planimetric) surface area range (details are given in 

section 4.4.1.1.10). One or both of these criteria can be used to check for valid trial surfaces, but the user selects 

one as the primary criterion. Note that the graphical user interface, Scoops3D-i, allows the use of only one 

(volume or area) size criterion. 

At each node in the search lattice there is an infinite number of possible spherical trial surfaces centered 

on that node. Scoops3D first identifies a surface that creates a potential failure size (either volume or area) near 

the minimum limit of the primary size criterion, within a tolerance chosen by the user. If the optional secondary 

criterion is chosen, valid potential failure masses must also have sizes within the minimum and maximum limits 

of the secondary criterion. Scoops3D then generates and analyzes additional trial surfaces by systematically 

increasing the radius of rotation in discrete steps, until the potential failure size exceeds the user-selected 

maximum volume and (or) area limits. Each of these spherical surfaces might intersect the DEM in multiple 

locations, and thus create multiple subsets of trial surfaces (fig. 3.3). Scoops3D keeps track of as many as ten 

subsets for each radius and independently analyzes all subsets that meet the volume/area size limits. Scoops3D 

moves on to the next search-lattice node once the largest subset reaches the user-defined maximum size limit. 

 

 
Figure 3.3. Diagram showing a single sphere that intersects an undulating DEM in multiple locations, thereby creating 
multiple trial surfaces (outlined in red). Scoops3D analyzes each trial surface separately. 
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Each spherical trial surface can slip (rotate) in any direction, and the computed stability may be different 

depending on the slip direction. Scoops3D always computes stability in the direction of an overall ground-surface 

fall direction (defined as the average ground-surface slope direction of all the full-column DEM cells included in 

a trial mass); this is the default mode. Commonly, this direction provides the minimum factor of safety, but not 

always. The user can specify that Scoops3D also compute a factor of safety for other slip directions on either side 

of the overall fall direction. Note that the axis of rotation will change orientation depending on slip direction. 

Details of specifying these other slip directions are given in section 4.4.1.1.9.1. 

3.2.2. Coarse-to-Fine Box Search 

For most projects, the user will want to use the coarse-to-fine search option to reduce overall computation 

time. Although the basic, simple box search described previously systematically examines all nodes in the 3D 

search-lattice array, this process can be very inefficient, because many of the search-lattice nodes will not yield 

critical surfaces in the DEM. The refinement technique in the coarse-to-fine search implements a series of 

iterations, each using a finer-resolution search lattice. The procedure for varying the potential failure mass size 

and slip direction at every search node is the same as for a simple box search (section 3.2.1). 

To use this technique, the user first defines the limits and spacing of the finest search lattice; this serves 

as the ultimate or final resolution of the search lattice. Then, the user selects a multiplier to create the coarsest 

resolution lattice subset from the finer lattice (fig. 3.4); this serves as the initial resolution of the search lattice. 

These additional parameters are listed in table 3.4. Scoops3D first searches all nodes from the coarse initial lattice 

(fig. 3.4A) and identifies the lattice nodes associated with a critical surface (having the lowest factor of safety) for 

each cell in the DEM (here called a critical lattice node or critical node). 

Table 3.4. List of parameters, in addition to those listed in table 3.3, required for a coarse-to-fine box search.  
 
[Details can be found in section 4.4.1.1.9.1] 
 

Parameter name Controls Comments 
irefine Flag to specify coarse-to-fine search  

multres Initial coarse lattice multiplier  

fostol F tolerance Value in percent, halts fine search 
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Figure 3.4. Sequence of perspective views (looking down from above) of a DEM and 3D array of search-lattice nodes for a 
progressive coarse-to-fine search. This example uses a coarse-to-fine multiplier of 8 (multres = 8). A, Search-lattice nodes 
for initial coarse search; overall extent of search is defined by box. B-F, Sequence of five iterative searches showing search 
nodes for a given iteration (red points) and all nodes previously searched (black points). With each iteration, the region 
containing critical lattice nodes becomes a smaller part of the overall search space. 
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The critical lattice nodes from this coarse search provide “seeds” for the first refined search iteration, 

where Scoops3D uses a finer resolution search-lattice interval around each critical node in a box-like region of 

lattice nodes spaced half the distance between the coarse nodes (fig. 3.4B). If any of the finer-resolution nodes 

have critical surfaces with a lower factor of safety at any DEM cell, that search node becomes a new critical seed 

node. Subsequent refinements of the search grid (fig. 3.4C, D, E, F) use the seed nodes from the previous 

iteration and search the box with nodes spaced half the distance between nodes used in the previous iteration, thus 

progressively searching finer and finer resolution lattices around the seed nodes. If no lattice node exists exactly 

at the halfway location, the next closest node toward the seed node is used instead. The search halts when no 

finer-spaced nodes result in a valid trial surface with a lower factor of safety than found previously (within a user-

defined tolerance, see section 4.4.1.1.9.1), or the search has examined the ultimate fine-resolution lattice. The 

locations of the critical lattice nodes may shift during the iteration process, but in the end the locations are usually 

similar to those found in a more complete simple search. 

The difference in searched lattice nodes between a simple search and a coarse-to-fine search can be seen 

by comparing figures 3.2 and 3.4F. Our empirical tests show that a multiplier of 6 or 8 for the initial coarse lattice 

often minimizes the number of trial surfaces examined, as well as the overall run-time, while not significantly 

compromising the thoroughness of the search. The default settings in Scoops3D-i use a coarse-to-fine search with 

the coarse grid 8X the spacing of the ultimate fine grid. 
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Chapter 4. Program Operation 
This chapter provides information about installing and running the two software programs, Scoops3D-i 

and Scoops3D. It describes how to use the graphical user interface (GUI), Scoops3D-i, to easily create and run 

slope-stability analyses with Scoops3D. It also provides detailed descriptions of the input files and parameters as 

well as the standard and optional output files. 

4.1. System Requirements and Installation 

The latest version of Scoops3D, Scoops3D-i, and associated documentation is available for download on 

the over the Internet at: http://pubs.usgs.gov/tm/14/a01. Consult the ReadMeScoops3D.txt file on this USGS web 

site for the latest information. The easiest method for installation of Scoops3D is to use the system-specific 

installation package. Packages are available for Microsoft Windows and Apple Macintosh operating systems to 

install executable versions of Scoops3D and Scoops3D-i, the Scoops3D manual, as well as associated icons and 

directories. To install Scoops3D and Scoops3D-i, the user should log in as an administrator (or authenticate as 

one when requested during the installation process), download the appropriate installer file (for Windows or 

Macintosh), launch the installer, and follow the directions. Note that the software is not copyrighted and the 

license agreement is for informational purposes only. 

Files containing examples of Scoops3D input and output can be downloaded to the user’s directory of 

choice. Scoops3D can be uninstalled with the Windows uninstaller, or by dragging the Scoops3D folder to the 

trash on the Macintosh OS. 

Source code and compiled executable versions of Scoops3D for Windows, Mac, Unix, and Linux are also 

available for download (see the ReadMeScoops3D.txt file for details). Compiled versions of Scoops3D can be 

executed without the Scoops3D-i interface. Scoops3D is written in the Fortran 90 programming language to 

provide computational efficiency, dynamic memory management, and cross-platform compatibility. The source 

code for Scoops3D can be compiled to execute on the user’s computer, provided the user has a Fortran 90 

language compiler. Thus, users may compile Scoops3D for execution on a wide variety of computer operating 

systems. We have successfully run versions of Scoops3D on a variety of Windows, Macintosh, Unix, and Linux 

operating systems - see the ReadMe file on the USGS web site for a current list. 

4.2. Running Scoops3D 

Scoops3D can be run from either the graphical user interface, Scoops3D-i (section 4.3), or from a 

command line. Before executing Scoops3D, the user must always construct the main parameter input file and 

provide a DEM file. Some slope-stability analyses may require additional input files (see section 4.4.2). 

http://pubs.usgs.gov/tm/14/a01
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Scoops3D-i provides a convenient tool to readily construct an internally consistent and complete main parameter 

input file and then to execute one or more Scoops3D runs. 

Alternatively, Scoops3D can be executed by double clicking on the Scoops3D executable program icon, 

or by typing the name of the executable file in a command prompt (Windows) or terminal (Macintosh) window. 

Before running Scoops3D in this scenario, the user needs to construct a complete main parameter input file 

(section 4.4.1) using a text editor or Scoops3D-i, as well as provide a DEM file and any necessary additional 

input files (section 4.4.2). Scoops3D will run and ask for the name of the main parameter input file. After the user 

enters this file name, Scoops3D executes and displays ongoing screen output (showing the search progress) in the 

command window. Some examples of command line input are shown in figure 4.1. When Scoops3D has 

completed execution, a message displays in the command window. In Windows, if the user initiates Scoops3D by 

double clicking on program icon, the command window will close automatically after Scoops3D completes its 

execution. 

 

 
A.  Command prompt window in Windows 7. 
 
Figure 4.1. Screenshots showing examples of Scoops3D run from command line input.  
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B. Terminal window in Mac OS 10.6. 
 
Figure 4.1. —Continued 
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4.3. Using Scoops3D-i, the Graphical User Interface 

The graphical user interface (GUI) for Scoops3D, called Scoops3D-i, provides a convenient way to create 

and (or) modify the main parameter input file needed to run Scoops3D. Scoops3D-i can also perform tasks such 

as running or stopping Scoops3D. By using Scoops3D-i, the user can create a complete and internally consistent 

input file. Once completed, this main parameter input file provides a listing of paths to all additional input files 

(such as files containing the DEM, subsurface distributions of material properties, or groundwater conditions) 

required for a given stability assessment. Scoops3D-i does not construct these additional input files – they must 

be prepared using other software. A complete listing of input files required by Scoops3D to perform various 

slope-stability assessments is presented in section 4.4. 

4.3.1. Basic Tasks with Scoops3D-i 

Scoops3D-i enables the user to perform the following activities: 

• Create a new main parameter input file for Scoops3D. 

• View and (or) modify an existing Scoops3D parameter input file. 

• Create a new parameter input file for Scoops3D using a trial surface from a previous Scoops3D 

run. 

• Check a Scoops3D input file for completeness before running. 

• Run Scoops3D with a designated input file. 

• Stop a Scoops3D run in progress. 

• Create additional parameter input files and run multiple Scoops3D runs at the same time. 

• View the text-based input and output files from a Scoops3D run. 

• Delete the output files from a previous Scoops3D run. 

4.3.2. Getting Started with Scoops3D-i 

Locate and launch the Scoops3D-i application using procedures appropriate for your computer operating 

system (such as double-clicking on the Scoops3D-i icon). After Scoops3D-i briefly displays a banner, the main 

window with a menu bar opens (fig. 4.2), along with an additional command line window (in the Windows 

operating system) to display runtime messages from Scoops3D-i and Scoops3D. Both windows close when 

Scoops3D-i is terminated. The user can perform basic tasks (see section 4.3.1) through the main Scoops3D-i 

window. This window contains a form for creating a Scoops3D input file as well as a menu bar with choices for 

modifying the input file and running Scoops3D. The main window pull-down menus are listed under File, Edit, 

View, Run, Options, and Help. The Scoops3D-i program can be terminated by selecting File > Quit or clicking 

the close button of the window. 
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Figure 4.2. Screenshot showing the main Scoops3D-i window with default parameters and main menu bar. 
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4.3.3. Create a New Input File for Scoops3D 

The main parameter input file for Scoops3D can be readily constructed using the main window (fig. 4.2) 

and associated “child windows” in Scoops3D-i. When Scoops3D-i first opens the main window or child 

windows, the windows contain a combination of blank parameters and default values. Selecting File > New in the 

main window menu bar resets the windows to these initial values. Child windows are accessed by way of buttons 

in the main window and are used for entering additional information. If desired, a main parameter input file can 

be saved in a partially complete state (by selecting File > Save or File > Save As in the main window menu bar) 

and reopened later for further modification. Scoops3D-i creates and prefers main parameter input files with a .scp 

extension. 

Detailed descriptions of each input parameter are provided in section 4.4.1, and are briefly summarized 

here. Input parameter names (for cross-referencing with section 4.4.1 descriptions) can be obtained by selecting 

Help > Balloon Help in the main window menu bar and then hovering with the cursor over an input area or radio 

button. In addition, brief descriptions of each variable can be viewed in a separate window by selecting Help > 

Scoops3D Variable Descriptions. 

The main Scoops3D-i window contains four sections for defining input parameters (fig. 4.2). Parameters 

can be selected in any order, but it is often useful to start at the top of the form and work down. Some default 

values for select parameters are based on other parameters (for example, the default horizontal extent of a box 

search is set by the dimensions of the DEM, thus entering the DEM first enables these default extents to be 

computed). The interface also restricts some parameters to an appropriate data type (for example, an integer, 

numeric, or character) and (or) an appropriate range of values. By following the sequence of entries described 

below, Scoops3D-i can be used to create a complete and consistent main parameter input file. 

4.3.3.1. Description and Units 

The top section of the main Scoops3D-i window displays the main parameter input file name (this name 

is untitled.scp if the file has not been saved already), a file description (as many as 120 characters), and a button 

for selecting unit descriptors. Clicking this button brings up the window shown in figure 4.3. The user can select 

the appropriate system of units for length, unit weight, and cohesion. Note that Scoops3D does not perform any 

unit conversions; the user should enter parameters in appropriate and consistent units (see section 4.4.1.1.2) and 

length units should match those of the DEM. Click OK or Cancel to return to the main window; values in the 

main window cannot be changed while a child window is open. 
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Figure 4.3. Screenshot showing window in Scoops3D-i for defining unit descriptors. 

4.3.3.2. Topography 

The second section in the main window allows selection of the DEM (digital elevation model) file using 

the Browse button. Note that the name must be selected by browsing rather than typed in directly. As a 

default the browse window displays files with .asc extensions (see section 4.4.2.1 for a description of the DEM 

file format). Once the DEM file is selected, the filename as well as the horizontal resolution and maximum and 

minimum elevations appear in the main window. Length units are displayed based on the unit descriptor 

selected previously; they are not read from the DEM file itself. 

4.3.3.3. Subsurface Conditions 

The third section in the main Scoops3D-i window contains information about subsurface conditions, 

including material properties, groundwater configuration, and earthquake loading. Material properties (strengths 

and unit weights) underlying the DEM can be characterized using homogeneous values, layers with differing 

properties (with layer elevations defined in a series of separate .asc files), or a 3D properties file. Depending on 

the desired configuration, select the appropriate Material properties option. If the layer files option is selected, 

enter the number of layers. Next, select a Groundwater configuration option: none (dry), Ru (pore-pressure 

ratio), piezometric surface file (.asc grid file containing water table elevations), a 3D pressure-head file, or a 3D 

variably saturated configuration. If the latter option is chosen, also select an option, either 3D combined water 

content file, van Genuchten SWCC, or Fredlund and Xing SWCC, from the pull-down menu. If earthquake 

loading is included, enter the dimensionless horizontal pseudo-acceleration coefficient (scaled as a fraction of g). 

If no earthquake loading effects are desired, leave this value set to zero. 
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After selecting options for these conditions, the user must click the Subsurface Parameters button to 

further define parameters based on the options selected in the main window. Failure to complete the Subsurface 

Parameters child window results in an incomplete input file. The Subsurface Parameters window that appears 

when the Subsurface Parameters button is clicked depends on which of the many possible combinations of 

material properties and groundwater configurations has been selected. Here we discuss three examples with 

increasing complexity. The simplest configuration (homogeneous with no groundwater) is shown in figure 4.4. 

For this case, enter cohesion, angle of internal friction, and total unit weight of the homogeneous material. A 

more complicated configuration (three material layers with a piezometric surface file) is shown in figure 4.5. In 

this case, the prefix (or root file name) for the layer files is defined using the upper Browse button and selecting 

any one of the layer files. Note that layer files are required to have a common prefix (section 4.4.2.1.4).  

Scoops3D-i extracts the prefix from the selected layer file. Next, enter cohesion, friction angle, and the partially 

saturated and saturated unit weights for all three layers, as well as the unit weight of water. Finally, select the 

piezometric surface file using the lower Browse button. Both layer files and piezometric surface files must be in 

.asc grid format (section 4.4.2). Click OK when finished to return to the main window. Clicking Cancel returns 

to the main window without making changes. 

 

 
Figure 4.4. Screenshot showing window in Scoops3D-i for defining subsurface parameters when homogeneous material 
properties and no groundwater options are selected. 
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Figure 4.5. Screenshot showing window in Scoops3D-i for defining subsurface parameters when three layers and a 
piezometric surface file are selected. 

An even more complex configuration (3D material properties file with 3D pressure-head file) is shown in 

figure 4.6. Here, click the upper Browse button to select a 3D material properties file (with a default .txt 

extension). Then select a method for defining the vertical distribution of values, either using linear interpolation 

between points or defined blocks with fixed parameter values. Select which parameters (cohesion, angle of 

internal friction, partially saturated, and [or] saturated unit weights) have a 3D distribution contained in the 3D 

file. At least one, and up to all, of the parameters may be defined in the file – ensure that the appropriate 

parameters are selected. For parameters not contained in the 3D file, enter values in the Layer #1 non-grey boxes. 

These values are assumed to be uniform throughout the 3D domain. Also, enter the unit weight of water in units 

consistent with the other unit weights. Finally, click the lower Browse button to select the 3D pressure-head file 

(with a default .txt extension). Click OK when finished to return to the main window. 
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Figure 4.6. Screenshot showing window in Scoops3D-i for defining subsurface parameters when 3D material properties and 
3D pressure-head file options are selected.  
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4.3.3.4. Stability Analysis: Limit-Equilibrium Method 

The fourth section of the main window contains options for the limit-equilibrium method and search 

method. Select either the Bishop’s simplified or Ordinary (Fellenius) methods (see section 2.3 for a description of 

these methods). Typically Bishop’s method produces slightly more accurate factor-of-safety results, although the 

Ordinary method provides a reasonable result in some cases where Bishop’s method produces spurious results 

(section 5.3.7). An advanced option when using Bishop’s method allows filtering of trial surfaces with spurious 

factors of safety (that is, those that have a small absolute value of mα, see section 2.3.2) from the results. The 

value for this filter is adjusted by selecting Options > Advanced Parameters from the main window menu bar. 

See section 4.4.1.1.8 for a more complete description of this option. 

4.3.3.5. Stability Analysis: Search Method 

Three methods are available to define the search lattice above the DEM: searching a box shaped lattice, 

computing a single trial surface using one lattice node, or searching a lattice region with the horizontal extent 

defined in a file (this can allow a non-rectangular horizontal extent of the search lattice). After selecting an 

option, the user must click the Search Configuration button to further define search parameters based on the 

option selected in the main window. An incomplete Search Configuration child window produces an incomplete 

input file. Selecting appropriate search parameters is crucial to performing a thorough search and completely 

mapping the factors of safety throughout the DEM. Some trial and error runs with different settings can help 

determine whether a thorough search has been performed (see chapter 5). See section 3.2 for further explanation 

of the search methods. 

4.3.3.5.1. Box Search 

If the box search method is selected and the user clicks the Search Configuration button, a window 

similar to that shown in figure 4.7 appears. The box option is the standard search method in Scoops3D. The top 

section of the window requires specification of the criterion for limiting the size range of potential failure masses. 

The range limits are based on either potential failure areas (horizontal extent) or volumes. Minimum and 

maximum values must be entered. It is usually not possible for Scoops3D to define an initial surface that exactly 

matches the minimum selected; thus a tolerance (as a percentage of the minimum value) is needed to obtain a trial 

failure with a size that falls within the range between the minimum and the minimum plus tolerance. The default 

tolerance is 10 percent of the minimum size. Smaller tolerance values force Scoops3D to obtain an initial trial 

surface with a size closer to the minimum, but can result in additional computational effort. 
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Figure 4.7. Screenshot showing window in Scoops3D-i for defining search configuration parameters for the box search 
method. This window shows parameters specified for Scoops3D Mount St. Helens example R (parameter file: R_sthel.scp) 
described in section 7.6. 

  



 55 

The second section of the window (Slip Directions) defines the number of slip directions and the 

maximum range of angles to analyze for each trial surface. The range is defined as the maximum deviation on 

either side of the slip direction obtained from the overall fall direction for the potential failure mass. Because the 

slip surface is spherical, a potential failure may occur with rotation in any direction. Scoops3D can compute the 

factor of safety for any rotation direction, but it always analyzes the case in the direction defined by the overall 

fall direction (see section 2.2). If the number of directions selected is one, then the factor of safety is computed 

only in the overall fall direction. If the number of directions is greater than one, then additional factors of safety 

are computed for slip directions on either side of the overall fall direction. Maximum deviation on either side of 

the fall direction is defined as an angle in degrees. Scoops3D-i computes the degree increment as a function of the 

number of slip directions and the maximum deviation to either side of the overall fall direction. 

The third section of the Search - Box window (Vertical Extent) defines the minimum and maximum 

vertical (z) extent of the search box in length units of the DEM – these are elevation values not relative vertical 

distances. The minimum z value should be greater than the lowest DEM elevation. An appropriate maximum z 

value may need to be determined by trial and error – it should be large enough to find minimum factor of safety 

values for all parts of the DEM, yet not large enough to cause unneeded computations (section 5.3.5). The vertical 

resolution is the distance between evenly spaced search-lattice nodes in the z direction, in length units of the 

DEM. The radius increment is also defined in length units of the DEM and represents the radius length increment 

for the set of spheres analyzed at a given lattice node; valid spheres must produce potential failure masses 

between the selected minimum and maximum sizes. 

The fourth section in this window (Horizontal Extent) defines the horizontal extent of the search box; 

here units are index counters defined relative to center of the lower left cell of the DEM, which corresponds to the 

coordinates i = 1, j = 1. Values of i increase in the positive x direction and j increase in the positive y direction 

(fig. 4.17). Minimum and maximum i and j values define the horizontal extent of the search lattice. A common 

choice is to define the horizontal search extent to match the extent of the DEM - the box at the top of the 

Horizontal Extent section can be checked to automatically create i and j limits that match the DEM. To search a 

box that includes search-lattice nodes outside the horizontal extent of the DEM, minimum i and j values can be 

set to negative values (each increment or decrement represents one additional DEM cell spacing) and maximum i 

and j values can be set to values greater than those defining the extent of the DEM. Alternatively, for a search box 

smaller than the DEM extent, the minimum i and j values should be greater than one, and the maximum i and j 

values less than the values defining the extent of the DEM (see section 4.4.1.1.9.1). The horizontal multiplier 

allows the search-lattice nodes to be defined at multiples of the DEM cell size. For example, a value of 2 places 

lattice nodes over the center of every other DEM cell. Note that the search-lattice nodes are located at the center 

of the DEM cells. See section 3.2 for further description of the search methods. 
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Clicking the Advanced button brings up the window shown in figure 4.8. This allows the user to select a 

simple search (where all lattice nodes are searched) or a coarse-to-fine search (section 4.4.1.1.9.1). Typically a 

coarse-to-fine search provides the most computationally efficient search, although a simple search may provide a 

more thorough examination. We have found empirically that a multiplier of 8 and a tolerance of 0.01 percent (the 

default values) produce a reasonably thorough yet computationally efficient search. Checking the box at the top 

of the window restores these default values if they have been modified. Click OK when finished to retain the 

selected parameters and return to the main window. 

 

 
Figure 4.8. Screenshot showing window in Scoops3D-i for selecting advanced search options. 

4.3.3.5.2. Single Trial Surface 

Scoops3D can compute the factor of safety for a single trial surface. This option is not a search; instead it 

relies on selecting one trial surface from a pre-existing search or precisely specifying the coordinates of one trial 

sphere. Selection of this option opens the window in figure 4.9 (if the user has already selected a DEM file). 

Select either Pre-existing run (this allows the user to select a single surface from a previous Scoops3D run) or 

Enter manually (this allows the user to precisely define a single surface). If Pre-existing run is selected and 

Next is clicked, then the window shown in figure 4.10 opens. Selecting a single surface from a pre-existing run 

allows the user to readily obtain the factor of safety, F, and volume information about individual trial surfaces 

from a previous search. Click on the Browse button to select a pre-existing Scoops3D input file. Output files 

associated with this input file must already exist. Possible selections from a pre-existing run include: the single 

surface with the global minimum F for the entire DEM, the single surface having the largest volume with F less 

than some chosen cutoff value, and the single surface having the lowest F at a specified location in the DEM.  

The x- and y-coordinates for this latter selection are specified in the coordinate system of the DEM (see  

section 4.4.2.1). Click OK when finished to return to the main window. 
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Figure 4.9. Screenshot showing window in Scoops3D-i for selecting the method to define a single trial surface. 

 

 
Figure 4.10. Screenshot showing window in Scoops3D-i for selecting a single trial surface from a pre-existing Scoops3D run.  



 58 

If the Enter manually option is selected and Next is clicked, then the window shown in figure 4.11 

opens. This option allows the user to manually define the rotational center of a trial sphere; no pre-existing output 

is needed. The center of the sphere is defined by x-, y-, and z- coordinates as well as a radius. The x-, y-, and z-

coordinates are specified in the length units and coordinate system of the DEM, where the coordinates of 

the lower left corner are defined in the DEM header by xllcorner, yllcorner (see example in section 4.4.2.1, 

fig. 4.20). The user can also specify a slip direction in degrees counter-clockwise from the positive x-axis (this 

parameter, angle, is further explained in section 4.4.1.1.9.2) or check the box to use the overall fall direction 

(defined relative to the ground surface). In both cases, the slip direction defines the axis of rotation. Click OK 

when finished to return to the main window. 

 

 
Figure 4.11. Screenshot showing window in Scoops3D-i for manually defining a single trial surface. 

4.3.3.5.3. File Search 

Selection of the file search method opens the window shown in figure 4.12. This option has similar 

parameters to the Box Search method (section 4.3.3.5.1), except that the horizontal extent of the initial coarse 

search is controlled by the contents of a file that can be chosen by clicking the Browse button. This file should be 

in ASCII raster grid format as described in section 4.4.2.1. Limiting the horizontal extent of the search through 

this option can shorten computational time when the area of interest in the DEM is irregularly shaped. The 

Advanced button functions similarly to that for the Box Search (section 4.3.3.5.1). Click OK when finished to 

return to the main window. 
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Figure 4.12. Screenshot showing Search Configuration window in Scoops3D-i for the “file” search method. Window shown 
is from Scoops3D Seattle example P (file name: P_seadry.scp) described in section 7.5. 
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4.3.3.6. Additional Output Options 

Additional output options can be selected by clicking Options > Output Files from the main window 

menu bar. The user does not need to select this option - Scoops3D creates the standard default output files 

(section 4.5.1) if this option is ignored. If this option is selected, then the Options – Output Files window shown 

in figure 4.13 appears. The user can choose to have Scoops3D create a new DEM file with a user-selected mass 

or masses removed, based on results from a stability analysis of the original DEM. Options for a new DEM 

include: removing only the mass with the global minimum factor of safety, F, less than a selected cutoff value; 

removing all masses with F less than a cutoff value; or removing only the largest (based on the primary size 

criterion) mass with F less than a cutoff value. The default F cutoff value is 10. The initial default setting does not 

create a new DEM file. 

 

 
Figure 4.13. Screenshot showing window in Scoops3D-i for selecting optional output files.  
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Other optional output files include any of the following: search quality files, a relative factor-of-safety 

file, a 3D search-lattice file, and (or) a 3D subsurface factor-of-safety file. These can be selected by checking the 

appropriate boxes in the Options – Output Files window. More complete descriptions of these output file 

options are provided in section 4.5.3. Click OK when finished to return to the main window. 

4.3.3.7. Save a Scoops3D Input File 

When finished entering parameters for the primary input file, select File > Save (if the file name remains 

the same). Alternatively, select File > Save As (if a new name is desired) from the main window menu bar, 

navigate to the appropriate directory (folder), enter a file name to identify the new input file, and click Save. The 

file will be saved with a .scp extension. 

4.3.4. View and/or Modify an Existing Scoops3D Input File 

An existing Scoops3D input file can be readily viewed and (or) modified using Scoops3D-i. From the 

main window menu bar, select File > Open, navigate to the desired directory (folder) containing the existing .scp 

file, select the file, and click Open. If the file has been opened recently, it may be opened by selecting File > 

Open Recent and choosing the desired file name. The main Scoops3D-i window then displays the contents of the 

existing .scp input file. An errorlog.txt window opens if linked files (such as the DEM or material layer files) are 

not found in the directories listed in the .scp file. If child windows are opened, such as the Subsurface 

Parameters or Search Configuration windows, they also display the relevant information contained in the .scp 

file. Recall that incomplete “in-progress” .scp files may exist. Thus, some parameters may be absent – these need 

to be entered before running Scoops3D. The text content of the .scp file can be viewed by selecting View > 

Scoops3D Input File from the main window menu bar. Existing .scp files can be readily modified and saved 

using the procedures described in section 4.3.3. 

4.3.5. Create a New Input File for Scoops3D Using a Single Trial Surface from a Previous Scoops3D Run 

Scoops3D-i can be used to examine the factor of safety and volume of a selected trial surface obtained 

from a previous Scoops3D run. The sequence of steps described here allows the user to start with the material 

properties and groundwater configuration defined in a previous Scoops3D run and modify them as desired. From 

the main window menu bar, select File > Open, navigate to the appropriate directory (folder) containing the 

existing .scp file, then select the file and click Open. Next, select File > Save As, navigate to the appropriate 

directory (folder) file, enter a new file name, and click Save. This sequence will preserve the previous run files. 

Then, in the main Scoops3D-i window, select single surface for the Search method and click Search 

Configuration. Pre-existing run is selected by default.  Click Next to proceed to the next window. Click on the 

Browse button to select the pre-existing .scp file from a previous Scoops3D run. Then pick a selection: (1) the 
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single surface with the global minimum F for the entire DEM, (2) the single surface having the largest volume 

with F less than some chosen cutoff value, or (3) the single surface having the lowest F at a specified location in 

the DEM. The x- and y-coordinates for this latter selection are specified in the coordinate system of the 

DEM where the coordinates of the lower left corner are defined in the DEM header by xllcorner, yllcorner 

(see section 4.4.2.1 and fig. 4.20). Click OK when finished to return to the main window. Modify other 

parameters as desired and select Run > Run Scoops3D to analyze the selected single trial surface. This procedure 

can be a useful analysis tool for testing sensitivity on a given trial surface, but keep in mind that the single surface 

with the global minimum F for the initial run may not be the same surface identified if the user conducts a new 

search with the modified parameters. 

4.3.6. Check a Scoops3D Input File for Completeness 

Before running Scoops3D, the user can check the main parameter input file for completeness and check 

for the existence of additional input files such as the DEM or layer files. Scoops3D-i can perform these checks for 

the currently open .scp input file by selecting Run > Check Input File from the main window menu bar. A 

window displays any missing values and the names of any missing input files. Note that this option only checks 

for the existence of the additional input files beyond the main parameter file; it does not determine 

whether the additional files contain data in the correct file formats. 

4.3.7. Run Scoops3D from Scoops3D-i 

Scoops3D can be run directly from the user interface, Scoops3D-i. After opening (by selecting File > 

Open) or creating a complete .scp input file, start Scoops3D by selecting Run > Run Scoops3D from the main 

window menu bar. Before launching Scoops3D, Scoops3D-i checks the input file for completeness, as described 

in section 4.3.6. If the input file is found to be OK, then Scoops3D is launched. As Scoops3D runs, the initially 

blank command tool window displays successive lines containing the current input file name, search node, search 

iteration number (for a coarse-to-fine search), the percentage completed of a specific search iteration, and the 

number of trial surfaces analyzed so far. If a simple search is selected, this window displays the percentage 

completed of the entire search and the number of trial surfaces analyzed. This display allows the user to 

determine how the Scoops3D simulation is progressing. When the run is completed, “Successful execution …” 

with Scoops3D version number, date, and time are displayed. Output files are placed in the subdirectory (folder) 

titled <filein>_output under the directory (folder) containing the .scp input file, where <filein> is the prefix to 

the .scp file. 
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Multiple Scoops3D runs can be performed simultaneously from Scoops3D-i. To perform an additional 

run while other runs are ongoing, open or create a different .scp input file and select Run > Run Scoops3D. 

Information about the simulation progress for all active runs is displayed in the Scoops3D-i window, but 

information from multiple simultaneous runs may be mixed in the window. Information for a particular run can 

be identified by the .scp file name at the beginning of each display line. 

4.3.8. Stop a Scoops3D Run in Progress 

Occasionally a user may want to stop a Scoops3D simulation run before it is completed. This can be 

achieved using Scoops3D-i by selecting Run > Stop Scoops3D from the main window menu bar and selecting 

the appropriate .scp file name from the list, provided the run was initiated in the current session of Scoops3D-i. 

The run then terminates and leaves the various output files incomplete. Other active simulations continue running. 

4.3.9. View Text-Based Input and Output Files 

The main parameter input file can be viewed using Scoops3D-i. To view this input file, open a .scp file 

and then select View > Scoops3D Input File from the main window menu bar. The file contents are displayed in 

a separate window; an example is shown in figure 4.14. If the main output file associated with the open .scp file 

exists, it can be viewed by selecting View > Scoops3D Output File. Other text files, including any of the 

Scoops3D output files, can be viewed by selecting View > ASCII Text File and selecting the appropriate file 

from the navigation window. View windows can be closed by clicking the red close button at the top of the 

windows. 
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Figure 4.14. Screenshot showing window in Scoops3D-i displaying an example of the main parameter input file for 
Scoops3D. This example has four layers with variable material properties and a groundwater configuration defined in a 3D 
pressure-head file. Taken from Seattle example Q (file name: Q_seawet.scp) described in section 7.5. 
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4.3.10. Delete Scoops3D Output Files 

To remove all output files associated with a previous Scoops3D run, first open the appropriate .scp input 

file in Scoops3D-i. Then select Run > Delete Scoops3D Output from the main window menu bar. A window 

lists the files that will be deleted. Clicking OK deletes these files (leaving a potentially empty output directory or 

folder) and returns the user to the main Scoops3D-i window. If desired, the user can then delete the output 

directory and (or) .scp file using the sequence appropriate for the user’s computer operating system outside of 

Scoops3D-i. 

4.3.11. Get Help for Scoops3D-i 

Additional help for using Scoops3D-i is available from the Help pull-down menu in the main window 

tool bar. Selecting Help > Scoops3D Manual brings up a pdf version of the manual. Selecting Help > Scoops3D 

Variable Descriptions opens a new window containing a brief list of the input parameters used in Scoops3D-i. 

Selecting Help > Balloon Help toggles on information balloons that briefly appear when using the cursor to 

hover over various parameters in the Scoops3D-i windows. Clicking this option again toggles off balloon help. 

Selecting Help > About provides information about Scoops3D-i (such as version number) and a URL where the 

latest version of the software can be obtained over the Internet from a USGS web site. 

4.4. Program Input 

This section details the input files and parameters needed to perform a slope-stability analysis in 

Scoops3D. At least two input files are always required: (1) the DEM file covering the area of interest and (2) the 

main parameter input file that contains control variables, search criteria, and material properties. Additional files 

are required for problems with a separate search file, multiple material layers with differing properties, 3D 

material properties, a piezometric surface, or 3D pore-pressure head data (table 4.1). Scoops3D-i can be used to 

build the main parameter input file and to select the additional files (section 4.3.3). When run at the command-

line, Scoops3D prompts the user for the main parameter input file name at the beginning of the run – this main 

file lists all the additional files. The complete file pathname for each input file may include as many as 220 

characters.
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Table 4.1. Descriptions of Scoops3D input files including recommended file extensions.  
 
[Input files contain three possible types of data: (1) text – a text listing of input parameters (section 4.4.1), (2) grid – raster grid data in Esri ASCII format  
(section 4.4.2.1), or (3) 3D – listing of 3D coordinates and pressure head or material properties at the specified coordinate that must include mandatory Scoops3D 
header information (section 4.4.2.2). Grid files may contain user-specified null values (equivalent to NODATA_values) as specified in the file header] 
 

Section File  
description1 

Criteria for 
optional files 

File 
extension Data type Description 

 Required files 

4.4.1 Main parameter input file --- .scp Text Material and search parameters, and input file names 

4.4.2.1.2 DEM --- .asc Grid Digital elevation model 

Optional files2     

4.4.2.1.3 Restricted search srch = 'file' or 
'FILE' 

.asc Grid Horizontal location of initial search extent 

4.4.2.1.4 Material layers nmat > 1 .asc Grid Elevation of bottom of material layers, n-1 number of 
files are needed to match n number of layers 

4.4.2.1.5 Piezometric surface water = 'pz' or 'PZ' .asc Grid Elevation of groundwater table 

4.4.2.2.4 3D pressure head water = '3d' or 
'3D' 

.txt or other 3D3 3D distribution of pressure head 

4.4.2.2.4 3D variably saturated pressure 
head and water content 

water = 'vs' or 'VS' .txt or other 3D3 3D distribution of variably saturated pressure head 
and water content 

4.4.2.2.5 3D variably saturated pressure 
head 

water = 'vg', 'VG', 
'fx' or 'FX' 

.txt or other 3D3 3D distribution of variably saturated pressure head 

4.4.2.2.6 3D material properties str3d = 1 .txt or other 3D3 3D distribution of material properties, such as 
strength and (or) unit weights 

1File names are user-defined.     
2Required if specific options are selected in the main parameter input file.   
33D files have various formats—see section 4.4.2.2.   
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The file format and data contents for each input file are described in the following sections. Files required 

for all problems are designated with a REQUIRED label. 

4.4.1. Main Parameter Input File 

REQUIRED. 

FORMAT: text. Scoops3D-i, designates these files with a .scp extension. 

This required input file contains information about subsurface material properties (shear strengths, unit 

weights, groundwater conditions, earthquake loading coefficient), the slope-stability analysis method, the search-

lattice configuration, and output file options. The last lines of this file contain operating system-specific 

pathnames to the DEM file and any additional input files. 

The main parameter input file is most easily created using Scoops3D-i (see section 4.3). Scoops3D-i 

helps the user create an internally consistent and complete parameter input file. The parameter input file can also 

be created or modified from an existing input file using a text editor. Note that there must be a carriage return 

after the last data value in this file for the input to be read completely. 

Input parameters in this file must be entered as a series of parameter-line pairs; these two-line pairings 

are demonstrated in the example input files shown in figures 4.15 and 4.16. The first line of each pair is 

descriptive and the first word in the line is the parameter-line id; the second line contains the actual numeric or 

alphanumeric values. Scoops3D-i creates parameter input files with labels for all of the parameters in each line 

pair. Parameter values are read in free form and do not require a specific format or specific spacing between 

entries. Any parameter-line pairs that do not start with the first two letters of a recognized parameter-line id label 

are ignored. Blank lines between two-line pairs are also ignored; however, no lines can separate the first and 

second lines of a specific parameter-line pair. If comment lines are desired, we recommend starting those 

lines with non-alphanumeric values (for example, !!! or #) to avoid any chance of confusion by accidental 

replication of a valid parameter-line id. 

Most of the parameter-line pairs can be placed in any order within the main parameter input file. 

However, some crucial parameter pairs require specific ordering, and these are noted in their individual 

descriptions below. Scoops3D-i automatically provides valid line ordering. 
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title # section 4.4.1.1.1 
Scoops3D example R; Mount Saint Helens   
lengthunits  ceeunits gamrunits # section 4.4.1.1.2 
m  kPa  kN/m^3   
water # section 4.4.1.1.3 
no   
nmat # section 4.4.1.1.4.1 
1   
lnum  cee  phi  gamt # section 4.4.1.1.4.1 
1  1000.  40.  24.    
eq # section 4.4.1.1.5 
0   
method # section 4.4.1.1.6 
B   
srch # section 4.4.1.1.9 
box   
ismin  jsmin  ismax  jsmax  nsrchres # section 4.4.1.1.9.1 
1  1  96  91  1   
zsmin  zsmax  zsrchres # section 4.4.1.1.9.1 
1000  9200  100   
irefine  multres  fostol # section 4.4.1.1.9.1 
1  8  0.01   
dr  deginc  degmax  numdir # section 4.4.1.1.9.1 
50  0  0  1   
vacriterion  armin  armax  vmin  vmax  tol  limcol # section 4.4.1.1.10 
V  0  0  .10E+9  3.5E+9  10000000.0  100   
remove  foscut # section 4.4.1.1.11.1 
M  5.0   
isqout # section 4.4.1.1.11.2 
1   
irelfos # section 4.4.1.1.11.3 
1   
icritlattice # section 4.4.1.1.11.4 
1  
ilattice # section 4.4.1.1.11.5 
1   
isubsurf zfrac # section 4.4.1.1.11.6 
1  1   
DEM file # section 4.4.1.1.12 
input\sthel_res100mDEM.asc   
output directory # section 4.4.1.1.13 
R_sthel_output\   

 

Figure 4.15. Text listing showing an example of a Scoops3D main parameter input file configured for homogeneous material 
with a box search and optional output files. Parameter-line pairs are distinguished by a line ID containing text descriptors 
followed by a line containing the parameter values. These lines are keyed by section numbers (for example, 4.4.1.1.1) for 
reference purposes; each section contains a complete description of the line pair. Note that files created by Scoops3D-i list 
full path names for input and output files, but the Scoops3D example files, including the one shown here, use relative path 
names (see chapter 7). Example is taken from Mount St. Helens example R (file name: R_sthel.scp) described in section 7.6. 
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title # section 4.4.1.1.1 
Arai and Tagyo 1985, 3D material properties combined w/ 3D pressure head file  
lengthunits  ceeunits gamrunits # section 4.4.1.1.2 
m  kPa  kN/m^3   
water gamw # section 4.4.1.1.3 
3d  9.81   
str3d  linterp # section 4.4.1.1.4.2 
1  0   
nmat # section 4.4.1.1.4.1 
1   
lnum  cee  phi  gamps  gams   # section 4.4.1.1.4.1 
1  -1  -1  -1  -1    
eq # section 4.4.1.1.5 
0   
method # section 4.4.1.1.6 
B   
srch  # section 4.4.1.1.9 
single   
xcen  ycen  zcen  rad  angle # section 4.4.1.1.9.2 
25.25  33.25  47  33.76  365   
remove  foscut # section 4.4.1.1.11.1 
M  10   
isqout # section 4.4.1.1.11.2 
0   
irelfos # section 4.4.1.1.11.3 
0   
icritlattice # section 4.4.1.1.11.4 
0   
isubsurf zfrac # section 4.4.1.1.11.6 
0  1   
DEM file # section 4.4.1.1.12 
C:\Users\SCOOPSuser\Scoops3D\examples\AraiTagyo\input\emb20dem.asc  
pressure head file # section 4.4.1.1.12 
C:\Users\SCOOPSuser\Scoops3D\examples\AraiTagyo\input\emb20phead3D.txt   
material properties file # section 4.4.1.1.12 
C:\Users\SCOOPSuser\Scoops3D\examples\AraiTagyo\input\emb20mat3d.txt   
output directory # section 4.4.1.1.13 
C:\Users\SCOOPSuser\Scoops3D\examples\AraiTagyo\emb20_single_output\   
 
Figure 4.16. Text listing of an example of a Scoops3D main parameter input file configured for a single trial surface computation (srch = ‘single’) with a 3D 
material property file and a 3D pore-pressure file. Parameter-line pairs are distinguished by a line ID containing text descriptors followed by a line containing the 
parameter values. These lines are keyed by section numbers (for example, 4.4.1.1.1) for reference purposes.  
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4.4.1.1. Input Parameter Descriptions 

This section describes each set of parameters. The parameter-line id label (LINE ID) is shown for each 

line pair, followed by the name and description of each parameter contained in the second line of the pair. Any 

limits on the parameters, their variable type (character, numeric, integer), and naming conventions are described 

in these sections. 

4.4.1.1.1. Title 

NOT REQUIRED by Scoops3D, but required in Scoops3D-i. 

LINE ID: title 

title  user-defined description line, maximum of 120 characters. (Character). 

4.4.1.1.2. Unit Descriptors 

NOT REQUIRED. 

Note that unit names are for descriptive purposes only; Scoops3D does not check whether the units are 

internally consistent nor does it convert any units to be consistent with the others. 

LINE ID: lengthunits ceeunits gamrunits 

lengthunits  user-defined units of length (for example, ‘m’ or ‘ft’). Note that all input parameters and 

data contained in other input files should use consistent units (for example, DEM, layer 

and piezometric surface elevations, and 3D pressure-head values should be in the same 

length units). (Character, maximum length of two characters). 

 

ceeunits user-defined units for cohesion (for example, ‘kPa’ or ‘lb/ft^2’). (Character, maximum 

length of eight characters). 

 

gamrunits  user-defined units for unit or specific weights (for example, ‘kN/m^3’ or ‘lb/ft^3’). 

(Character, maximum length of eight characters). 
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4.4.1.1.3. Groundwater Options 

NOT REQUIRED. 

If this pair is absent, then no groundwater pore pressures are used in the stability computations. Note that 

this line pair must come before the material properties line pair (section 4.4.1.1.4). Section 2.4 describes how 

different groundwater options are used in the computation of factor of safety. The options with 3D variably 

saturated or unsaturated pressure heads (‘vs’,’vg’, or ‘fx’) cannot be used with a 3D material properties file. 

LINE ID: water gamw 

water two character descriptor that indicates which method is used to determine pore-water pressures 

for the slope-stability computations. Seven options are available. If water = ‘no’ or ‘NO’, no pore 

pressures are used in calculations. If water = ‘ru’ or ‘RU’, a fraction of overlying column weight 

is used as an approximation of pore pressure and this pore-pressure ratio must be specified for 

each material layer in the property layers input. If water = ‘pz’ or ‘PZ’ (piezometric or water 

table surface), ‘3d’ or ‘3D’ (3D pressure heads), ‘vs’ or ‘VS’ (3D variably saturated pressure 

heads and water contents), ‘vg’ or ‘VG’ (van Genuchten SWCC and 3D variably saturated 

pressure heads), or ‘fx’ or ‘FX’ (Fredlund and Xing SWCC and 3D variably saturated pressure 

heads), the corresponding file name must be included at the end of the parameter input file. The 

formats and pathname requirements for these files are described below. (Character, ‘no’, ‘NO’, 

‘ru’, ‘RU’, ‘pz’, ‘PZ’, ‘3d’,‘3D’, ‘vs’, ‘VS’,’vg’,’VG’,’fx’, or ‘FX’). 

 

gamw  unit weight of water ( ) in units consistent with all other parameters. Only required if water = 

‘pz’ (or ‘PZ’), water = ‘3d’ (or ‘3D’), water = ‘vs’ (or ‘VS’), water = ‘vg’ (or ‘VG’), or water = 

‘fx’ (or ‘FX’). (Numeric, ≥ 0). 

4.4.1.1.4. Material Properties 

REQUIRED. 

One of the following options is required (see sections 4.4.1.1.4.1 or 4.4.1.1.4.2). The user may select 

either an option for material layers (using nmat and associated lnum lines) or an option for using a 3D 

distribution contained in a separate file. If a homogeneous or uniform domain is desired, the user should use the 

option described in section 4.4.1.1.4.1 with one layer (nmat = 1). If only some of the material properties are 

contained in a 3D file, the other properties should be designated using the homogeneous, one-layer method. 
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4.4.1.1.4.1. Property Layers Option 

This option requires the nmat line pair and associated lnum line pairs describing the material properties 

for each layer. For example, if the user specifies three layers (nmat = 3), there must also be three pairs of lnum 

lines to designate the properties for each layer. Separate input files define the bottom elevation for each material 

layer (section 4.4.2.1.4). Note that all material parameters should have consistent units with each other and 

with the units of the DEM. 

LINE ID: nmat 

nmat  the number of layers used to define material properties for the slope-stability computations. 

(Integer, ≥ 0). 

 

 The parameters contained in the lnum line pairs depend on the groundwater option selected, as follows: 

If no groundwater (water = ‘no’ or ‘NO’) then: 

LINE ID: lnum cee phi gamt 

or, if pore-pressure ratio (water = ‘ru’ or ‘RU’) then: 

LINE ID: lnum cee phi gamt ru 

or, if piezometric surface (water = ‘pz’ or ‘PZ’) or if 3D pressure-head file (water = ‘3d’ or ‘3D’) then: 

LINE ID: lnum cee phi gamps gams 

or, if 3D variably saturated pressure-head and water content file (water = ‘vs’ or ‘VS’) then: 

LINE ID: lnum cee phi gams thetares thetasat 

or, if van Genuchten SWCC and 3D variably saturated pressure-head file (water = ‘vg’ or ‘VG’) then: 

LINE ID: lnum cee phi gams thetares thetasat vgalpha vgn 

or, if Fredlund and Xing SWCC and 3D variably saturated pressure-head file (water = ‘fx’ or ‘FX’) then: 

LINE ID: lnum cee phi gams thetares thetasat fxa fxn fxm fxr 

 

where: 

lnum  the layer identification number. (Integer, > 0 and ≤ nmat). 
 

cee cohesion (c) for a layer. (Numeric, ≥ 0). 

 

phi  angle of internal friction (ϕ) for a layer, in degrees. (Numeric, ≥ 0). 

 

gamt  total unit weight (γt) for a layer of earth material. This value is required if either the no pore 

pressure option (water = ‘no’ or ‘NO’) or the pore-pressure ratio option (water = ‘ru’ or ‘RU’) is 

selected. (Numeric, ≥ 0) 
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gamps  partially saturated unit weight (γps) for a layer of earth material, used for materials above the 

piezometric or zero-pressure surface. This value is required if either the piezometric surface 

option (water = ‘pz’ or ‘PZ’) or 3D pressure-head file option (water = ‘3d’ or ‘3D’) is selected. It 

is NOT used for variably saturated configurations (water = ‘vs’, ‘VS’, ‘vg’, ‘VG’, ‘fx’, ‘FX’). 

(Numeric, ≥ 0). 

 

gams  saturated unit weight (γs) for a layer of earth material, used for materials below the piezometric 

surface or where positive pore pressures are specified by a 3D pressure-head file. This value is 

required if either the piezometeric surface option (water = ‘pz’ or ‘PZ’), the 3D pressure-head 

file option (water = ‘3d’ or ‘3D’), the 3D variably saturated pressure head and water content file 

option (water = ‘vs’ or ‘VS’), the van Genuchten SWCC and 3D variably saturated pressure-head 

file option (‘vg’ or ‘VG’), or the Fredlund and Xing SWCC and 3D variably saturated pressure-

head file option (‘fx’ or ‘FX’) is selected. (Numeric, ≥ 0). 

 

ru  pore-pressure ratio (only required if water = ‘ru’ or ‘RU’), defined as the ratio of pore pressure to 

vertical stress, or u tr u zdz= ∫γ  (section 2.4), where u is pore pressure on the trial surface, γt is 

total unit weight (earth material plus pore water), and z is the vertical distance from the trial 

surface to the ground surface. The value of ru is used to compute the pore pressure acting on the 

trial surface of each column within the potential failure mass. The user can specify different ru 

values for different layers, but ru is constant within a layer. Typically, values of ru are less than 

0.5. (Numeric, ≥ 0). 

 

thetares  residual water content (θr) in partially saturated earth material layer. This value is required if any 

of the 3D variably saturated options (water = ‘vs’, ‘VS’, ‘vg’, ‘VG’, ‘fx’ or ‘FX’) are selected. 

(Numeric, ≥ 0). 

 

thetasat saturated water content (θs) for a layer of earth material. This value is required if any of the 3D 

variably saturated options (water = ‘vs’, ‘VS’, ‘vg’, ‘VG’, ‘fx’ or ‘FX’) are selected.  

(Numeric, ≥ 0). 

vgalpha αvG parameter for the van Gunuchten (1980) soil-water characteristic curve (see section 2.4 and 

equation 2.39). This value is required if the van Genuchten SWCC and 3D variably saturated 

pressure-head file option (water = ‘vg’ or ‘VG’) is selected. (Numeric, > 0). 

 



 74 

vgn nvG parameter for the van Gunuchten (1980) soil-water characteristic curve (see section 2.4 and 

equation 2.39). This value is required if the van Genuchten SWCC and 3D variably saturated 

pressure-head file option (water = ‘vg’ or ‘VG’) is selected. (Numeric, > 0). 

 

fxa aFX parameter for the Fredlund and Xing (1994) soil-water characteristic curve (see section 2.4 

and equation 2.40). This value is required if the Fredlund and Xing SWCC and 3D variably 

saturated pressure-head file option (water = ‘fx’ or ‘FX’) is selected. (Numeric, > 0). 

 

fxn nFX parameter for the Fredlund and Xing (1994) soil-water characteristic curve (see section 2.4 

and equation 2.40). This value is required if the Fredlund and Xing SWCC and 3D variably 

saturated pressure-head file option (water = ‘fx’ or ‘FX’) is selected. (Numeric, > 0). 

 

fxm mFX parameter for the Fredlund and Xing (1994) soil-water characteristic curve (see section 2.4 

and equation 2.40). This value is required if the Fredlund and Xing SWCC and 3D variably 

saturated pressure-head file option (water = ‘fx’ or ‘FX’) is selected. (Numeric, > 0). 

 

fxr ψr, residual suction parameter for the Fredlund and Xing (1994) soil-water characteristic curve 

(see section 2.4 and equation 2.41). This value is required if the Fredlund and Xing SWCC and 

3D variably saturated pressure-head file option (water = ‘fx’ or ‘FX’) is selected. (Numeric, > 0). 
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4.4.1.1.4.2. 3D Property File Option 

LINE ID: str3d linterp 

str3d flag indicating that a 3D file is used to specify material properties for the slope-stability 

computations. If str3d = 1, the 3D material properties file name must be included at the end of 

the main parameter input file (fig. 4.16). The format for this file is described in section 4.4.2.2. 

Note that when using a 3D material properties file, if all properties needed for the simulation are 

included in the 3D file, the main input file does not need a nmat line pair. If water = ‘ru’ (or 

‘RU’) is specified, then the value for ru must be constant throughout the domain. If the 3D file 

contains some but not all of the material properties or water = ‘ru’ (or ‘RU’), the nmat and lnum 

line pairs (section 4.4.1.1.4.1) must be included with nmat = 1. Each parameter included in the 

3D file must be assigned a value of -1 in the lnum line. Parameters not in the 3D file are assumed 

to be constant throughout the domain and set to the value specified in the lnum line. In the 

example shown in figure 4.16, cee, phi, and the unit weight values are assigned values of -1 to 

indicate that they are contained in the 3D material properties file. Note that Scoops3D cannot 

incorporate 3D distributions of residual, thetares, and saturated, thetasat, water contents in the 

3D material properties file. (Integer, 0 or 1). 

 

linterp flag for linear interpolation. If linterp = 1, Scoops3D linearly interpolates between vertical 3D 

property data to determine values at the trial surface. Otherwise, Scoops3D uses the values 

associated with the 3D block containing the trial surface. (Integer, 0 or 1). 

 

4.4.1.1.5. Earthquake Loading 

NOT REQUIRED. 

LINE ID: eq 

eq earthquake or seismic loading, imposed as a horizontal pseudo-acceleration coefficient (keq) and 

given as a dimensionless coefficient relative to a fraction of gravitational acceleration, g  

(section 2.3). (Numeric, ≥ 0). 

  



 76 

4.4.1.1.6. Slope-Stability Analysis Options 

REQUIRED. 

LINE ID: method 

method the limit-equilibrium method used for computing factor of safety. Specify method = ‘B’ (or ‘b’) 

to implement Bishop's simplified method or method = ‘O’ (or ‘o’) for the Ordinary (Fellenius) 

method. See section 2.3 for a discussion of these methods. If method = ‘B’ (or ‘b’) is specified, 

Scoops3D also calculates the factor of safety using the Ordinary method for the critical surfaces 

identified with Bishop’s method. Note that the critical surfaces found using the two methods may 

be different. (Character, ‘b’, ‘B’, ‘o’, or ‘O’). 

4.4.1.1.7. Iteration Tolerance for Bishop’s Simplified Method 

NOT REQUIRED. Only used when method = ‘B’ (or ‘b’). 

This option allows the user to modify the Scoops3D default iteration tolerance (0.0001) used with 

Bishop’s simplified method (see section 2.3.2). This advanced option is not available in Scoops3D-i. Typically, 

the user will not need to modify this value. If the default tolerance is adequate, this parameter does not need to be 

specified. 

LINE ID: diter 

diter a user-defined tolerance level for halting the iteration process when using Bishop's simplified 

method. If not specified, Scoops3D uses a default value of diter = 0.0001. Stability computation 

for a given trial surface is halted when the difference between the factor of safety computed in 

the current iteration and the previous iteration is less than diter (that is, |(Fnew-Fold)| < diter). Trial 

surfaces that do not reach this tolerance are eliminated from consideration, but they are listed in 

the files <filein>_filter_out.txt and <filein>_filtergrid_out.asc (see section 4.5.2). Iterations for 

trial surfaces that do not reach this tolerance within 10 iterations are terminated unless the 

solution is converging monotonically. Scoops3D will allow solutions with monotonic 

convergence to continue up to a maximum of 25 iterations before termination of iteration 

calculations. See section 2.3.2 for an explanation of the iteration process. The parameter diter is 

optional and is only used if method = ‘B’ or ‘b’. (Numeric, > 0). 
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4.4.1.1.8. Filter Option for Bishop’s Simplified Method 

NOT REQUIRED. Only used when method = ‘B’ (or ‘b’). 

This option allows the user to filter spurious or unreliable solutions from the search by removing 

solutions with low values of mα determined during the iteration process. Bishop’s simplified method may 

occasionally converge to an incorrect (very low or negative) value of factor of safety – see section 2.3.2 for more 

explanation. The effectiveness of filtering can vary between problems; some trial and error investigation may be 

required to select an appropriate filter value (section 5.3.7). 

LINE ID: absminma 

absminma minimum value of mα (section 2.3.2) used to filter results when using Bishop’s simplified 

method. If a trial surface has one or more columns with ma < absminma, the surface is 

eliminated from consideration, but information about the surface is included in 

<filein>_filter_out.txt and <filein>_filtergrid_out.asc (see section 4.5.2). The value of mα 

depends on a number of factors, including the maximum and minimum dips of columns in the 

trial surface; the optimal filter value may vary between problems and selecting an appropriate 

value may require some investigation. If method = ‘O’ (or ‘o’), this parameter is ignored. 

(Numeric, > 0). 

4.4.1.1.9. 3D Search Options 

REQUIRED. 

The srch parameter-line pair is required and subsequent lines depend on the option selected for srch. 

Three options are available: ‘box’, ‘file’, or ‘single’ and only one can be selected. With box and file options, the 

user defines the extent of the search lattice. The single option defines one individual trial surface; this option does 

not invoke a 3D search. 

LINE ID: srch 

srch descriptor that specifies the search option. The required parameters for each option, ‘box’, ‘file’, 

or ‘single’, are described below (sections 4.4.1.1.9.1, 4.4.1.1.9.2, or 4.4.1.1.9.3, respectively). 

(Character, ‘box’, ‘BOX’, ‘file’, ‘FILE’, ‘single’, or ‘SINGLE’). 
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4.4.1.1.9.1. Box Search 

If srch = ‘box’ (or ‘BOX’) then the horizontal extent of the search lattice is a rectangular box defined 

relative to the DEM. Three parameter-line pairs must be included with this option; an additional line pair for a 

coarse-to-fine search is optional. Note that the horizontal extent and nodal spacing of the search lattice is 

specified differently than the vertical extent and spacing. 

LINE ID: ismin jsmin ismax jsmax nsrchres 

ismin, jsmin, ismax, jsmax the horizontal limits of the search lattice relative to the DEM array bounds, 

expressed as ij cell counters. The lower left cell of the DEM has values i =1, j = 

1, where i increases in the positive x direction and j increases in the positive y 

direction (fig. 4.17). For example, if the search lattice covers the same horizontal 

extent as the DEM, then ismin =1, jsmin = 1, ismax = ncols, and jsmax = nrows, 

where ncols and nrows are the maximum array bounds of the DEM (fig. 4.17A). 

The user can readily select this option when using Scoops3D-i. (Integer). 

 

In some cases, the user may want the search lattice to extend beyond or be restricted to only part of the 

DEM extent (see sections 3.2 and 5.3.5). For example, if the search lattice needs to extend horizontally beyond 

the lower and (or) left side boundaries of the DEM grid, then ismin and (or) jsmin should be set to an integer 

value less than 1 (for example, a value of ismin = 0 starts the search lattice a distance, in the x direction, of one 

DEM cell spacing away from the center of the leftmost DEM cell, and a value of ismin = -1 starts the search 

lattice two cells outside the DEM). Note that search-lattice nodes are located above the centers of the DEM grid 

cells. For search-lattice coverage beyond the right or upper side of the DEM grid, ismax and (or) jsmax should be 

greater than the maximum array boundaries (fig. 4.17B). Likewise, for search-lattice coverage smaller than the 

DEM grid, use values for ismin and jsmin greater than one and values for ismax and jsmax less than the DEM 

boundaries (fig. 4.17C). In all cases with this option, the horizontal extent of the search lattice forms a rectangle. 

(Integers). 

nsrchres  a multiplier used to control the horizontal (x and y) nodal spacing of the search lattice relative to 

the resolution of the DEM grid. If nsrchres = 1, the search-lattice spacing in the horizontal 

directions equals the DEM grid resolution. The horizontal search grid spacing cannot be finer 

than the DEM grid resolution (nsrchres  1). If a coarse-to-fine search is selected, nsrchres is 

the spacing of the finest search lattice (see also the irefine line pair discussed below).  

(Integer, > 0). 
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Figure 4.17. Multiple diagrams illustrating different parameter configurations controlling the horizontal spacing of the search 
lattice. Each diagram shows a plan view of a DEM grid (squares) and search lattice (nodal points centered above the DEM 
cells). Note that for illustrative purposes, the DEM shown has only 21 rows and columns; it likely would not provide a sufficient 
number of columns for a good estimate of factor of safety. A, Search-lattice spacing matches the horizontal extent and 
spacing of the DEM grid. B, Search lattice extends beyond the DEM grid with a spacing that matches the DEM cell size 
(nsrchres = 1). C, Search-lattice horizontal extent is less than the DEM boundaries and lattice node spacing is larger than 
the DEM cell size (nsrchres = 4).  
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LINE ID: zsmin zsmax zsrchres 

zsmin the minimum elevation of the search-lattice nodes, in the same length units as the DEM  

(fig. 4.18). If zsmin is located below the surface of the DEM at a specific horizontal search-lattice 

location, Scoops3D calculates the elevation of the first search-lattice node as zsmin plus a 

multiple of zsrchres, so that the lattice node being used is always above the DEM. (Numeric). 

 

zsmax the maximum elevation of the search lattice, in the same length units as the DEM. (Numeric). 

 

zsrchres the vertical (z) spacing between search-lattice nodes in the same length units as the DEM. The 

value of zsrchres may be any number and need not be a multiple of the DEM grid resolution 

(unlike nsrchres). (Numeric, > 0). 

 

 
Figure 4.18. Diagram illustrating the parameters controlling the horizontal and vertical search node spacing as well as the 
vertical limits (zsmin and zsmax) of the search lattice. A perspective view of a DEM and one vertical slice through a 3D 
search lattice is shown. Note that the parameter describing horizontal spacing (nsrchres) is a multiplier of the DEM cell size, 
whereas the parameter describing the vertical spacing (zsrchres) is in length units of the DEM and need not be a multiple of 
the DEM cell size. 
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LINE ID: dr deginc degmax numdir 

dr the radius increment used to construct trial surfaces, in the same length units as the DEM. The 

value of dr is used to systematically increase the radius of the spheres generated around each 

search-lattice node. This systematic increase creates a series of trial surfaces ranging in size 

between the user-specified minimum and maximum volumes or areas (section 4.4.1.1.10). 

Scoops3D determines an initial radius for each node that creates a trial failure with a size 

(volume or area) near the user-specified minimum (within a user-specified tolerance) for the 

primary size criterion. Subsequent trial surfaces at the same search-lattice node are obtained by 

increasing the sphere radius by dr, until the potential failure mass exceeds the user-specified 

maximum volume or area or it intersects a DEM boundary. (Numeric, > 0). 

 

deginc the degree increment for analyzing additional slip directions (for a given trial surface) located to 

either side of the overall fall direction (fig. 4.19). The azimuthal overall fall direction is found 

from the average ground-surface slope direction for all full DEM cells contained in the potential 

failure mass (see section 2.2); Scoops3D always computes the factor of safety for potential slip in 

this direction. To analyze only trial surfaces rotating in the direction of the overall fall direction, 

the user should set deginc = 0. In some cases, such as those with a very uneven distribution of 

mass or strength, the minimum factor of safety for a given trial surface may be in a direction that 

differs from the overall fall direction. To analyze potential slip in other directions, the user needs 

to input values for both deginc and degmax. (Numeric, ≥ 0). 

 

degmax the maximum deviation, in degrees, to analyze slip directions on either side of the overall fall 

direction (fig. 4.19). Note that degmax must be a multiple of deginc. If degmax is smaller than 

deginc, Scoops3D sets degmax to 0 and only analyzes the overall fall direction. (Numeric, ≥ 0). 

 

numdir number of slip directions analyzed for each potential failure mass, including the overall fall 

direction ( (2*degmax)/deginc + 1). This parameter is used by Scoops3D-i and is ignored by 

Scoops3D. (Integer, odd value ≥ 1). 

 



 82 

 
Figure 4.19. Diagram illustrating parameters used to analyze slip directions that differ from the azimuthal overall fall direction. 

 

LINE ID: irefine multres fostol 

This line pair is optional. 

irefine  flag to specify the coarse-to-fine search method where an initial coarse search is performed with 

subsequent search refinement (see section 3.2.2 for details of this method). If irefine = 1, this 

option is implemented and both multres and fostol must be defined. If irefine = 0, multres and 

fostol are ignored. (Integer, 0 or 1). 

 

multres multiplier to define the spacing of the initial coarse search lattice. The initial coarse search node 

spacing in a horizontal plane is multres*nsrchres*DEM cell size and the node spacing in a 

vertical plane is defined by multres*zsrchres. The finest search node spacing is defined by 

nsrchres*DEM cell size (horizontally) and zsrchres (vertically). (Integer, > 0). 

 

fostol tolerance in computed factor of safety used to halt fine search iterations, expressed in percent. 

When the percentage difference in computed factor of safety for all DEM cells in the current 

iteration compared to those from previous iteration (defined as ((Fnew– Fold)/ Fold)*100) is less 

than fostol, then the search is finished. (Numeric, %, > 0). 
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4.4.1.1.9.2. Single Trial Surface 

If srch = ‘single’ (or ‘SINGLE’) then Scoops3D calculates the stability of a single user-defined trial 

surface. Only the following parameter-line pair is needed for this option. Commonly, these values are obtained 

from a previous Scoops3D run. 

LINE ID: xcen ycen zcen rad angle 

xcen, ycen, zcen coordinates of the center for the single trial surface, specified in the coordinate system of 

the DEM. If these values are obtained from a previous Scoops3D analysis, then they 

represent the coordinates of one of the search-lattice nodes. (Numeric). 

rad length of the radius (expressed in length units of the DEM) of the spherical surface containing the 

single trial surface. (Numeric, > 0). 

angle azimuthal slip direction of the single trial surface in degrees counter-clockwise from the positive 

x-axis. If the slip direction is unknown, the user can specify a value of angle > 360º (for example, 

see fig. 4.16) and Scoops3D calculates and uses the overall fall direction (see section 2.2) for the 

slip direction of the trial surface. (Numeric). 

4.4.1.1.9.3. File Search 

If srch = ‘file’ (or ‘FILE’) then the horizontal pattern of the search lattice is defined by a search grid file 

(section 4.4.2.1.3). This option can be useful if the user wants to restrict the search-lattice space to cover an 

irregular space rather than a box. With this option, DO NOT include the parameter-line pair: 

LINE ID: ismin jsmin ismax jsmax nsrchres 

Instead, include the parameter-line pair: 

LINE ID: ismin jsmin nsrchres 

These parameters are explained previously (section 4.4.1.1.9.1). Note that ismin and jsmin indicate the starting 

node of the search lattice defined in the search file, relative to the DEM. The maximum dimensions of the search 

array (ismax and jsmax) are defined by the dimensions of the search file as specified in the header lines of the 

file. The file indicates which horizontal nodes to include in the search lattice. If the user selects a coarse-to-fine 

search (irefine = 1), the search grid file controls the horizontal limits of the initial coarse lattice. Subsequent finer 

searches will not be restricted by the search grid file. 

The file search option requires two additional parameter-line pairs. A third parameter-line pair, irefine, is 

optional. These parameters are described in section 4.4.1.1.9.1. 

LINE ID: zsmin zsmin zsrchres 

LINE ID: irefine multres fostol 

LINE ID: dr deginc degmax numdir 
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4.4.1.1.10. Potential Failure Size Controls 

REQUIRED when srch = ‘box’ (or ‘BOX’) or ‘file’ (or ‘FILE’). NOT REQUIRED when srch = ‘single’ (or 

‘SINGLE’). 

LINE ID: vacriterion armin armax vmin vmax tol limcol 

vacriterion specifies whether volume or horizontal surface area is the primary criterion controlling potential 

failure size. Scoops3D only analyzes potential failures within user-specified size limits. ‘V’ (or 

‘v’) indicates that the primary size criterion is volume; ‘A’ (or ‘a’) indicates that it is horizontal 

surface area. For example, if volume is the primary criterion, the first potential failure mass at 

each search-lattice node must fall within the range of vmin to vmin + tol (parameters described 

below). Then, using area as the secondary criterion, Scoops3D checks that the area is between 

armin and armax (if not, Scoops3D proceeds to the next trial sphere). Each subsequent trial 

sphere increases in radius by dr until either vmax or armax is exceeded, or the trial surface 

intersects the DEM boundary. Although the primary criterion sets the minimum and maximum 

size limits, for a trial surface to be analyzed it must also fall within the secondary criterion size 

limits. If the user does not want the secondary criterion to affect trial surface selection, the 

minimum and maximum secondary limits should be set equal to zero. Note that Scoops3D-i 

only uses one size criterion and automatically sets the secondary criteria size limits to zero. 

The primary size control determines the name of the critical size output file (volume or area, see 

section 4.5.1.3) associated with the critical surfaces found during a Scoops3D analysis. 

(Character, ‘v’, ‘V’, ‘a’, or ‘A’). 

 

armin, armax the minimum and maximum horizontal surface area limits for potential failure masses to 

be analyzed, given in area units consistent with the length units of the DEM. The area of 

the potential failure mass must fall in this range for a trial surface to be considered valid. 

If the user does not want area to restrict potential failure size when area is the secondary 

criterion, set both armin and armax = 0. (Numeric). 

 

vmin, vmax the minimum and maximum volume limits for potential failure masses to be analyzed, 

given in volume units consistent with the length units of the DEM. The volume of the 

potential failure mass must fall in this range for a trial surface to be considered valid. If 

the user does not want volume to restrict potential failure size when used as the 

secondary criterion, set both vmin and vmax = 0. (Numeric). 
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tol the volume or area tolerance level used when computing an initial potential failure size at each 

search-lattice node, given in units consistent with the primary size control criterion. For example, 

if vacriterion = ‘v’ (or ‘V’), the volume of the initial potential failure mass must fall between 

vmin and vmin + tol. If tol is very small, Scoops3D may take more computational time to find an 

initial radius, or may not be able to find an initial radius within the volume or area range because 

of the discrete nature of the problem (for example, the volume does not change continuously with 

change in radius). We have found that a tolerance set to 10 percent of the minimum value for the 

primary size criterion usually works well. (Numeric, > 0). 

 

limcol  the preferred minimum number of active DEM columns to be included in a potential failure 

mass. If the number of active columns in a potential failure mass is less than limcol,  

Scoops3D generates a message in the summary output file and creates an output file, 

<filein>_ncolerr_out.txt, with location and column information about the masses 

(section 4.5.2.2). However, Scoops3D does not halt computation using that trial surface if the 

mass contains less than limcol number of active columns. Our tests show that a potential failure 

mass with at least ~200 active columns commonly provides good estimates of factor of safety 

and volume, but masses with fewer active columns (~100) may still allow calculation of a factor 

of safety within a few percent of results with many active columns. Some situations, such as very 

steep terrain or purely cohesive strength, may require 300 to 500 active columns to provide good 

estimates (see sections 5.3.4 and 6.6) (Integer, > 0). 

4.4.1.1.11. Output Options 

Note that the Scoops3D output files listed below use the main parameter input file name (without 

extension) as a prefix, denoted <filein> in the following text. 

4.4.1.1.11.1. Create New DEM File 

NOT REQUIRED. 

This option creates a new DEM file with selected potential failure masses removed. 

LINE ID: remove foscut 

remove  character flag to control the creation of a new DEM (<filein>_newDEM_out.asc) with select 

potential failure masses removed. If remove = ‘A’ (or ‘a’), all potential failure masses with a 

computed factor of safety (F) less than the foscut value are removed and an additional output file 

listing these surfaces, <filein>_spheresltcut_out.txt, is created. If remove = ‘L’ (or ‘l’), the 

largest potential failure mass with F < foscut is removed. If remove = ‘M’ (or ‘m’), only the 
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potential failure mass with the overall lowest factor of safety (global minimum) is removed, 

provided F < foscut. If remove = ‘N’ (or ‘n’) or is not specified or no potential failure masses 

have F < foscut, then no new DEM is created. (Character, ‘A’, ‘ a’, ‘L’, ‘ l’, ‘M’, ‘m’, ‘N’, or 

‘n’). 

 

foscut  factor of safety cut-off value for creating a new DEM with potential failure masses removed. 

(Numeric, > 0). 

4.4.1.1.11.2. Create Search Quality Files 

NOT REQUIRED. 

This option creates three or four (four if srch = ‘box’) additional output files for examining the quality of 

the stability solutions and the DEM search. These files are grids in ASCII raster format and their contents are 

described in section 4.5.3.2. 

LINE ID: isqout 

isqout flag to create three or four search quality files. If isqout = 1, Scoops3D generates additional 

output files <filein>_critcheck_out.asc, <filein>_numcols_out.asc, 

<filein>_searchgrid_out.asc, and <filein>_boundcheck_out.asc. (Integer, 0 or 1). 

4.4.1.1.11.3. Create Relative Factor-of-Safety File 

NOT REQUIRED. 

This option creates an additional output file containing a grid of the relative, or normalized, factor of 

safety (Frel) for each DEM cell, defined as Frel = F/Fmin, where Fmin is the lowest overall (global minimum) F 

found in the search. 

LINE ID: irelfos 

irelfos flag to create an output file containing the relative factor of safety for each DEM cell. If irelfos = 

1, Scoops3D generates the file <filein>_fos3drel_out.asc. (Integer, 0 or 1). 

4.4.1.1.11.4. Create 3D Search-Lattice File Highlighting Critical Nodes 

NOT REQUIRED. 

This option creates a 3D output file containing the minimum factor-of-safety (F) value found for  

each critical node in the 3D search lattice above the DEM. Critical nodes are the centers for the critical  

surfaces affecting the DEM. Search-lattice nodes with no associated critical surface are assigned a null value 

(section 4.5.3.4.1). Note that Scoops3D always creates a file containing a raster grid of the minimum factor-of-

safety (critical) values for each DEM cell (<filein>_fos3d_out.asc). 
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LINE ID: icritlattice 

icritlattice flag to create a 3D output file highlighting the critical nodes in the search lattice. If icritlattice = 

1, Scoops3D generates the output file <filein>_critfoslattice_out.3D. The file contains the x, y, z 

coordinates and minimum factor of safety for each critical node in the search lattice. The 

coordinates are specified in the coordinate system of the DEM. This file may become large 

depending on the nodal spacing and extent of the search lattice. (Integer, 0 or 1). 

4.4.1.1.11.5. Create 3D Search-Lattice File of Minimum F Value For Each Search Node 

NOT REQUIRED. 

This option creates a 3D file containing the minimum factor-of-safety (F) value found at each node 

searched in the 3D search lattice above the DEM. Note that the minimum found at each search lattice node may 

not necessarily correspond to a critical surface affecting the DEM, thus the contents of this file may differ from 

the critfoslattice file (section 4.4.1.1.11.4). 

LINE ID: ilattice 

ilattice flag to create an output file containing the minimum factor of safety computed at each search-

lattice node. If ilattice = 1, Scoops3D generates the output file <filein>_foslattice_out.3D. The 

file contains the x, y, z coordinates and minimum factor of safety for each node in the search 

lattice. The coordinates are specified in the coordinate system of the DEM. This file may become 

large depending on the nodal spacing and extent of the search lattice. (Integer, 0 or 1). 

4.4.1.1.11.6. Create Subsurface Minimum F File 

NOT REQUIRED. 

This option creates a 3D file containing the computed minimum factor-of-safety (F) values at defined 

points in the subsurface beneath the DEM. 

LINE ID: isubsurf zfrac 

isubsurf flag to create a 3D output file containing minimum factor-of-safety values in the subsurface. If 

isubsurf = 1 or 2, Scoops3D generates the output file <filein>_subsurf_out.txt with the location 

coordinates specified in either ijk (isubsurf = 1) or xyz (isubsurf = 2) format. If isubsurf = 3, the 

file <filein>_subsurf_out.3D with xyz coordinates and a simplified header in Point3D format is 

generated (see fig. 4.38 for example of Point3D format). The x and y coordinates are specified in 

the coordinate system of the DEM. The horizontal spacing of data within the file is equal to the 

DEM cell size; the vertical (depth) spacing is controlled by zfrac, as described below. (Integer, 0, 

1, 2, or 3). 
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zfrac fraction of the DEM cell size used to determine vertical spacing of the subsurface 3D factor-of-

safety output file. Take care using this parameter, because the output file can become extremely 

large! Typical values are 0.5 or 1. A value of zfrac > 1 is recommended when the DEM 

resolution is known to be finer than necessary (section 5.1). (Numeric, > 0). 

4.4.1.1.12. List of Additional Input Files 

REQUIRED. 

The last lines of the main parameter input file list the additional input files needed. A DEM file is always 

required, other files may be required depending on the parameters selected. The files names are entered as line 

pairs, with an identification line first and the file name second. File names may be specified with either relative or 

full pathnames, with delimiters (for example “/” or “\”) appropriate for the computer operating system. See 

figures 4.15 and 4.16 and chapter 7 for some examples. The file formats and contents of the additional input files 

are described in section 4.4.2. 

LINE ID: DEM file 

<pathname/filename> 

 

LINE ID: search file 

<pathname/filename> 

 

LINE ID: pressure head file 

<pathname/filename> 

 

LINE ID: layer file 

<pathname/filenameprefix> 

 

LINE ID: material properties file 

<pathname/filename> 

 

LINE ID: piezometric file 

<pathname/filename> 

 

Note that the specification of multiple property layers requires layer files with a common prefix. There 

must be a file for each layer (except the lowermost layer) with a numbered extension after the given root name, 

representing the layer number. The number of layer files should equal nmat-1. For example, if layer file = 
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<pathname>/layer and nmat = 4, the specified pathname directory should contain the files: layer_1.asc, 

layer_2.asc, and layer_3.asc (section 4.4.2.1.4). A homogeneous problem (where nmat = 1) does not require 

layer files. 

4.4.1.1.13. Output Directory Pathname 

NOT REQUIRED. 

This line pair identifies the pathname of the directory where all Scoops3D output files are placed during a 

run. If this option is specified without using Scoops3D-i, the user must ensure that this output directory already 

exists. If this line is omitted, all output files are placed in the directory containing the main parameter input file. 

Note that Scoops3D-i always creates a subdirectory under the directory containing the main parameter input file 

with the name <filein>_output. 

LINE ID: output directory 

<pathname/outputdirectoryname> 

4.4.2. Additional Input Files 

In addition to the main parameter input file, a Scoops3D analysis always requires a separate file 

containing the DEM. Depending on the options selected, other files may be needed as well. The additional input 

files are in either an Esri ASCII raster format (grid data) or 3D format for Scoops3D (table 4.1). 

4.4.2.1. Grid Data 

All grid files (DEM, search grid, layer, and piezometric surface files) contain a 2D array of values 

preceded by six required header lines (fig. 4.20). Grid files use the Esri ASCII raster format. The header lines 

contain the number of cells in the x direction (ncols, integer value), the number of cells in the y direction (nrows, 

integer value), the x coordinate of the lower left corner (xllcorner, numeric value), the y coordinate of the lower 

left corner (yllcorner, numeric value), the grid spacing (cellsize, numeric value), and the value for null cells 

(NODATA_value, numeric value). At least 12 characters or spaces must precede data values in each of the 

six header lines. 

The 2D array of data following the header lines may be in free format, but there must be nrows number of 

lines, each containing ncols number of values. The values are written in the file exactly as they would appear in 

map (plan) view. Each value in the data array represents a uniform cell. The coordinate system of the grid files 

must be projected into a rectilinear coordinate system (NOT latitude, longitude). Grid files of elevation 

(DEM, layers, and piezometric surfaces) must have the same horizontal and vertical length units. For 

example, DEMs commonly use the UTM (Universal Transverse Mercator) coordinate system with vertical length 

units of meters. 
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An excerpt from a DEM file in Esri ASCII raster format shows the six required header lines (fig. 4.20). 

Here, the DEM has 96 columns (ncols), 91 rows (nrows), and 100 m resolution (cellsize). The values for 

xllcorner, yllcorner are the x and y coordinates of the origin at the lower left corner of the DEM in the UTM 

(Universal Transverse Mercator) coordinate system. The values following the header lines represent the ground-

surface elevation (in meters) for 100 by 100 m grid cells. The elevations are written in the file exactly as they 

would appear in map view, in other words, the upper left elevation in the file (950.2679 m) corresponds with the 

elevation of the upper left (northwest) cell displayed on a map. 

 

ncols     96 

nrows     91 

xllcorner   557974.631687 

yllcorner   5111446.1291019 

cellsize   100 

NODATA_value -9999 

950.2679 954.3484 1008.63 1005.364 1009.342 1010.104 1015.683 .... 

958.0488 961.4271 1014.83 1020.795 1018.986 1016.861 1016.05 .... 

972.327 971.7813 996.9572 1041.421 1029.844 1033.345 1031.922 .... 

977.8392 979.4543 988.1952 1047.295 1046.076 1042.628 1047.686 .... 

986.4683 992.5452 998.5279 1001.354 1062.244 1053.514 1059.542 ....  

... 

 

Figure 4.20. Text excerpt from a DEM file in Esri ASCII raster format. Example taken from the Mount St. Helens 100 m DEM 
(file name: sthel_res100mDEM.asc – see section 7.6). 

The DEM coordinates of the lower left corner (xllcorner, yllcorner) are used in Scoops3D as a check that 

any additional input grid files have a consistent origin, or in the case of the search grid, that the search extent 

aligns with the DEM as intended. The coordinates for the lower left corner also define the coordinate system used 

to specify the coordinates of the trial surface center for a single surface search (section 4.4.1.1.9.2). 

The dimensions (ncols and nrows), cell size, and lower left corner must be the same for all grid files 

associated with a Scoops3D run (with the exception of the search grid, see section 4.4.2.1.3). The NODATA 

value can vary between different input grids. If the lower left coordinates are unknown, Scoops3D allows the 

substitution of other values, such as xllcorner = 0, yllcorner = 0, provided all grids for a particular analysis have 

the same origin. 
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4.4.2.1.1. Tips for Esri ArcGIS users 

If users have access to Esri ArcGIS software, the grid input files for Scoops3D can be created in 

ArcToolbox with Conversion tools >From Raster > Raster to ASCII or in python scripting with 

“arcpy.RasterToASCII_conversion (<in_raster>, <out_asciifile>)”. These specific commands function in 

ArcGIS 10.2 and are also available in older versions of ArcGIS. 

4.4.2.1.2. Digital Elevation Model (DEM) Input File 

REQUIRED. 

This input file contains elevation values for each cell of the digital elevation model (DEM) in ASCII 

raster format (see for example, fig. 4.20). 

4.4.2.1.3. Search File 

REQUIRED ONLY if srch = ‘file’. 

This input file contains an integer array describing the horizontal (x, y) pattern of the search lattice. The 

search file option allows the user to specify an irregularly shaped, non-rectangular search lattice. The utility of a 

search file is illustrated in Seattle examples P and Q (section 7.5). 

This file must be in ASCII raster format, containing the standard six-line header (see for example,  

fig. 4.20), and the cell size must be the same as the DEM. The values of ncols and nrows are used by Scoops3D to 

determine the maximum horizontal extent of the search array relative to ismin and jsmin (section 4.4.1.1.9.3). 

Note that this file does not affect the vertical (z) extent of the search lattice, which is determined by the control 

parameters zsmin, zsmax, and zsrchres in the main parameter input file (section 4.4.1.1.9.1). 

Following the header lines, each line in this file must contain an entire row of values identifying which 

search-lattice locations are active. A positive integer indicates that the xy location of the corresponding cell center 

in the search lattice will be used in the search. A negative integer or zero eliminates the cell center location from 

use in the search lattice. The search file option is commonly used with the coarse-to-fine search refinement option 

turned off (irefine = 0). However, if the user selects the coarse-to-fine search option (irefine = 1), the values 

(positive versus negative) in the search file are used only for the initial coarse search. Subsequent finer searches 

are restricted only by the horizontal area bounded by the extent of the search file, not by the positive or negative 

values contained in the search file. 
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If needed, the search grid and DEM can have different values for ncols, nrows, xllcorner or yllcorner, 

allowing the search grid to be larger or smaller than the DEM extent. Calculate the xllcorner and yllcorner of the 

search grid relative to the DEM, using ismin and jsmin (shown in fig. 4.17) and the following equations: 

 xllcornersearchgrid = xllcornerDEM + (ismin-1)*cellsize, and (4.1) 

 yllcornersearchgrid = yllcornerDEM + (jsmin-1)*cellsize, (4.2) 

where cellsize is the length of one side of a DEM cell. 

If the DEM and search grid corner coordinates do not agree, Scoops3D issues a warning in the main 

output file, but will continue to execute. 

4.4.2.1.4. Material Layer Files 

REQUIRED ONLY if nmat > 1. 

The material layer files define the bottom elevation of every DEM cell for each layer. These files must be 

in ASCII raster format, containing the standard six-line header (see for example, fig. 4.20). The header 

parameters ncols, nrows, xllcorner, yllcorner, and cellsize must be the same as the DEM. Elevations in the files 

must be in length units of the DEM.  The total number of layers is defined by the parameter nmat in the main 

input file (see section 4.4.1.1.4.1). There must be one layer file for each material, except for the final, lowest 

material. Therefore, if there are 5 materials, there must be 4 layer input files. The 5th material is assumed to 

extend from the bottom of the lowermost (4th in this example) layer in the column to the depths of the earth. If 

only one layer is used in the main parameter input file (nmat = 1), then no additional layer files are needed. 

The layer files must have a root name in common, with a numbered extension representing the layer 

number, for example layer_1.asc, layer_2.asc, etc., where “layer” is the user-defined root name. The numbers of 

the layers must be in order of occurrence as if drilling vertically downward from the ground surface. If two layers 

are adjacent without any overlap, then the ordering of the two does not matter. If the layer boundaries occur in 

different order at different locations (for example, in the case of interfingering), more layer files must be created 

to define the sequence of bottom boundaries. A lower numbered layer file (meaning that it is closer to the ground 

surface) must never contain an elevation value that is less than the elevation value at the corresponding cell in a 

higher numbered (deeper) layer file. 

Elevations in the layer files should be in length units of the DEM. If a layer is discontinuous and does 

not occur at all DEM cells, each cell in the layer file with non-occurrence must be represented by the 

NODATA value. The user can define discontinuous layers by setting the elevation of a layer equal to the 

elevation of the layer above. In this situation, Scoops3D will issue a warning and proceed with computations 

assuming that the lower layer has a thickness of zero at those locations (see examples in sections 7.2 and 7.3). 
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4.4.2.1.5. Piezometric Surface File 

REQUIRED ONLY if water = ‘pz’ or ‘PZ’. 

This input file contains elevation data (in length units of the DEM) for a piezometric surface, in ASCII 

raster format (see for example, fig. 4.20). The header parameters ncols, nrows, xllcorner, yllcorner, and cellsize 

must be the same as the DEM grid. 

Following the header, each line in this file must contain an entire row of values designating the elevation 

of the piezometric surface at each DEM cell. If a piezometric surface does not exist at every DEM node, each 

node with non-occurrence must be represented by the NODATA value. For the stability calculations 

performed by Scoops3D, pore pressure at a point within a vertical column is computed as γwzpz, where zpz is the 

vertical depth below the elevation of the piezometric surface. 

4.4.2.2. 3D Data 

Options that utilize 3D data (3D distribution of pore-pressure head and (or) 3D material properties) 

require additional input files. These 3D input files contain header information, followed by a list of 3D location 

coordinates and the corresponding data. Typically, a user will need to manipulate 3D data derived from other 

models or sources into formats usable by Scoops3D by regridding, adding header lines, and making other changes 

as needed. 

The 3D file formats for Scoops3D differ fundamentally from the format used for grid data 

(section 4.4.2.1). Instead of a 2D map-view array of values for each cell, the 3D files contain data for  

points beneath each DEM cell. Specifications for 3D data are: 

• Horizontal coordinates should be located at the center of each DEM cell. 

• 3D files must contain space-delimited or tab-delimited data for every active DEM cell (that is, all 

cells that do not contain the NODATA value). 

• 3D files must contain data to the greatest depth that any trial surface may intersect. If any trial surface 

falls below the lowest defined 3D data point in a vertical column, Scoops3D issues an error and 

stops. 

• Locations of the 3D data values may be specified using one of three different coordinate methods: 

ijk, xyz, and ijz. The coordinate specification method is defined in the header of the 3D file  

(section 4.4.2.2.1). 

• Data must be listed sequentially in either ascending or descending vertical order for each active DEM 

cell. Data do not need to be listed sequentially in the horizontal directions. 
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• 3D data for material properties may be either linearly interpolated between data points or interpreted 

as discrete fixed blocks (sections 4.4.2.2.2 and 4.4.2.2.6). The method of interpretation is controlled 

by the parameter linterp in the main parameter input file (section 4.4.1.1.4.2). 3D pressure-head data 

are always linearly interpolated between data points. 

• Optional descriptive comments must be located at the beginning of the file and designated by the 

character ‘#’ at the beginning of the comment. 

4.4.2.2.1. 3D Data Coordinates 

Coordinates in the three orthogonal directions define the location of each 3D data value. The user can 

select one of three methods to specify the 3D coordinates (table 4.2). The xyz coordinate system is defined by the 

coordinate system of the DEM and the ijk coordinate system is defined as integer counters, where the point 

aligned with the center of the lower left cell of the DEM at the lowest elevation has values i = 1, j = 1, k = 1; i 

increases in the positive x direction, j increases in the positive y direction, and k increases in the positive z-

direction upward (fig. 4.21). Scoops3D also allows a combination of the two coordinate systems (designated as 

ijz), where horizontal coordinates are defined as integer counters and vertical coordinates are in the DEM 

coordinate system. The ijz coordinates are useful for data defined as integer counters relative to the DEM cell 

numbers and containing irregular vertical (z) spacing. Examples of 3D files formatted for Scoops3D in ijz format 

are provided in the folder titled examples (Scoops3D examples C, E, I, and Q, sections 7.2, 7.3, and 7.5). 

If the user’s data is in discrete finite volumes or blocks, instead of point format, coordinates of points in 

or on the blocks are needed for the 3D input files formatted for Scoops3D (fig. 4.21B). The horizontal coordinates 

(x,y or i,j) are for the center of the block and the vertical coordinate (z or k) can be located on the top, center, or 

bottom of the block. 

Table 4.2. List of methods for defining data coordinates for 3D files formatted for Scoops3D. 
 
[The method is defined by the parameter coords in the header lines of the 3D file] 
 

Coords Horizontal coordinate system Vertical coordinate system 
xyz DEM coordinate system DEM coordinate system 

ijk Integer counters (relative to the lower left corner cell of the DEM) Integer counter (relative to zmin) 

ijz Integer counters (relative to the lower left corner cell of the DEM) DEM coordinate system 
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Figure 4.21. Diagrams illustrating 3D data portrayed with the xyz and ijk coordinate systems. A, 3D point data with axes 
labeled using the xyz coordinate system. Equivalent points in the ijk system are shown for comparison. Note that at least one 
data point above the DEM is required if the interpolation option is selected. B, 3D block labeled with the ijk coordinate system. 
In this case the locations of 3D points required by Scoops3D are shown at the bottom of each block (zlocation = ‘bottom’). 
For illustrative purposes, these examples show sparse data and a low resolution DEM of constant slope. The DEM has the 
attributes: ncols = 6, nrows = 6, xllcorner = 0, yllcorner = 0, and cellsize = 100. In practice, the DEM and 3D input file used for 
Scoops3D should have a significantly larger number of data points. 

4.4.2.2.2. 3D Data Representation 

Scoops3D uses discrete columns based on the DEM raster cells for its stability analysis. The value of 

each 3D parameter (pore-pressure head or material properties) is horizontally uniform at any specific elevation 

within each column. In the vertical direction, Scoops3D assumes that pore-pressure heads vary continuously 

(linearly interpolated) between data points because pressure is usually a continuous field within earth materials. 

However, material properties (unit weight, angle of internal friction or cohesion) may vary continuously in the 

vertical direction or be fixed within discrete finite volumes (block data) (fig. 4.22). The user can select which 

method best represents their material property data by setting a flag (linterp) in the main parameter input file. 

Section 4.4.2.2.6 provides examples of these different interpretations and describes the additional header lines 

needed for block data. 
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Figure 4.22. Diagrams illustrating the same generic 3D material property data interpreted as either discrete blocks or 
interpolated data. A, Data in discrete blocks (linterp = 0). B, Interpolated data (linterp = 1). Colors indicate different material 
properties. The two examples portray interpretations of 3D point data that are regularly spaced in the vertical (z) direction. For 
illustrative purposes, this example shows only a few 3D blocks. In practice, the DEM and 3D input file used for Scoops3D 
should have significantly larger number of 3D blocks. 

4.4.2.2.3. 3D File Header Lines 

Any number of descriptive comment lines, preceded by the character ‘#’, may be included at the 

beginning of a 3D input file; these descriptor lines are ignored by Scoops3D. Following these optional descriptor 

lines, the 3D files must contain some parameter line pairs before the data lines. These line pairs identify important 

attributes of the data, such as format and spacing. All 3D files must contain the following line pair defining the 

data coordinate method: 

LINE ID: coords 

 

coords the method used to specify the spatial coordinates of the data (table 4.2, fig. 4.21). There are 

three options: 

1. A designation of ‘xyz’ indicates that each data line contains x, y, z location coordinates in the coordinate 

system of the DEM and in length units of the DEM. 

2. A designation of ‘ijk’ indicates that each data line is identified by integer counters, where i=1, j=1, and 

k=1 indicates the lowermost data point, located in the center of the lower left (southwest corner) cell of 

the DEM (horizontally) (fig. 4.21); ‘ijk’ data must be regularly spaced in the vertical direction. When 
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material properties are interpreted as block data (linterp = 0), zmin (described below) defines the location 

of the top, center or bottom elevation of the lowermost block (defined by zlocation, see section 4.4.2.2.6). 

Values of i increase in the positive x direction and j increase in the positive y direction until they reach 

their maximums at the values of ncols and nrows, respectively, for the DEM. 

3. A designation of ‘ijz’ indicates that x and y locations are identified by integer counters and z locations are 

elevations in length units of the DEM. Note that the conversion from ij coordinates to xy for the exact 

location of the center of the DEM cell is: 

 x = (i-1)*cellsize + 0.5*cellsize + xllcorner, and (4.3) 

 y = (j-1)*cellsize + 0.5*cellsize + yllcorner, (4.4) 

where cellsize is the length of one side of a DEM cell. 

Although it is desirable, Scoops3D does not require the xy coordinates in a 3D file to be precisely in the 

center of a cell. Scoops3D allows some flexibility to account for floating point errors in precision. 

Therefore, as long as the specified xy coordinates fall within the bounds of a DEM cell, the data specified 

for those coordinates are associated with that cell. (Character, ‘xyz’, ‘ijk’, or ‘ijz’). 

 

If coords = ‘ijk’, then an additional two-parameter line pair is needed after the coords line pair. This 

line pair defines the vertical spacing and location of the regularly spaced data: 

LINE ID: delz zmin 

delz  vertical (z) spacing between data values, in length units of the DEM. (Numeric, >0). 

zmin  lowest elevation of data in the 3D file, in length units of the DEM. (Numeric). 

4.4.2.2.4. 3D Pressure-Head File or 3D Variably Saturated Pressure-Head File 

REQUIRED ONLY if water = ‘3d’, ‘3D’, ‘vg’, ‘VG’, ‘fx’ or ‘FX’. 

3D pore-pressure heads (h) contained in this file are converted to pore pressures by Scoops3D to 

calculate a factor of safety. If any trial surface falls below the lowest defined 3D pressure-head point in a vertical 

column, Scoops3D issues an error and stops. Note that when computing pore pressure that acts on the base of a 

column, Scoops3D always interpolates between data values located at elevations vertically above and below the 

trial surface. 

For 3D pressure-head data that are regularly spaced in the vertical direction, data can be presented in one 

of three forms: x,y,z,h , i,j,k,h, or i,j,z,h, where h represents the pressure head at the specified 3D coordinate 

(section 4.4.2.2.1). Examples of 3D pressure-head files are shown in figure 4.23. Data that are irregularly spaced 

in the z direction can only be presented in x,y,z,h or i,j,z,h formats. 
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A. Excerpt from a 3D pressure head file, coords = ‘xyz’: 
 
# comment lines are preceded by a # 
# 3D pressure head with xyz coordinates 
# regular vertical spacing 
# x y z h   
coords 
xyz 
50 50 -100 50 
50 50 -70  45 
50 50 -40  10 
50 50 -10 0 
50 50 20 0 
150 50 -100 50 
... 
 
B. Excerpt from a 3D pressure head file, coords = ‘ijk’: 
 
# comment lines are preceded by a # 
# 3D pressure head with ijk coordinates 
# regular vertical spacing 
# i j k h    
coords 
ijk 
delz  zmin 
 30 -100           
1 1 1 50 
1 1 2 45 
1 1 3 10 
1 1 4 0 
1 1 5 0 
2 1 1 50 
... 
 
C. Excerpt from a 3D pressure head file, coords = ‘ijz’: 
 
# comment lines are preceded by a # 
# 3D pressure head with ijz coordinates 
# regular vertical spacing 
# i j z h    
coords 
ijz   
1 1 -100 50 
1 1 -70  45 
1 1 -40  10 
1 1 -10 0 
1 1 20 0 
2 1 -100 50 
... 

 
Figure 4.23. Text excerpts from three files illustrating the three methods for specifying 3D pressure-head data that are 
regularly spaced in the vertical (z) direction. These examples use equivalent data and the DEM has xllcorner = yllcorner = 0 
and cellsize = 100 m. The lowest vertical elevation (zmin) for the pressure-head data is 100 m and the spacing between data 
points in the vertical (delz) is 30 m. A, ‘xyz’ format. xy coordinates are located in the center of the DEM cell. B, ‘ijk’ format. 
Note that i = 1,j = 1,k = 1 corresponds to lowest vertical elevation in the center of the DEM cell in the lower left corner of a 
map view. C, ‘ijz’ format. 
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4.4.2.2.5. 3D Variably Saturated Pressure-Head and Water Content File 

REQUIRED ONLY if water = ‘vs’ or ‘VS’. 

This 3D file contains values for both variably saturated pressure head (positive or negative relative to 

atmospheric pressure) and water content. Section 2.4 describes how Scoops3D uses these values to calculate the 

factor of safety. If any trial surface falls below the lowest defined 3D point in a grid cell, Scoops3D issues an 

error and stops. 

For 3D variably saturated pressure-head data that are regularly spaced in the vertical direction, data can 

be presented in one of three forms: x,y,z,h,theta, i,j,k,h,theta, or i,j,z,h,theta, where h represents the pressure head 

(h) (negative where it represents matric suction) and theta represents the water content at the specified 3D 

coordinate (fig. 4.24). Coordinate systems (xyz, ijk, ijz) are described in section 4.4.2.2.1. Data that are 

irregularly spaced in the z direction can only be presented in x,y,z,h,theta or i,j,z,h,theta formats. 

The USGS model TRIGRS (Baum and others, 2008) can generate a 3D file of variably saturated pressure-head 

and water content data for use by Scoops3D. 

4.4.2.2.6. 3D Material Properties File 

REQUIRED ONLY if str3d = 1. 

This 3D file can contain any or all of the material properties parameters: cohesion (c), angle of internal 

friction (ϕ), total unit weight (γt), partially saturated unit weight (γps), and saturated unit weight (γs); the units 

weights required depend on the groundwater option chosen (see section 4.4.1.1.4.1 for possible combinations). 

Material property data must be in units consistent with the DEM. Each parameter must be completely defined in 

either this 3D file (with values for each location) or as uniform values in the main parameter input (.scp) file. Any 

parameters included in the 3D file must be assigned a value of -1 in the lnum line in the main parameter input file 

(see section 4.4.1.4.2). Values not included in the 3D file are assumed to be uniform and are assigned the value 

specified in the lnum line. If any trial surface falls below the lowest defined 3D point in a vertical column, 

Scoops3D issues an error and stops. 

Data in 3D files formatted for Scoops3D are described as points in a 3D domain (figs. 4.25A, 4.26, and 

4.27). For material properties, Scoops3D can interpret these 3D points in one of two ways, designated by the user: 

(1) the points represent a continuously varying field (linterp = 1) where Scoops3D uses linear vertical 

interpolation between data points (fig. 4.25B) or (2) the points represent locations defining the extent of discrete 

fixed blocks (linterp = 0) where Scoops3D assumes uniform properties within the block (fig. 4.25C and D).  

The user controls the method of interpretation by setting linterp in the main parameter input file (see  

section 4.4.1.1.4.2). 
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Excerpt from 3D variably saturated pressure head file, coords = ‘ijz’: 

 
# Comments: Quasi-3D pressure head data from TRIGRS, v. 2.0.10e 
# TRIGRS, clipped area of North Charlotte Creek, Oregon   
# i j z h th 
# timestep=       1 
# time=     0.0000000  
coords 
ijz    
   1  704   251.96   -2.365   0.8676E-01 
   1  704   251.85   -2.277   0.8761E-01 
   1  704   251.73   -2.188   0.8862E-01 
   1  704   251.62   -2.099   0.8981E-01 
   1  704   251.50   -2.010   0.9122E-01 
   1  704   251.39   -1.921   0.9288E-01 
   1  704   251.28   -1.831   0.9485E-01 
   1  704   251.16   -1.742   0.9717E-01 
   1  704   248.95   0.0000   0.4700  
   1  704   201.96    29.14   0.4700  
   2  704   251.18   -2.324   0.8703E-01 
   2  704   251.08   -2.242   0.8786E-01 
   2  704   250.98   -2.161   0.8882E-01 
   2  704   250.87   -2.079   0.8995E-01 
   2  704   250.77   -1.997   0.9126E-01 
   2  704   250.66   -1.915   0.9280E-01 
   2  704   250.56   -1.833   0.9459E-01 
   2  704   250.45   -1.751   0.9668E-01 
   2  704   248.23   0.0000   0.4700  
   2  704   201.18    29.32   0.4700  
   3  704   250.41   -2.217   0.8965E-01 
   3  704   250.31   -2.145   0.9069E-01 
   3  704   250.22   -2.072   0.9188E-01 
   3  704   250.12   -2.000   0.9324E-01 
   3  704   250.03   -1.927   0.9478E-01 
   3  704   249.93   -1.854   0.9654E-01 
   3  704   249.84   -1.782   0.9854E-01 
   3  704   249.74   -1.709   0.1008  
   3  704   247.52   0.0000   0.4700  
   3  704   200.41    27.81   0.4700  
... 

 
Figure 4.24. Text excerpt from a 3D variably saturated pressure-head file containing data that  
are irregularly spaced in the vertical (z) direction. Coordinates are specified as ‘ijz’. Values of  
pressure head and water content are listed for each point. 
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Figure 4.25. Sequence of diagrams showing perspective views with different interpretations of 3D cohesion data. A, locations 
of 3D points and cohesion values contained in a 3D material property file for Scoops3D (fig. 4.26A), B, linearly interpolated 
data (linterp = 1), C, block data (linterp = 0) with zlocation = ‘bottom’, D, block data (linterp = 0) with zlocation = ‘top’. 
3D perspective images created using VisIt software. 
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If data are best represented as fixed within blocks (linterp = 0), then the z-coordinate of the data 

represents the location of a data point at the top, center, or bottom of the block. Scoops3D will attribute material 

properties to a trial surface depending on which block contains that surface. Figures 4.26 and 4.27 show examples 

of 3D material properties files with irregularly and regularly spaced data. If linterp = 0, the 3D material properties 

file requires an additional header line pair containing one parameter: 

LINE ID: zlocation 

zlocation the vertical location of the specified parameter values within a 3D block. The location can be 

‘top’, ‘center’, or ‘bottom’ (table 4.3). All values in the horizontal (x and y) directions should be 

located in the center of the DEM cell. The selection of the option zlocation = ‘center’ is only 

allowed when the data have regular vertical spacing. The zlocation line pair is not required if 

coords = ‘ijk’ (zmin should define the elevation of the bottom of the lowest cell), and it is 

ignored for linearly interpolated data (linterp = 1). (Character, ‘top’, ‘center,’ ‘bottom’). 

 

Table 4.3. List of valid values for zlocation when 3D material property data are represented as block data.  
 
[In these cases linterp = 0] 
 

Coords 
Valid values for zlocation 

Vertical spacing 
regular irregular 

xyz 'top', 'center' or 'bottom' 'top' or 'bottom' 

ijz 'top', 'center' or 'bottom' 'top' or 'bottom' 

ijk Not required Not required 
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A.  Excerpt from 3D material property file containing cohesion data, coords = ‘ijz’, irregular vertical spacing: 

 
# 3D material property file 
# i j z cohesion 
coords 
ijz 
  1 1 200.000 90 
  1 1 270.000 40 
  1 1 280.000 10 
  1 1 320.000 0 
  2 1 200.000 90 
  2 1 272.000 40 
  2 1 288.000 10 
  2 1 328.000 0 
  3 1 200.000 90 
  3 1 274.000 40 
  3 1 296.000 10 
  3 1 336.000 0 
  4 1 200.000 90 
  4 1 276.000 40 
... 
 
B. Associated line pairs required in the main parameter input file: 
 
str3d linterp 
1 1 
nmat          
1  
lnum  cee  phi  gamt      
1 -1  30.  24. 

 
Figure 4.26. Text excerpts from two files showing 3D data formats and additional parameters needed for 3D data shown in 
figure 4.25. A, Excerpt from the 3D material properties file displayed in figure 4.25. This file contains cohesion data and is 
irregularly spaced in the vertical (z) direction. B, Additional line pairs required in the main parameter input file for the linear 
interpolation (linterp = 1) of cohesion displayed in figure 4.25B. Here cee = -1 indicates that the cohesion data are listed in 
the specified 3D data file (excerpted in A), and the other material parameters are constant. With this option, Scoops3D linearly 
interpolates to determine cohesion on the trial surface for each column. 
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Excerpt from 3D material properties file, coords = ‘ijk’, regular vertical spacing: 
 
# 3D material properties file 
# Donald and Giam (ACADS) example 1c 
# regular vertical spacing, ijk coordinates 
# 
# i j k cee  phi  gamt 
# 
coords 
ijk 
delz zmin 
1 12 
  1 1 1 7.20000 20.0000 19.5000 
  1 1 2 7.20000 20.0000 19.5000 
  1 1 3 7.20000 20.0000 19.5000 
  1 1 4 7.20000 20.0000 19.5000 
  1 1 5 7.20000 20.0000 19.5000 
  1 1 6 7.20000 20.0000 19.5000 
  1 1 7 7.20000 20.0000 19.5000 
  1 1 8 7.20000 20.0000 19.5000 
  1 1 9 7.20000 20.0000 19.5000 
  1 1 10 7.20000 20.0000 19.5000 
  1 1 11 7.20000 20.0000 19.5000 
  1 1 12 7.20000 20.0000 19.5000 
  1 1 13 7.20000 20.0000 19.5000 
  1 1 14 7.20000 20.0000 19.5000 
  2 1 1 7.20000 20.0000 19.5000 
  2 1 2 7.20000 20.0000 19.5000 
... 

 
Figure 4.27. Text excerpt from a 3D material properties file with data regularly spaced in  
the vertical (z) direction. The file contains all of the material properties required: cohesion (cee),  
angle of internal friction (phi), and total unit weight (gamt). Scoops3D example I (section 7.3) 
uses irregularly spaced material property data equivalent to this file. 

4.5. Program Output 

During execution, Scoops3D generates a suite of output files including: 

• Six standard output files that are always produced. 

• Six conditional output files that are created depending on user-selected options or the existence 

of errors and filters related to the factor-of-safety calculations. 

• Nine optional output files (table 4.4). 

The user can control the creation of any or all of the nine optional output files using flags in the main 

input file (see section 4.4.1.1.11). Each output file is created in a form appropriate for the data type, either as a 

text, ASCII raster grid format, or 3D file. 
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Table 4.4. Description of Scoops3D output files including file names, conditions for creation, and null values. 
 
[Null values are equivalent to NODATA values for grid files. Output files contain three possible types of data: (1) text – a text summary or listing of information, 
(2) grid – raster grid data in Esri ASCII format, or (3) 3D – listing of 3D coordinates and associated factor-of-safety (F) values] 

 
Section File suffix1 Criteria for 

creation of file Data type Null value Description 

Standard output files (always produced) 

4.5.1.1 _out.txt Always Text --- Summary output file - echoes input parameters and 
describes overall minimum F 

4.5.1.2 _fos3d_out.asc Always Grid  9999 Minimum 3D F for each DEM cell with the user-
specified slope-stability method 

4.5.1.3 _fosvol_out.asc 
or 
 _fosarea_out.asc 

vacriterion = 'V' or 'v' 
or 
vacriterion = 'A' or 'a' 

Grid -9999 Volume (or area) of the critical surface for each 
DEM cell. One file is generated depending on the 
value of vacriterion 

4.5.1.4 _spheres_out.okc Always Text --- Parameters associated with minimum F for each 
DEM cell 

4.5.1.5 _slope_out.asc Always Grid -9999 Slope of ground surface at each DEM cell 

4.5.1.6 _errors_out.txt Always Text  Errors related to input files 

Conditional output files (warning, filtering, and debugging - sometimes produced) 

4.5.2.1 _ordfos3d_out.asc method = 'B' or 'b' Grid  9999 3D Ordinary (Fellenius) F for critical surface 
identified by Bishop’s method for each DEM cell 

4.5.2.2 _ncolerr_out.txt Failure masses with 
fewer columns than 
limcol 

Text --- Parameters associated with trial surfaces analyzed 
with columns less than user-specified value 

4.5.2.3 _filter_out.txt Non-converging or 
filtered surfaces 

Text --- Parameters associated with trial surfaces that were 
filtered out or had non-convergent solutions 

4.5.2.4 _filtergrid_out.asc Non-converging or 
filtered surfaces 

Grid -9999 Number of times each DEM cell had trial surfaces 
that were filtered out or had non-convergent 
solutions 

4.5.2.5 _foslocal_out.txt method = 'O' or 'o', 
and srch = 'single' 

Text --- Local driving and resisting forces, and F, for each 
DEM cell on a user-specified trial surface 

4.5.2.6 _spheresltcut_out.txt  Text --- Parameters associated with trial surfaces with F 
less than a user-specified cutoff value (foscut) 
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Section File suffix1 Criteria for 
creation of file Data type Null value Description 

Optional output files (user-selected) 

4.5.3.1 _newdem_out.asc remove = ‘A’, ‘a’, ‘L’, 
‘l’, ‘M’, or ‘m’ 

Grid -9999 DEM with user-specified potential failure masses 
removed 

4.5.3.2.1 _critcheck_out.asc isqout = 1 Grid -9999 Check on the volumes or areas associated with the 
critical surfaces 

4.5.3.2.2 _numcols_out.asc isqout = 1 Grid -9999 Number of columns associated with the critical 
surface at each DEM cell 

4.5.3.2.3 _searchgrid_out.asc isqout = 1 Grid -9999 Location of horizontal search space relative to the 
DEM 

4.5.3.2.4 _boundcheck_out.asc isqout = 1 and 
srch = 'box' 

Grid -9999 Check on the search-lattice boundaries 

4.5.3.3 _fos3drel_out.asc irelfos = 1 Grid  9999 3D relative F for each DEM cell 

4.5.3.4.1 _critfoslattice_out.3D icritlattice = 1 3D --- Minimum F for critical surface found at each 
search-lattice node 

4.5.3.4.2 _foslattice_out.3D ilattice = 1 3D --- Minimum F found at each search-lattice node 

4.5.3.5 _subsurffos_out.3D or 
_subsurffos_out.txt 

isubsurf = 3 or  
isubsurf = 1 or 2 

3D --- Minimum F at and beneath each DEM cell 

1File names start with input file root name <filein>, followed by the file name suffix listed in this table.  
 



 

 107 

All output file names begin with the main input file root name (for example, if the main input file is 

file1.scp, then the main output file is called file1_out.txt). All output files are created in the output directory 

designated in the main Scoops3D input file. If no output directory is specified, then the output files can be found 

in the same directory as the main parameter input file. In the discussion below, we identify the output files using 

the root name plus a descriptive file suffix (table 4.4), with <filein> serving as a proxy for the root name of the 

main parameter input file. 

Although some output files can be viewed in a text editor, thorough analysis of the output files from 

Scoops3D requires additional software such as a GIS or 3D visualization software. This manual shows examples 

of images produced using Esri ArcMap (http://www.esri.com/software/arcgis), VisIt (open source software 

developed by the U.S. Department of Energy, https://wci.llnl.gov/codes/visit/about.html), and QGIS 

(http://www.qgis.org) software. Other software packages with GIS, 2D, or 3D visualization capabilities can be 

used, although some software will require file format conversion. 

4.5.1. Standard Output Files 

These output files are always produced upon completion of a successful Scoops3D run. 

4.5.1.1. Main Output File 

NAME: <filein>_out.txt 

FORMAT: text 

 

This output file echoes the parameters contained in the main input file with explanatory text, lists the 

names of the output files generated, the number of trial surfaces analyzed, and contains results about the overall 

or global minimum factor of safety found during the Scoops3D run. Note that the slip direction for the global 

minimum is an angle measured from 0º along the positive x-axis, and positive in the counter-clockwise direction. 

An example of the main output file is shown in figure 4.28. 

  

https://wci.llnl.gov/codes/visit/about.html
http://www.qgis.org
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    ************************************************************* 
                               Scoops3D 
          3D Slope Stability Throughout a Digital Landscape 
                        U.S. Geological Survey 
                            Version: 1.0  
    ************************************************************* 
 
 
This file: R_sthel_output\R_sthel_out.txt                                                                                                                                                                                               
 
Start date and time: 07/11/2014  10:24:06 
Description: Scoops3D example R; Mount Saint Helens                                                                                   
 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
I. INPUT FILES: 
  DEM file: input\sthel_res100mDEM.asc                                                                                                                                                                                                   
  Main parameter input file: R_sthel.scp                                                                                                                                                                                              
 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
II. SIMULATION PARAMETERS: 
------------ 
DEM 
Input file for topography: input\sthel_res100mDEM.asc                                                                                                                                                                                                   
  Dimensions of DEM grid (x,y):                                       96    91 
  Number of cells in DEM grid:                                            8736 
  Number of non-null cells in DEM grid:                                   8668 
  Horizontal resolution of DEM grid (m ):                               100.00 
  Minimum elevation of DEM (m ):                                       743.277 
  Maximum elevation of DEM (m ):                                      2928.884 
  xllcorner and yllcorner (m ):                      557974.632    5111446.129 
------------ 
UNIT DESCRIPTORS (used for labels in output files) 
lengthunits   ceeunits    gammaunits 
     m          kPa         kN/m^3   
------------ 
MATERIAL PROPERTIES 
Property method:                                                         layer 
Number of layers (nmat):                                                     1 
                      total unit wt.   
lnum   cee      phi      gamt   
       kPa              kN/m^3   
  1   1000.00  40.000   24.000  
------------ 
GROUNDWATER CONFIGURATION 
Groundwater method (water):                                               None 
------------ 
EARTHQUAKE LOADING 
Horizontal pseudo-acceleration coefficient (dimensionless)(eq):          0.000 
------------ 
LIMIT-EQUILIBRIUM METHOD 
Analysis method (method):                                               Bishop 
------------ 
SEARCH METHOD (srch)                                                       box 
POTENTIAL FAILURE SIZE CONTROLS 
Primary constraint, volume or area (vacriterion):                       Volume 
Surface area is not a criterion for size restriction. 

Volume range of potential failures (m ^3)(vmin, vmax):     1.000E+08 3.500E+09 
Tolerance amount for initial potential failure (tol):                1.000E+07 
Minimum number of active columns in potential failure required, 
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      otherwise error message generated (limcol):                          100 
SLIP DIRECTIONS 
Interval to search slip directions on each side of overall  
 fall direction of potential failure, in degrees (degmax):               0.000 
Increment amount for slip direction, in degrees (deginc):                0.000 
Calculated number of slip directions tested for each lattice node:           1 
SEARCH-LATTICE EXTENT AND RESOLUTION 
VERTICAL EXTENT AND RESOLUTION 
Minimum elevation of search-lattice nodes (m ) (zsmin):               1000.000 
Maximum elevation of search-lattice nodes (m ) (zsmax):               9200.000 
Search-lattice vertical spacing (m ) (zsrchres):                       100.000 
Increment amount for potential failure surface sphere radius(m )(dr):   50.000 
HORIZONTAL EXTENT AND RESOLUTION 
Starting search-lattice horizontal node (ismin,jsmin):                  1    1 
Ending search lattice horizontal node (ismax,jsmax):                   96   91 
Horizontal spacing - multiple of DEM resolution (nsrchres):                  1 
COARSE-TO-FINE SEARCH PARAMETERS 
Horizontal and vertical multiplier for initial coarse search (multres):      8 
Search iteration tolerance - percent change F (fostol):                 0.0100 
------------ 
ADDITIONAL OUTPUT FILES AND PARAMETERS (see user manual for options) 
isqout (search quality files):                                               1 
irelfos (relative F file):                                                   1 
icritlattice (3D search lattice for critical nodes):                         1 
ilattice (3D search lattice):                                                1 
isubsurf (3D subsurface factor of safety):                                   1 
zfrac:                                                                   1.000 
Create new DEM file (remove):                                                M 
   (surface with minimum F<foscut removed) 
F cutoff for removing material from new DEM (foscut):                5.000E+00 
 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
III. OUTPUT FILES GENERATED:  
 
     LOCATION FOR OUTPUT FILES: 
          R_sthel_output\                                                                                                                                                                                          
 
      R_sthel_out.txt 
      R_sthel_errors_out.txt 
      R_sthel_slope_out.asc 
        Range: [    0.5858,   45.8266] 
      R_sthel_fos3d_out.asc 
        Range: [    2.2035,   18.5841] 
      R_sthel_ordfos3d_out.asc 
        Range: [    2.1205,   17.8549] 
      R_sthel_fosvol_out.asc 
        Range: [  1.0111E+08,  3.4992E+09] 
      R_sthel_spheres_out.okc 
 
     Optional files generated: 
      R_sthel_fos3drel_out.asc 
        Range: [    1.0000,    8.4339] 
      R_sthel_newDEM_out.asc 
        Range: [   743.2767,  2928.8840] 

      R_sthel_numcols_out.asc 

        Range: [   76, 1733] 
      R_sthel_critcheck_out.asc 
      R_sthel_boundcheck_out.asc 
      R_sthel_subsurffos_out.txt 
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      R_sthel_critfoslattice_out.3D 
      R_sthel_foslattice_out.3D 
      R_sthel_ncolerr_out.txt 
      R_sthel_searchgrid_out.asc 
 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
IV. RESULTS: 
Number of trial surfaces tried:                                         521313 
F < foscut found and newDEM_out file created?                              yes 
Number of surfaces with active column totals less than limcol:             823 
     Check file ncolerr_out for detailed information. 
------------ 
3D POTENTIAL FAILURE - GLOBAL MINIMUM 
Bishop's 3D factor of safety:                                           2.2035 
Ordinary 3D factor of safety:                                           2.1205 
Volume (m ^3):                                                     4.14604E+08 
Horizontal surface area (m ^2):                                    2.30219E+06 
Slip surface area (m ^2):                                          2.74618E+06 
Weight (kg):                                                       9.95050E+09 
Number of active columns:                                                  246 
        x-center         y-center          z-center     radius 
     563224.6317      5118596.1291         3900.0000   2.21644E+03 
Slip direction, relative to search lattice:                            72.3351 
End date and time: 07/11/2014  10:29:52 

 

Figure 4.28. Text showing example of Scoops3D main output file. File from Mount St. Helens example R (file name: 
R_sthel_out.txt); see section 7.6. 

4.5.1.2. Minimum Factor-of-Safety File 

NAME: <filein>_fos3d_out.asc 

FORMAT: ASCII raster 

 

This output file contains the minimum 3D factor of safety calculated on the critical surface for each DEM 

cell by the user-specified limit-equilibrium method (Bishop’s simplified or Ordinary). This file allows the user to 

view computed stability over the entire DEM area (fig. 4.29A). These results, an amalgamation of critical 

potential failure masses, can also be draped over topography (see fig. 1.2A). The file is written in ASCII raster 

format (see for example fig. 4.20). Some values in this file indicate lack of data or problems with the calculation 

of factor of safety for a specific DEM cell: (1) 9999.00 identifies cells not included in any trial surface 

computations, such as cells at the boundary of the DEM or with a NODATA (null) value in the DEM, (2) 111.00 

indicates that the cells were contained only in trial slip surfaces with non-converging limit-equilibrium solutions 

or solutions were eliminated due to the user-specified filter (absminma, section 4.4.1.1.8), or (3) 100.0 indicates 

that the calculated factor of safety was greater than 100.0. Note that if the user-specified limit-equilibrium method 

is Bishop’s simplified (method = ‘B’ or ‘b’), an additional file (<filein>_ordfos3d_out.asc) is created with the 

results from the Ordinary method for the same critical surfaces (see section 4.5.2.1). 
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4.5.1.3. Critical Size File 

NAME: <filein>_fosvol_out.asc or <filein>_fosarea_out.asc 

FORMAT: ASCII raster 

Scoops3D generates one critical size file that depends on the primary size criteria selected by the user. If 

volume is the primary size criterion (vacriterion = ‘V’ or ‘v’), Scoops3D creates <filein>_fosvol_out.asc. If 

horizontal area is the primary size criterion (vacriterion = ‘A’ or ‘a’), Scoops3D creates 

<filein>_fosarea_out.asc. The critical size file is written in ASCII raster format (see for example fig. 4.20). 

4.5.1.3.1. Critical Volumes File 

The output file <filein>_fosvol_out.asc contains the volume associated with the critical surface for each 

DEM cell. An example of how this file can be used to create a map view is shown in figure 4.29B. 

 

 
Figure 4.29. Examples of maps created from Scoops3D output files of minimum factor of safety and associated potential 
failure volumes. Maps created from Scoops3D Mount St. Helens example R output files (see section 7.6), with the addition of 
explanatory text and 100 m contours lines. A, Map of minimum factor of safety on the critical surfaces for each DEM cell 
calculated using Bishop’s simplified method (derived from R_sthel_fos3d_out.asc). B, Map of potential failure volume 
associated with the critical surfaces shown in A (derived from R_sthel_fosvol_out.asc). Note that black cells on the 
boundaries were assigned the NODATA value of -9999, indicating that either there was no elevation value in the DEM at this 
cell or all trial surfaces that intersected this cell were truncated by the boundary of the DEM and therefore not analyzed. Maps 
created using Esri ArcMap software. 
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4.5.1.3.2. Critical Areas File 

The output file <filein>_fosarea_out.asc contains the horizontal area associated with the critical surface 

for each DEM cell. 

4.5.1.4. Critical-Trial-Surface File 

NAME: <filein>_spheres_out.okc 

FORMAT: text in XmdvTool (.okc) format 

This output file lists additional data associated with the critical surface producing the minimum factor of 

safety for each DEM cell. The data contained in this file enable the user to reconstruct the single critical surface 

for a given DEM cell. The header of this file is in XmdvTool flat format, where the first line contains the number 

of variables and number of data points contained in the file and the number of variables multiplied by the number 

of data points (fig. 4.30). Subsequent header lines contain variable names, followed by lines containing the 

minimum and maximum values for each variable (in order of the variable names). See 

http://davis.wpi.edu/xmdv/fileformats.html for an explanation of the general XmdvTool (.okc) format. The 

variables contained in the file are: 

• xcen, ycen, zcen – coordinates of the rotational center (critical node) of the critical surface in the 

coordinate system of the DEM, 

• i and j – cell counter locations for each DEM cell, 

• radius – radius of the sphere containing the critical surface, 

• angle – azimuthal slip direction (counter-clockwise from the positive x-axis), 

• cols – number of DEM cells (active columns) intersected by the critical surface, 

• vol – volume of the critical potential failure mass, 

• area – horizontal surface area of the critical potential failure mass, 

• F_Bish – factor of safety computed using Bishop’s simplified method (only listed if method = 

‘B’ or ‘b’), and 

• F_Ord – factor of safety computed using the Ordinary method. 

 Note that if Bishop’s simplified method was specified, the Ordinary F values are for the same critical 

surfaces identified with Bishop’s method. If the Ordinary method was specified, the Ordinary F values are for the 

critical surfaces identified by the Ordinary method (which may differ from those found by Bishop’s simplified 

method). If length units have been defined by the user in the main parameter input file, the variable names listed 

in the header include the character ‘_’ followed by length units for the appropriate variables. If the same critical 

surface defines the minimum factor of safety for multiple DEM cells, the file lists the same information for each 

DEM cell affected by that critical surface.  

http://davis.wpi.edu/xmdv/fileformats.html
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  12 8633 103596 
xcen_m 
ycen_m 
zcen_m 
i 
j 
radius_m 
angle 
cols 
vol_m^3 
area_m^2 
F_Bish 
F_Ord 
  558424.631687000 567124.631687000 4 
  5111796.12910190 5120496.12910190 4 
  1100.00 9200.00 4 
  1 96 4 
  1 91 4 
  515.734 8229.85 4 
  3.273308E-02 359.773 4 
  76 1733 4 
  1.011122E+08 3.499162E+09 4 
  676022. 1.683488E+07 4 
  2.20350 18.5841 4 
  2.07652 17.2802 4 
558624.6317 5111896.1291 3300.0000 6 1 2.392E+03 235.10  192 1.039E+08 1.793E+06   
6.3586  6.1692 
558824.6317 5112096.1291 2100.0000 7 1 1.319E+03 234.29  213 2.912E+08 2.003E+06   
5.7446  5.1016 
558924.6317 5112096.1291 2300.0000 8 1 1.484E+03 235.97  223 2.860E+08 2.089E+06   
5.5059  5.0179 
558924.6317 5112096.1291 2300.0000 9 1 1.484E+03 235.97  223 2.860E+08 2.089E+06   
5.5059  5.0179 
558924.6317 5112096.1291 2300.0000 10 1 1.484E+03 235.97  223 2.860E+08 2.089E+06   
5.5059  5.0179 
558924.6317 5112096.1291 2300.0000 11 1 1.484E+03 235.97  223 2.860E+08 2.089E+06   
5.5059  5.0179 
558924.6317 5112096.1291 2300.0000 12 1 1.484E+03 235.97  223 2.860E+08 2.089E+06   
5.5059  5.0179 
558924.6317 5112096.1291 2300.0000 13 1 1.484E+03 ... 

 

Figure 4.30. Text excerpt from an example critical-trial-surface output file. File from Mount St. Helens example R (file name: 
R_sthel_spheres_out.okc); see section 7.6. The header lines are in the XmdvTool format. In this example, lengthunits = ‘m’ 
was specified by the user in the main parameter input file. The first line contains the number of variables, data points, and the 
product of the two. Lines 2 through 13 list the variable names, and lines 14 through 25 list the minimum and maximum values 
for each variable (the value 4 in each line can be ignored). Subsequent lines contain values for each variable at each data 
point. 
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4.5.1.5. Slope File 

NAME: <filein>_slope_out.asc 

FORMAT: ASCII raster 

 

This output file contains the ground-surface slope, in degrees, computed by Scoops3D for each DEM 

cell. The slope file is a grid written in ASCII raster format (see for example fig. 4.20). 

Slope for each cell is computed using the elevations of the surrounding eight cells (Horn, 1981; Burrough 

and McDonnell, 1998). To compute slope (converted from radians to degrees) for a DEM cell of interest (center 

cell ‘e’ in fig. 4.31), Scoops3D uses the formula: 

 2 2arctan ( / ) ( / ) (180 / )slope dz dx dz dy = +  
p , (4.5) 

where the rate of elevation change in the x direction, dz/dx for the center is: 

 dz/dx = ((c + 2f + i) - (a + 2d + g) / (8 * cellsize), (4.6) 

and the rate of elevation change in the y direction, dz/dy is: 

 dz/dy = ((g + 2h + i) - (a + 2b + c)) / (8 * cellsize). (4.7) 

Here, the letters denote elevations in the cells surrounding the center cell of interest (fig. 4.31) and cellsize is the 

length of the DEM cell as specified in the header of the DEM file. 

 

 
Figure 4.31. Schematic diagram showing plan view of cell identification letters used for computing ground-surface slope. Cell 
letters are used in equations 4.6 and 4.7. 
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4.5.1.6. Error File 

NAME: <filein>_errors_out.txt 

FORMAT: text 

 

An error file is always created during a Scoops3D run, but may be empty if there are no errors related to 

input files. This file lists errors associated with the main parameter input file, header problems with the input 

files, non-existent files, or inconsistencies between files. Some input file problems cause Scoops3D to stop 

execution, whereas minor errors do not stop execution but are reported in the error file. If this file lists any errors, 

the user should modify the input files as needed or carefully check the files to assure correct interpretation by 

Scoops3D. 

4.5.2. Conditional Output Files 

During the execution of a Scoops3D run, some additional files may be generated depending on analysis 

criteria or problems encountered during the run. The conditions for creation of each of these additional files are 

listed with each file description and in table 4.4. This is in contrast to optional output files, which are explicitly 

requested by the user (section 4.5.3). For example, Scoops3D creates some of the conditional files when specific 

parameters or combinations of parameters are set (for example, if srch = ‘single’ and method = ‘O’ or ‘o’, then 

the file <filein>_foslocal_out.txt is created). Other files described in this section provide information about trial 

surfaces that did not meet user-specified criteria, such as the minimum number of active columns within a 

potential failure mass, or trial surfaces that were eliminated due to filtering constraints. Note that Scoops3D 

execution does not halt if these conditions occur. These files can be used to ascertain whether the overall 

solutions are acceptable for the user’s purposes. 

4.5.2.1. Minimum Factor-of-Safety File – Ordinary (Fellenius) Method 

CONDITIONS FOR FILE CREATION: Stability analysis method is Bishop; method = ‘B’ or ‘b’ 

NAME: <filein>_ordfos3d_out.asc 

FORMAT: ASCII raster 

 

This output file contains the minimum 3D factor of safety calculated for the critical surface affecting each 

DEM cell using the Ordinary (Fellenius) method, and is created as a supplemental file when the user selects 

Bishop’s simplified method. This additional file allows the user to compare slope stability computed using the 

Ordinary method with results using the Bishop’s simplified method for the same critical trial surfaces, as 

determined using Bishop’s method. Note that these may not be the Ordinary method critical surfaces – the user 

should run Scoops3D with the Ordinary option selected to obtain these values. The file is written in ASCII raster 
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format (see for example fig. 4.20). Some values in this file indicate lack of data or problems with the calculation 

of factor of safety for a specific DEM cell: (1) 9999.00 identifies cells at the boundary of the DEM or with a 

NODATA value in the DEM and (2) 100.0 indicates that the calculated factor of safety was greater than or equal 

to 100.0. 

4.5.2.2. Column Warning File 

CONDITIONS FOR FILE CREATION: existence of potential failure masses containing fewer active columns 

than the value of limcol 

NAME: <filein>_ncolerr_out.txt 

FORMAT: text 

 

This output file is created only if the number of active columns in a potential failure mass falls below the 

user-specified limit, limcol (section 4.4.1.1.10). This condition does not terminate Scoops3D execution, but the 

factor of safety, volume, and area computations for this potential failure mass may be suspect. This file contains a 

listing of all surfaces within the user-specified size constraints but with a potential failure mass containing a 

number of active columns less than limcol. It lists all trial surfaces failing this column criterion, not just the 

critical surfaces. To examine the number of active columns defining only the critical surfaces, the user should 

view the contents of the <filein>_numcols_out.asc file (generated when isqout = 1, section 4.5.3.2.2). If many 

trial surfaces are flagged as having too few active columns, the user may wish to either increase the resolution  

of the DEM grid (effectively creating more columns) so that more columns are intersected by trial surfaces 

(section 5.3.4). 

The column warning file contains two header lines and then a series of lines for each trial surface not 

meeting the user-selected limcol criteria; an example is shown in figure 4.32. This information includes: 

• # cols – number of DEM cells (active columns) in the potential failure mass, 

• xcen, ycen, zcen – coordinates of the rotational center of the trial surface specified in the 

coordinate system of the DEM, 

• radius - radius of the sphere containing the trial surface, 

• volume - computed volume of the potential failure mass, 

• area - horizontal area of the potential failure mass, and either 

• F_Bish – computed factor of safety using Bishop’s simplified method (if method = ‘B’ or ‘b’),  

or F_Ord – computed factor of safety using the Ordinary (Fellenius) method (if method = ‘O’  

or ‘o’). 
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Trial surfaces with columns < limcol 
#cols xcen_m  ycen_m  zcen_m  radius_m volume_m^3 area_m^2 F_Bish 
92 561224.6317 5112296.1291 1800.000 740.161 1.053E+08 8.366E+05 6.6959 
83 562024.6317 5112296.1291 1800.000 663.685 1.062E+08 7.556E+05 6.6515 
87 562824.6317 5112296.1291 1800.000 694.758 1.056E+08 8.033E+05 5.5904 
95 564424.6317 5112296.1291 1800.000 771.473 1.014E+08 8.524E+05 7.3548 
91 558824.6317 5113096.1291 1800.000 795.604 1.073E+08 8.183E+05 4.1298 
95 559624.6317 5113096.1291 1800.000 702.510 1.068E+08 8.171E+05 7.0428 
... 

 
Figure 4.32. Text excerpt from a column warning output file. File from Mount St. Helens example R (file name: 
R_sthel_ncolerr_out.txt); see section 7.6. 

4.5.2.3. Filtered Surfaces File 

CONDITIONS FOR FILE CREATION: method = ‘B’ or ‘b’ and either convergence problems or ma > 

absminma 

 

NAME: <filein>_filter_out.txt 

FORMAT: text 

This output file lists details associated with all trial surfaces (meeting the user-specified size constraints) 

that were either filtered or failed to converge during factor-of-safety, F, iterations. This file is created when at 

least one trial surface meets one of these conditions—such conditions do not terminate a Scoops3D run, but do 

indicate that Scoops3D was unable to calculate a factor of safety for some potential failure masses. The factor of 

safety is assigned a value of 111.0 if a solution cannot be reached in 25 iterations (if monotonically converging). 

We have found that most solutions converge in 4 to 5 iterations (section 2.3.2). The user-specified filtering option 

(absminma – see section 4.4.1.1.8) and non-convergence problems occur only when using Bishop’s simplified 

method. The factor of safety for trial surfaces that converge but do not meet the filter criteria are also shown in 

this file. Note, however, that these surfaces are not included in the analysis of critical surfaces (and therefore are 

not included in files such as the factor-of-safety file, <filein>_fos3d_out.asc). 

The filtered surfaces file contains several header lines and then lists the following values for each filtered 

surface: 

• xcen, ycen, zcen – coordinates of the rotational center of the trial surface, in the coordinate system of 

the DEM, 

• radius - radius of the sphere containing the trial surface, 

• angle - slip direction in degrees (counter-clockwise from the positive x-axis), 

• minma – minimum value of mα computed with Bishop’s simplified method for the potential failure 

mass, 



 

 118 

• F_Bish - factor of safety computed using Bishop’s simplified method (if method = ‘B’ or ‘b’), and 

• F_Ord - factor of safety computed using the Ordinary (Fellenius) method. 

An example of <filein>_filter_out.txt is shown in figure 4.33. 

 

This file contains data for trial slip surfaces filtered by absminma 
 and nonconverging surfaces. 
These data are not used in the search for minimum F values. 
xcen_ft    ycen_ft  zcen_ft radius_ft angle minma  F_Bish F_Ord 
1258401.9727 216371.9230 200.000 51.234 120.068 9.473E-03 111.000 1.220 
1258401.9727 216371.9230 200.000 51.234 122.068 6.661E-03 111.000 1.220 
1258401.9727 216371.9230 200.000 51.234 124.068 4.574E-03 111.000 1.220 
1258401.9727 216421.9230 200.000 54.561  16.907 3.391E-02 111.000 1.002 
 

 

Figure 4.33. Text excerpt from a filtered surfaces output file. File from a variation of Seattle example Q (file name: 
Q_seawet_filter_out.txt); see section 7.5. Note that, in this example, no mα filter was specified by the user (absminma = 0), 
so all surfaces listed here failed to converge within 25 iterations. 

4.5.2.4. Filtered Surfaces Location File 

CONDITIONS FOR FILE CREATION: method = ‘B’ or ‘b’ and either convergence problems occurred or ma

> absminma 

NAME: <filein>_filtergrid_out.asc 

FORMAT: ASCII raster 

This raster grid output file contains the number of times that each DEM cell was intersected by trial 

surfaces that were filtered out or failed to converge. This file is created only when Bishop’s simplified method  

is selected and at least one trial surface was filtered or failed to converge during factor-of-safety iterations 

(section 4.5.2.3). This file is useful for viewing whether excessive factor-of-safety computational problems were 

encountered in areas of interest within the DEM (see fig. 5.11). The file is written in ASCII raster format (see for 

example fig. 4.20). 

4.5.2.5. Detailed Forces and Factor-of-Safety File 

CONDITIONS FOR FILE CREATION: method = ‘O’ or ‘o’ and srch = ‘single’ 

NAME: <filein>_foslocal_out.txt 

FORMAT: text 

 

This output file is automatically generated only if the user specifies the Ordinary (Fellenius) method with 

a single trial surface analysis. The file contains information about the local factor of safety (resisting/driving 
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forces) at the base of each column intersected by the user-specified trial surface. This information can be used to 

carefully examine individual column driving and resisting forces acting on a specific trial surface. This file is 

available only with the Ordinary method because this method does not consider the entire mass during the 

solution of F. 

The detailed forces file contains one header line followed by lines containing: 

• i, j - cell counter (section 4.4.1.1.9.1) indicating the horizontal location of the column, 

• sliparea – trial surface area, 

• res. frict - frictional component of the resisting force acting on the column base, 

• res. coh. - cohesive component of the resisting force acting on the column base, 

• total res. - total resisting force on the column, 

• total driv. - total driving force on the column, and 

• res./driv. – ratio of total resisting/total driving force for the column (the local factor of safety). 

Note that the local factor of safety can be negative because the driving force on the base of a single 

column may be in a direction opposite that of the overall slip direction. An example of this file is shown in  

figure 4.34. 

i  j sliparea res. frict. res. coh. total res. total driv. res./driv. 
42 25 4.3506E-02 4.2096E-03 1.3052E-01 3.5011E+00 1.5124E-01 2.3150E+01 
43 25 6.9415E-02 1.0085E-02 2.0824E-01 5.6714E+00 3.8340E-01 1.4792E+01 
44 25 8.0718E-02 1.3279E-02 2.4215E-01 6.6342E+00 5.3335E-01 1.2439E+01 
45 25 7.7021E-02 1.1843E-02 2.3106E-01 6.3092E+00 5.0176E-01 1.2574E+01 
46 25 5.7797E-02 6.6172E-03 1.7339E-01 4.6769E+00 2.9536E-01 1.5835E+01 
47 25 2.2377E-02 1.2505E-03 6.7131E-02 1.7776E+00 5.8735E-02 3.0265E+01 
38 26 9.0524E-02 1.9834E-02 2.7157E-01 7.6369E+00 5.5311E-01 1.3807E+01 
39 26 1.7547E-01 6.8817E-02 5.2642E-01 1.5579E+01 2.0496E+00 7.6011E+00 
... 

 

Figure 4.34. Text excerpt from a detailed forces output file. File from example G using Ordinary method (file name: 
G_emb10single_foslocal_out.txt); see section 7.3. 

 

4.5.2.6. Removed Failure Masses File 

CONDITIONS FOR FILE CREATION: remove = ‘A’ or ‘a’ and calculation of potential failure masses with F < 

foscut 

NAME: <filein>_spheresltcut_out.txt 

FORMAT: text 

If the user chooses to create a new DEM with all potential failure masses removed (remove = ‘A’ or ‘a’) 

having a factor of safety, F, less than the value of foscut (section 4.4.1.1.11.1), this output file lists additional 
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information about the masses removed from the original DEM. This file can be used to recreate any trial surfaces 

that were removed. The text file contains two header lines (fig. 4.35). For an explanation of the variables 

contained in this file, see the variables described for the critical-trial-surfaces output file, 

<filein>_spheres_out.okc (section 4.5.1.4). 

 
Potential failure masses with F < 1.400 
xcen_ft    ycen_ft  zcen_ft radius_ft angle volume_ft^3 area_ft^2 F_Bish 
1254251.9727 217221.9230 650.00 552.6975 142.9037 2.249E+05 1.835E+04 1.3719 
1254451.9727 217221.9230 450.00 310.1039 135.4226 3.314E+05 2.168E+04 1.3355 
1255451.9727 219021.9230 250.00 241.0051 145.4801 1.063E+05 8.536E+03 1.3565 
1258251.9727 219021.9230 450.00 380.7452 23.6471 9.661E+05 5.019E+04 1.3483 
1255651.9727 219221.9230 250.00 224.5933 143.7098 2.904E+05 1.711E+04 1.2876 
1255651.9727 219221.9230 250.00 234.5933 143.0667 6.185E+05 3.362E+04 1.3433 
1258151.9727 215921.9230 450.00 207.5477 23.3521 1.164E+05 1.072E+04 1.3880 
1258151.9727 216021.9230 350.00 116.7330 335.9197 1.106E+05 8.740E+03 1.3817 
1254051.9727 216421.9230 350.00 183.2500 151.8632 1.144E+05 9.193E+03 1.3256 
... 

 

Figure 4.35. Text excerpt from a removed failure masses output file. File from example P (file name: P_seadry 

_spheresltcut_out.txt); see section 7.5. 

4.5.3. Optional Output Files 

Scoops3D can generate a variety of optional output files useful for analyzing certain stability scenarios. 

The user can select any or all of these files by setting flags in the main parameter input file or by using 

Scoops3D-i (see section 4.3.3.6). Caution should be exercised when selecting optional 3D output files – they can 

occupy considerable storage space. 

4.5.3.1. New DEM File 

SELECTION OPTION: remove = ‘A’, ‘a’, ‘L’, ‘l’, ‘M’, or ‘m’ 

NAME: <filein>_newDEM_out.asc 

FORMAT: ASCII raster 

This optional output file contains a new DEM with user-specified potential failure masses removed from 

the original DEM, creating a new ground surface coincident with the trial surfaces of these specified potential 

failure masses. Parts of the DEM not affected by the potential failure masses remain the same. This file is created 

only if the remove parameter (section 4.4.1.1.11.1) in the main parameter input file is ‘A’, ‘L’, or ‘M’ (or the 

lower case equivalents). If the parameter equals ‘N’ or ‘n’ or the parameter line pair is absent from the main input 

file, then the file is not created. A value of ‘A’ or ‘a’ removes all potential failures with factors of safety less than 

a cutoff value (foscut) from the DEM. ‘L’ or ‘l’ removes only the largest potential failure mass with a factor of 

safety less than the cutoff value. ‘M’ or ‘m’ removes the failure mass with the minimum global factor of safety. If 



 

 121 

no critical potential failure masses have a factor of safety less than the cutoff, this output file is not generated. The 

file is written in ASCII raster format (see for example fig. 4.20). 

4.5.3.2. Search Quality Files 

SELECTION OPTION: isqout = 1 

If this option is selected (isqout = 1), Scoops3D generates three or four (four if srch = ‘box’ is also 

selected) additional output files. These files can be used to check the overall quality of both the factor of safety 

solutions and the search. Typically, this option is used early in an analysis process and then unselected after the 

user is satisfied with the overall solution and search quality (see section 5.1). 

4.5.3.2.1. Critical-Size Check File 

NAME: <filein>_critcheck_out.asc 

FORMAT: ASCII raster 

 

This output file contains a raster grid that indicates whether the size of the critical potential failure 

determined at each DEM cell was close to the upper or lower size limit, based on the user-specified primary 

criterion of either volume or area and associated tolerances. A user may view this file to determine whether the 

factor-of-safety search has been overly limited by size restrictions (see section 5.3.2; fig. 5.3). To find the global 

minimum factor of safety, trial surfaces should not be restricted by size limits, although limitations may be 

acceptable if the user is only interested in a specific size range. Each cell with a valid computed factor of safety 

can have one of four values (table 4.5). The file is written in ASCII raster format (see for example fig. 4.20). 

Table 4.5 List of numeric codes used in the critical-size check output file (<filein>_critcheck_out.asc). 
 
[Scoops3D assigns the numeric code by comparing the size of the critical potential failure mass for each DEM cell with the 
user-specified primary size criterion] 
 

Code 
Explanation 

Volume is primary criterion  
(vacriterion = 'V' or 'v') 

Area is primary criterion  
(vacriterion = 'A' or 'a') 

-1 DEM cell was not included in any trial surface DEM cell was not included in any trial surface 

0 Size was not restricted Size was not restricted 

1 Volume was less than vmin+tol, Horizontal area was less than armin+tol, 

2 Volume was greater than vmax-tol Horizontal area was greater than armax-tol 
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4.5.3.2.2. Number of Columns File 

NAME: <filein>_numcols_out.asc 

FORMAT: ASCII raster 

This output file contains a raster grid showing the number of active columns associated with the critical 

potential failure mass for each DEM cell. A user can view the contents of this file to determine whether all 

regions of interest have sufficient columns in the critical potential failure masses (see section 5.3.4; fig. 5.5) to 

ensure accurate factor of safety, volume, and area calculations. The file is written in ASCII raster format (see for 

example fig. 4.20). 

4.5.3.2.3. Horizontal Search Space File 

NAME: <filein>_searchgrid_out.asc 

FORMAT: ASCII raster 

 

This output file contains a raster grid showing the location of DEM cells above which search-lattice nodes are 

located. Thus, this file shows the horizontal alignment of the search space relative to the DEM grid as well as the 

horizontal search-lattice spacing. Visualization of this file can help the user assure the proper alignment of the 

horizontal search space in relation to the DEM (fig. 4.36), and may be particularly helpful when using a search 

grid file (section 4.4.2.1.3). Note that the boundaries of the search grid file may be larger than the boundary of the 

DEM (fig. 4.36), or may be restricted to a region smaller than the DEM. This file is generated as a union of the 

user-input search area (from either a search file or a box) and the DEM area. Each grid cell contains one of four 

possible numbers (table 4.6). The file is written in ASCII raster format (see for example fig. 4.20). 

Table 4.6 List of numeric codes used in the horizontal search space output file (<filein>_searchgrid_out.asc). 
 
[Numeric codes indicate how the horizontal extent of the 3D search lattice overlaps with the DEM. Cells with negative 
numbers indicate that search-lattice nodes do not exist at that horizontal location] 
 

 Code Explanation 
Search-lattice nodes exist at location Location is inside the boundary of the DEM 

-1 No Yes 

-11 No No 

2 Yes Yes 

22 Yes No 

 

  



 

 123 

 
Figure 4.36. Examples of maps created from Scoops3D output files illustrating the horizontal extent of the search lattice 
relative to the DEM. Data portrayed are contained in horizontal search space output files (<filein>_searchgrid_out.asc) and 
show two search lattices that extend outside the boundary of the DEM. Black box outline indicates the boundary of the DEM. 
Red indicates DEM cells above which there are some search-lattice nodes. Blue indicates DEM cells above which there are 
no search-lattice nodes. A, Search lattice with a horizontal multiplier of 5 (nsrchres = 5). B, Search lattice with a horizontal 
multiplier of 1 (nsrchres = 1). Maps created using Esri ArcMap software. 

 

4.5.3.2.4. Search-Lattice Boundary Check File 

SELECTION OPTION: isqout = 1 and srch = ‘box’ 

NAME: <filein>_boundcheck_out.asc 

FORMAT: ASCII raster 

 

This output file contains a raster grid identifying the DEM cells where a search-lattice node associated 

with a critical surface (here called a critical node) is located on a boundary of the search lattice. A user could 

view this file to determine whether the search lattice is too restrictive to ensure finding critical surfaces with the 

minimum F (see section 5.3.5; fig. 5.8). In this file, areas of interest in the DEM should contain the value zero. 

Non-zero values indicate that the extent of the search lattice was most likely not sufficient to locate the critical 

surface at the specified DEM cell. If a critical node is located on multiple boundaries of the search lattice, the 

value assigned to the lattice boundary check array is the sum of the values in table 4.7. For example, a DEM cell 

with a critical search-lattice node location on the uppermost (highest elevation), western boundary of the search 

lattice would be assigned a value 9+100 = 109. The file is written in ASCII raster format (see for example  

fig. 4.20). An example map created from this file is shown in figure 4.37. 
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Table 4.7. List of numeric codes used in the search-lattice boundary check file (<filein>_boundcheck_out.asc).  
 
[Note that if the search lattice is restricted on more than one boundary, the value assigned to the boundary check array by 
Scoops3D will be the sum of the values in this table] 
 

Code Problem Explanation 

   0  --- Critical node not on boundary, search lattice was not restricted 

 100 ismin is too large Critical node on west side of search lattice 

 900 ismax is too small Critical node on east side of search lattice 

  10 jsmin is too large Critical node on south side of search lattice 

  90 jsmax is too small Critical node on north side of search lattice 

  1 zsmin is too large Critical node on the bottom of the search lattice 

  9 zsmax is too small  Critical node on the top of the search lattice 

-9999 --- No trial surfaces found 

 
 
 

 
Figure 4.37. Example of a map created from a search-lattice boundary check file (<filein>_boundcheck_out.asc) for a search 
that was limited on the north and east sides of the DEM. Numeric codes are explained in table 4.7. The 100 m contour lines 
are derived from the DEM for Scoops3D Mount St. Helens example R (file name: sthel_res100mDEM.asc); see section 7.6. 
Map created using Esri ArcMap software. 
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4.5.3.3. Relative-Minimum Factor-of-Safety File 

NAME: filein>_fos3drel_out.asc 

FORMAT: ASCII raster 

 

This output file contains a raster grid of the relative-minimum 3D factors of safety calculated for each 

DEM cell by the user-selected limit-equilibrium method (Bishop’s or Ordinary). Relative factor of safety is 

defined as the computed minimum factor of safety at a DEM cell divided by the global minimum factor of safety. 

These normalized values can provide a convenient way to compare the locations of unstable areas between 

different scenarios. Invalid factor-of-safety results are reported in the same manner as in the minimum factor of 

safety file described in section 4.5.1.2. The file is written in ASCII raster format (see for example fig. 4.20). 

4.5.3.4. 3D Search-Lattice Files 

Scoops3D has two options for creating 3D files containing results from the search lattice located above 

the DEM. One option (icritlattice) creates a file containing F values for search nodes associated with critical 

surfaces affecting the DEM (section 3.2). The other option (ilattice) creates a file containing the minimum F 

values found at each lattice node. Both search-lattice files contain the x, y, and z coordinates and an associated 

factor of safety found at each node in the 3D search lattice. 

3D visualization of the 3D search-lattice file highlighting the critical nodes 

(<filein>_critfoslattice_out.3D) can help the user decide if the limits of the search lattice are adequate (fig. 4.38 

and section 5.3.5); a well-defined search-lattice space ensures that the minimum F is found for all cells in the 

DEM. On the other hand, 3D visualization of the 3D search-lattice file containing the minimum F values for all 

the search nodes (<filein>_foslattice_out.3D) may be used to examine the overall spatial pattern of the lowest 

factors of safety found, but may not be as helpful for deciding the limits of the search lattice because not all of the 

factors of safety in the file are associated with a critical surface affecting the DEM. The pattern in this file 

(<filein>_foslattice_out.3D) is similar in appearance to the results of a grid search for the global minimum in 

other slope-stability software (for example Krahn, 2004; O. Hungr Geotechnical Research Inc., 2010). 

  



 

 126 

4.5.3.4.1. 3D Search-Lattice File Highlighting Critical Nodes 

SELECTION OPTION: icritlattice = 1 

NAME: <filein>_critfoslattice_out.3D 

FORMAT: text in Point3D format 

This 3D optional output file of the search lattice highlighting critical nodes is generated when icritlattice 

= 1. Followed by a simple header in Point3D format (see example in fig. 4.38), each line in the 3D file contains 

the x, y, z coordinates of the lattice node in the coordinate system of the DEM, and the minimum factor of safety 

found for critical surfaces centered at that node. If multiple critical surfaces used the same lattice node, then only 

the minimum of the multiple F values is contained in the file. All search nodes that did not generate a critical 

surface are assigned the value 10000.0000. If a search-lattice node did not yield any valid trial surfaces, one of 

three values is assigned: (1) 9999.00 indicates no valid potential failure masses could be found within the 

specified size range, (2) 111.00 indicates all trial surfaces had non-converging limit-equilibrium solutions or 

solutions eliminated due to user-defined mα filter (section 4.4.1.1.8), and (3) 100.00 indicates that all trial surfaces 

had a calculated factor of safety greater than or equal to 100.0. A 3D visualization of an example 3D search-

lattice file highlighting the critical nodes is shown in figure 4.39. 
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x_m y_m z_m F_Bish 
558024.6317     5111496.1291     1000.0000 9999.0000 
558024.6317     5111496.1291     1800.0000 9999.0000 
558024.6317     5111496.1291     2600.0000 9999.0000 
558024.6317     5111496.1291     3400.0000 9999.0000 
558024.6317     5111496.1291     4200.0000 9999.0000 
558024.6317     5111496.1291     5000.0000 9999.0000 
558024.6317     5111496.1291     5800.0000 9999.0000 
558024.6317     5111496.1291     6600.0000 9999.0000 
558024.6317     5111496.1291     7400.0000 9999.0000 
558024.6317     5111496.1291     8200.0000 9999.0000 
558024.6317     5111496.1291     9000.0000 9999.0000 
558824.6317     5111496.1291     1000.0000 9999.0000 
558824.6317     5111496.1291     1800.0000 9999.0000 
558824.6317     5111496.1291     2600.0000 9999.0000 
558824.6317     5111496.1291     3400.0000 9999.0000 
558824.6317     5111496.1291     4200.0000 9999.0000 
558824.6317     5111496.1291     5000.0000 9999.0000 
558824.6317     5111496.1291     5800.0000 9999.0000 
558824.6317     5111496.1291     6600.0000 9999.0000 
558824.6317     5111496.1291     7400.0000 10000.0000 
558824.6317     5111496.1291     8200.0000 10000.0000 
558824.6317     5111496.1291     9000.0000 10000.0000 
... 
563024.6317     5118696.1291     4200.0000 10000.0000 
563024.6317     5118696.1291     4400.0000 10000.0000 
563224.6317     5118696.1291     3600.0000 10000.0000 
563224.6317     5118696.1291     4000.0000   2.2046 
563224.6317     5118696.1291     4400.0000 10000.0000 
563424.6317     5118696.1291     3600.0000 10000.0000 
563424.6317     5118696.1291     3800.0000 10000.0000 
563424.6317     5118696.1291     4000.0000   2.2225 
563424.6317     5118696.1291     4200.0000 10000.0000 
563424.6317     5118696.1291     4400.0000 10000.0000 
563424.6317     5118696.1291     4600.0000 10000.0000 
563424.6317     5118696.1291     4800.0000 10000.0000 
563624.6317     5118696.1291     4400.0000   2.2605 
563624.6317     5118696.1291     4800.0000 10000.0000 
563824.6317     5118696.1291     4400.0000   2.2907 
563824.6317     5118696.1291     4600.0000   2.2767 
563824.6317     5118696.1291     4800.0000   2.2758 
563824.6317     5118696.1291     5000.0000 10000.0000 
563824.6317     5118696.1291     5200.0000 10000.0000 
564024.6317     5118696.1291     4400.0000 10000.0000 
564024.6317     5118696.1291     4800.0000   2.3077 
564024.6317     5118696.1291     5200.0000 10000.0000 
564224.6317     5118696.1291     4400.0000 10000.0000 
564224.6317     5118696.1291     4600.0000 10000.0000 
564224.6317     5118696.1291     4800.0000   2.3728 
564224.6317     5118696.1291     5000.0000   2.3525 
564224.6317     5118696.1291     5200.0000 10000.0000 
564224.6317     5118696.1291     5400.0000 10000.0000 

... 
 
Figure 4.38. Text excerpts from a 3D search-lattice output file highlighting the critical nodes. File from the Mount St. Helens 
example R displayed in figure 4.39 (file name: R_sthel_critfoslattice_out.3D). Note that some nodes contained in this excerpt 
had either no valid trial surfaces (values of 9999.0000) or only trial surfaces associated with non-critical surfaces (values of 
10000.0000). 
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Figure 4.39. Images showing the 3D visualization of the search lattice highlighting critical nodes displayed above the 
corresponding factor-of-safety map draped on topography. Files from the Mount St. Helens example R (file names: 
R_sthel_critfoslattice_out.3D and R_sthel_fos3d_out.asc); see section 7.6. The example uses a coarse-to-fine search. A, All 
searched lattice nodes are shown with small black points. B, Search-lattice nodes with a critical surface are shown with colors 
assigned to factor of safety (F); high values of F and nodes that are not associated with critical surfaces are shown in grey. 
Note that each critical node in the lattice is associated with a critical surface in the factor-of-safety map. Images produced 
using VisIt software. 

4.5.3.4.2. 3D Search-Lattice File of Minimum F Value for Each Search Node 

SELECTION OPTION: ilattice = 1 

NAME: <filein>_foslattice_out.3D 

FORMAT: text in Point3D format 

This 3D optional output file of the search lattice containing the minimum F for each search node is 

generated when ilattice = 1. Following a simple header in Point3D format, each line in the 3D search-lattice file 

contains the x, y, z coordinates of the lattice node in the coordinate system of the DEM and the minimum factor 

of safety found for any trial surfaces centered at that node. Values in this file can differ from those in 

<filein>_critfoslattice_out file (section 4.5.3.4.1) for two reasons: (1) many of the lattice nodes may not represent 

the centers of critical surfaces but do have computed F values for other trial surfaces, and (2) some critical node 

values may be superseded by other trial surfaces with lower F values from less-stable parts of the DEM that have 

a critical node located elsewhere in the search space. If a search-lattice node did not yield any valid trial surfaces 

one of three values is assigned, as described in section 4.5.3.4.1 for the <filein>_critfoslattice_out.3D file. An 

excerpt of the output file is shown in figure 4.40 and a 3D visualization of an example of the complete 3D search-

lattice file is shown in figure 4.41. 
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x_m y_m z_m F_Bish 
558024.6317     5111496.1291     1000.0000 9999.0000 
558024.6317     5111496.1291     1800.0000 9999.0000 
558024.6317     5111496.1291     2600.0000 9999.0000 
558024.6317     5111496.1291     3400.0000 9999.0000 
558024.6317     5111496.1291     4200.0000 9999.0000 
558024.6317     5111496.1291     5000.0000 9999.0000 
558024.6317     5111496.1291     5800.0000 9999.0000 
558024.6317     5111496.1291     6600.0000 9999.0000 
558024.6317     5111496.1291     7400.0000 9999.0000 
558024.6317     5111496.1291     8200.0000 9999.0000 
558024.6317     5111496.1291     9000.0000 9999.0000 
558824.6317     5111496.1291     1000.0000 9999.0000 
558824.6317     5111496.1291     1800.0000 9999.0000 
558824.6317     5111496.1291     2600.0000 9999.0000 
558824.6317     5111496.1291     3400.0000 9999.0000 
558824.6317     5111496.1291     4200.0000 9999.0000 
558824.6317     5111496.1291     5000.0000 9999.0000 
558824.6317     5111496.1291     5800.0000 9999.0000 
558824.6317     5111496.1291     6600.0000 9999.0000 
558824.6317     5111496.1291     7400.0000   7.3036 
558824.6317     5111496.1291     8200.0000   7.4781 
558824.6317     5111496.1291     9000.0000   7.7879 
... 
563024.6317     5118696.1291     4200.0000   2.2200 
563024.6317     5118696.1291     4400.0000   2.2521 
563224.6317     5118696.1291     3600.0000   2.2606 
563224.6317     5118696.1291     4000.0000   2.2046 
563224.6317     5118696.1291     4400.0000   2.2387 
563424.6317     5118696.1291     3600.0000   2.2858 
563424.6317     5118696.1291     3800.0000   2.2437 
563424.6317     5118696.1291     4000.0000   2.2225 
563424.6317     5118696.1291     4200.0000   2.2370 
563424.6317     5118696.1291     4400.0000   2.2492 
563424.6317     5118696.1291     4600.0000   2.2759 
563424.6317     5118696.1291     4800.0000   2.2985 
563624.6317     5118696.1291     4400.0000   2.2605 
563624.6317     5118696.1291     4800.0000   2.2763 
563824.6317     5118696.1291     4400.0000   2.2734 
563824.6317     5118696.1291     4600.0000   2.2757 
563824.6317     5118696.1291     4800.0000   2.2664 
563824.6317     5118696.1291     5000.0000   2.2846 
563824.6317     5118696.1291     5200.0000   2.3108 
564024.6317     5118696.1291     4400.0000   2.3383 
564024.6317     5118696.1291     4800.0000   2.2881 
564024.6317     5118696.1291     5200.0000   2.3020 
564224.6317     5118696.1291     4400.0000   2.4431 
564224.6317     5118696.1291     4600.0000   2.3913 
564224.6317     5118696.1291     4800.0000   2.3637 
564224.6317     5118696.1291     5000.0000   2.3343 
564224.6317     5118696.1291     5200.0000   2.3280 
564224.6317     5118696.1291     5400.0000   2.3353 
... 

 

Figure 4.40. Text excerpts from a 3D search-lattice output file containing values for each lattice node. File from the Mount St. 
Helens example R displayed in figure 4.41 (file name: R_sthel_foslattice_out.3D); see section 7.6. File contents differ from the 
search-lattice output file highlighting the critical nodes shown in figure 4.39. 
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Figure 4.41. Image of 3D visualization of the minimum F found at each search-lattice node. File from the Mount St. Helens 
example R (file name: R_sthel_foslattice_out.3D) displayed above the DEM (file name: sthel_res100mDEM.asc); see  
section 7.6. The example uses a coarse-to-fine search. Image produced using VisIt software. 

 

4.5.3.5. 3D Subsurface Factor-of-Safety File 

SELECTION OPTION: isubsurf = 1, 2, or 3 

NAME: <filein>_subsurffos_out.3D or <filein>_subsurffos_out.txt 

FORMAT: text in Point3D format or Scoops3D formats 

This optional 3D output file contains a 3D array of the minimum factor of safety, F, found at depth 

beneath each DEM cell and at a constant vertical spacing defined by zfrac. It is created when isubsurf = 1, 2, or 3 

(section 4.4.1.1.11.6) in the main parameter input file. Visualization of this file enables the user to identify 

continuous regions in the subsurface having similar values of F. Given the constant (regular) vertical spacing of 

the data in the file, there may or may not be an F value in the file for the exact ground-surface elevation at each 

DEM cell. Therefore, the file typically contains vertical values above the DEM surface. This allows 3D 

visualization software to smoothly portray F throughout the domain under the DEM surface (fig. 4.42). Using 

such software, the user can truncate the excess region above the DEM surface, if desired. Note that this file can 

become quite large if zfrac is small and (or) the dimensions of the DEM are large. 
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If isubsurf = 1 or 2, Scoops3D generates the output file <filein>_subsurf_out.txt with the location 

coordinates specified in either ijk (isubsurf = 1) or xyz (isubsurf = 2) format. For explanation of coordinate 

systems, see section 4.4.2.2.1. If isubsurf = 3, the file <filein>_subsurf_out.3D is generated with xyz coordinates, 

all specified in the coordinate system of the DEM, and a simplified header in Point3D format. The horizontal 

spacing of data within the file is equal to the DEM cell size and the vertical (depth) spacing is controlled by zfrac. 

Examples of the three output options are shown in figure 4.43. 

 

 
Figure 4.42. Image of 3D visualization of subsurface factors of safety. Ground surface truncated by topography and vertical 
slice to portray interior beneath the DEM. File from the Mount St. Helens example R (file name: R_sthel_subsurffos_out.3D); 
see section 7.6. Image created using VisIt software. 
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A 
# Comments: Scoops3D Factors of safety in the subsurface 
# Coordinate_system: ijk 
# Field: 1 i 
# Field: 2 j 
# Field: 3 k 
# Field: 4 F_Bish 
# Length_units: m 
# Grid_size:   96 x   91 x   28 
# Grid_x_range:  557974.632 to  567574.632 
# Grid_y_range: 5111446.129 to 5120546.129 
# Grid_z_range:   256.155 to   3056.155 
  6  91  1 9999.0000 
  6  91  2 9999.0000 
  6  91  3 9999.0000 
  6  91  4 9999.0000 
  6  91  5 9999.0000 
  6  91  6 9999.0000 
  6  91  7 9999.0000 
  6  91  8  11.2456 
  6  91  9  11.2456 
  6  91  10  11.2456 
  6  91  11  11.2456 
  6  91  12  11.2456 
... 
B 
# Comments: Scoops3D Factors of safety in the subsurface 
# Coordinate_system: xyz 
# Field: 1 x 
# Field: 2 y 
# Field: 3 z 
# Field: 4 F_Bish 
# Length_units: m 
# Grid_size:   96 x   91 x   28 
# Grid_x_range:  557974.632 to  567574.632 
# Grid_y_range: 5111446.129 to 5120546.129 
# Grid_z_range:   256.155 to   3056.155 
     558524.620     5120496.000       306.155 9999.0000 
     558524.620     5120496.000       406.155 9999.0000 
     558524.620     5120496.000       506.155 9999.0000 
     558524.620     5120496.000       606.155 9999.0000 
     558524.620     5120496.000       706.155 9999.0000 
... 
C 
x_m y_m z_m F_Bish 
     558524.620     5120496.000       306.155 9999.0000 
     558524.620     5120496.000       406.155 9999.0000 
     558524.620     5120496.000       506.155 9999.0000 
     558524.620     5120496.000       606.155 9999.0000 
     558524.620     5120496.000       706.155 9999.0000 
... 

 

Figure 4.43. Text excerpts from three equivalent 3D subsurface factor-of-safety output files. Files from the Mount St. Helens 
example R (file name: R_sthel_subsurffos_out) in three user-selectable formats: A, ijk, B, xyz, and C, 3D or Point3D. Note 
that B and C are identical except for the header information. For these examples, zfrac = 1, so the vertical resolution for the 
<filein>_subsurffos_out files is equal to the DEM resolution (100 m). 
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Chapter 5. Practical Considerations 
Ultimately, the user would like to ensure that all of the important parts of the DEM have accurate stability 

assessments that are computed in an acceptable amount of time. This chapter and associated reference tables 

(tables 5.1, 5.2, and 5.3) provide guidelines to assure solution quality and thorough searches of the DEM. In 

addition, we provide guidelines for reducing excessive computer runtime (section 5.2). The seven factors listed in 

table 5.1 control the balance between the solution and search quality and the computational effort expended on a 

Scoops3D analysis. 

Table 5.1. List of factors influencing the thoroughness and accuracy of a 3D stability assessment in Scoops3D.  
 
[Section references and basic methods for assessing the effects are shown for each factor] 
 

Factor Section Method of assessment 
Subsurface 
conditions 

5.3.1 Assess λ values as they relate to potential failure size limits 

Potential failure 
size limits 

5.3.2 Examine critical-size check file (<filein>_critcheck_out.asc), one of the 
search quality files 

DEM extent 5.3.3 Attempt Scoops3D run and determine if computer runtime or memory are 
limitations 

DEM resolution 5.3.4 Examine number of columns file (<filein>_numcols_out.asc), one of the 
search quality files 

Search-lattice 
extent 

5.3.5 Examine search-lattice boundary check (<filein>_boundcheck_out.asc) 
and (or) critical search-lattice (<filein>_foslatticecrit_out.3D) files 

Search resolution 5.3.6 Trial and error. Compare factor of safety (<filein>_fos3d_out.asc) and 
critical size files with results from different search resolutions 

Poor solutions 5.3.7 Examine factor of safety (<filein>_fos3d_out.asc) and number of filtered 
surfaces (<filein>_filtergrid_out.asc) files 

 
Interactions between the factors in table 5.1 can be complex. Typically, actions that improve solution 

quality and thoroughness of the search are the opposite of actions that decrease computational effort and memory 

requirements (tables 5.2 and 5.3). Adjusting one factor without accounting for the effects of the other factors can 

lead to unintended consequences in the slope-stability results. Despite the complex interaction between factors, 

the user can obtain good results by applying the guidelines provided in this chapter. Table 5.2 provides suggested 

actions to achieve specific goals, and references to related sections in this chapter, whereas table 5.3 presents the 

effect that selected actions may have on solution quality, thoroughness of search, computational effort, and 

computer memory requirements. 
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Table 5.2. List of suggestions to improve solution quality, improve thoroughness of search, reduce computational effort, and reduce memory requirements in an 
analysis performed by Scoops3D.  
 
[Each suggestion references a subsection in this chapter for more information, as well as listing the window in Scoops3D-i or parameter(s) in the main parameter 
input file that controls the suggested action] 
 

Desired goal Section Action Location in Scoops3D-i Modification of Scoops3Dinput parameters 

Improve solution 
quality 

5.3.7 Filter poor solutions Options > Advanced Parameters Assign value for absminma 
5.3.4 Increase DEM resolution Performed outside of Scoops3D-i Not applicable 

Improve 
thoroughness 
of  search 

5.3.5 Increase vertical extent of search lattice1 Search Configuration Decrease zsmin and/or increase zsmax 
5.3.5 Increase horizontal extent of search lattice1 Search Configuration Decrease ismin and/or jsmin or increase ismax 

and/or jsmax 
5.3.6 Increase vertical resolution of search lattice Search Configuration Increase zsrchres 
5.3.6 Increase horizontal resolution of search lattice Search Configuration Increase nsrchres 
5.3.2 Increase potential failure size range1 Search Configuration Increase range of armin, armax or vmin, max 
5.3.6 Decrease radius increment Search Configuration Decrease dr 

Reduce  
computational 
effort 

5.3.6 Use coarse-to-fine search Search Configuration > Advanced irefine = 1, adjust multres 
5.3.6 Decrease number of slip directions Search Configuration Decrease numdir and/or deginc 
5.3.6 Decrease vertical resolution of search lattice Search Configuration Decrease zsrchres 
5.3.6 Decrease horizontal resolution of search lattice Search Configuration Decrease nsrchres 
5.3.5 Decrease vertical extent of search lattice  Search Configuration Increase zsmin and/or decrease zsmax 
5.3.5 Decrease horizontal extent of search lattice  Search Configuration Increase ismin and/or jsmin or decrease ismax 

and/or jsmax 
5.3.5 Use search file to decrease horizontal extent of search 

lattice 
Search method  srch = 'file' (requires creation of additional file) 

5.3.6 Increase radius increment Search Configuration Increase dr 
5.3.2 Decrease potential failure size range Search Configuration Reduce range of armin, armax or vmin, vmax 
5.3.3 Decrease extent of DEM Performed outside of Scoops3D-i Not applicable 
5.3.4 Decrease DEM resolution Performed outside of Scoops3D-i Not applicable 

Reduce memory 
requirements 

5.3.5 Decrease vertical extent of search lattice Search Configuration Increase zsmin and/or decrease zsmax 
5.3.6 Decrease vertical resolution of search lattice Search Configuration Decrease zsrchres 
5.3.6 Decrease horizontal resolution of search lattice Search Configuration Decrease nsrchres 
5.3.6 Use simple search instead of coarse-to-fine search Search Configuration > Advanced irefine = 0 
5.3.3 Decrease extent of DEM Performed outside of Scoops3D-i Not applicable 
5.3.5 Decrease horizontal extent of search lattice  Search Configuration Increase ismin and/or jsmin or decrease ismax 

and/or jsmax 
5.3.4 Decrease DEM resolution Performed outside of Scoops3D-i Not applicable 
5.2 Deselect specific optional output files  Options > Output Files isubsurf = 0, isqout = 0, irelfos= 0 

1This action may or may not improve the thoroughness of a search. The user should examine related output files (table 5.1) to determine if a specific action is an improvement. 



 

 135 

Table 5.3. List of the effects of different actions on solution quality, thoroughness of search, computational effort (runtime), and computer memory requirements in 
an analysis performed by Scoops3D.  
 
[Note that improving quality and thoroughness are typically at odds with decreasing computational effort and memory requirements. Some actions will have no effect and are 
indicated by ‘–‘] 

Action Solution quality Thoroughness of search Computational effort Memory requirements 
Potential failure size limits         

  Increase size range – Improve1 Increase – 
  Decrease size range – Degrade1 Decrease – 
DEM extent2      
  Increase extent – – Increase Increase 
  Decrease extent – – Decrease Decrease 
DEM resolution2     
  Increase resolution Improve Improve3 Increase Increase 
  Decrease resolution Degrade Degrade3 Decrease Decrease 
Search-lattice extent     
  Increase horizontal extent – Improve1 Increase Slight increase4 
  Decrease horizontal extent – Degrade1 Decrease Slight decrease4 
  Increase vertical extent – Improve1 Increase Increase4 
  Decrease vertical extent – Degrade1 Decrease Decrease4 
Search resolution     
  Select coarse-to-fine search – Most likely the same Significant decrease Increase 
  Select simple search – Improve in rare cases Significant increase Decrease 
  Increase horizontal resolution – Improve Increase Slight increase 
  Decrease horizontal resolution – Degrade Decrease Slight decrease 
  Increase vertical resolution – Improve Increase Increase4 
  Decrease vertical resolution – Degrade Decrease Decrease4 
  Increase radius increment – Degrade Decrease – 
  Decrease radius increment – Improve Increase – 
  Increase number of slip directions – Improve1 Increase – 
  Decrease number of slip directions – Degrade1 Decrease – 
Other actions     

  Filter solutions using ma
5 Potential improvement No effect Potential decrease – 

  Deselect specific optional output files  – – – Decrease 
1Some actions will increase the number of trial surfaces, but may not be necessary for a thorough search. 
2Changes to the DEM are performed outside of Scoops3D and require modification of associated raster input files (for example, layers or piezometric surfaces) and 3D files 
3Increased DEM resolution increases horizontal search resolution, but is not generally recommended for improved thoroughness of a search. 
4Some changes to search lattice affect memory requirements only when using a coarse-to-fine search. 
5 ma is part of the computation of normal force acting on a trial slip surface, used in Bishop’s simplified method of analysis. 
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5.1. Assess Solution and Search Quality 

Scoops3D can provide slope-stability assessments (including minimum factor of safety and associated 

potential failure size for each DEM cell) for a range of 3D searches. However, the overall quality of the results 

may vary. For a given Scoops3D analysis, the user needs to assess: (1) solution quality and (2) thoroughness of 

the search. Solution quality refers to the accuracy of the factor of safety and size calculations for an individual 

potential failure mass, relative to solutions using large numbers of active columns.  A poor solution can result 

owing to an insufficient number of active columns in a potential failure mass (section 5.3.4) or to convergence 

problems with Bishop’s simplified method (section 5.3.7). Thoroughness of the search refers to the process of 

analyzing enough trial surfaces, in the appropriate user-defined size range, to determine the minimum factor of 

safety for every DEM cell. Search thoroughness is affected by the extent of the search lattice (section 5.3.5) and 

resolution of the search (section 5.3.6). Table 5.2 lists actions to achieve better solution quality and search 

thoroughness using Scoops3D, with references to the pertinent sections of this chapter. Potential effects of these 

actions are listed in table 5.3. Improving solution or search quality will most likely increase computer runtime and 

memory requirements. 

The quality of results desired by the user may vary from project to project. In some cases, only an 

approximation of the factor of safety may be needed, whereas in other cases precise computations of potential 

failure volumes may be necessary. Note that Scoops3D can often provide reasonable estimates of factor of safety 

with relatively coarse DEMs and sparse search lattices. Precise volume computations require higher resolution 

DEMs, with appropriate resolution dependent on the potential failure sizes analyzed. Before assessing the quality 

of the overall analysis, the user needs to identify the areas of interest in the DEM and determine the degree of 

solution certainty required. Scoops3D will not thoroughly assess factors of safety at the edges of a DEM, as any 

trial surfaces that intersect the boundaries are discarded. 

To build confidence in the overall solution and search quality provided by Scoops3D, the user can 

examine each of the main items listed in table 5.1. If the quality or confidence in any factors appear to be subpar 

for the user’s needs, then adjustments can be made as necessary. Typically, a systematic examination requires a 

series of trial-and-error runs to fully evaluate the results. Initially, the user will likely make “best guesses” for 

each parameter, run Scoops3D, examine the output (including the quality files described below), and make 

adjustments as needed. Some of the controlling factors can be assessed using output files; others (such as search 

resolution) need to be assessed by comparing a series of analyses with different resolutions. Details for assessing 

each controlling factor are discussed in section 5.3. 
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In some cases, it may be more effective for the user to initially analyze a subset of the DEM by limiting 

the search lattice to a smaller horizontal extent. A smaller search lattice enables faster computation and therefore 

more efficient examination of the controlling factors. Once appropriate levels for the different factors are 

identified, the user can implement these for analysis of the entire DEM. For completeness, the factors listed in 

table 5.1 should then be re-examined using results from the entire DEM and adjusted as necessary. Note also that 

changes in conditions for a given DEM, such as adding pore pressures or earthquake loading, may necessitate 

modifying some of the analysis factors in table 5.1. 

5.2. Reduce Computer Runtime and Memory Requirements 

For some analyses, a user may find that Scoops3D takes an excessively long time to finish executing. 

Runs using DEMs that contain many cells and that utilize extensive, high-resolution search lattices may take 

hours to days for Scoops3D to finish execution, even on a relatively fast computer with extensive memory.  

Table 5.2 provides some suggestions to reduce computer runtime or memory requirements. Note that these 

actions may reduce solution quality and search thoroughness (table 5.3); in the end the user may need to choose 

an acceptable compromise. 

Improvements in runtime can commonly be achieved by reducing the number of trial surfaces computed 

(by reducing the search lattice resolution or extent) (fig. 5.1A) and (or) the number of active columns (by 

increasing the DEM cell size) contained in each potential failure mass (table 5.3). The simplest approach for 

reducing runtime is to select the coarse-to-fine search option and set the horizontal multiplier to a value greater 

than one (unless the DEM resolution is extremely coarse, this value may be ≥4). We suggest an initial vertical 

resolution equal to the horizontal multiplier times the DEM cell size. Some trial-and-error tests may be needed to 

determine search-lattice resolutions and radius increments that run quickly yet provide reasonable results (5.3.6). 

In addition, runtime may be reduced by decreasing the extent of the search lattice (provided the areas of interest 

are still assessed) or by decreasing the range of potential failure sizes, if appropriate to the problem. Increasing 

the size of the DEM cells (decreasing its resolution) may help as well, so long as enough active columns are 

maintained in the potential failure masses for a reasonable computation of F and size. However, modifying the 

DEM resolution or extent may involve considerable effort by the user, as all associated grids and arrays (for 

example, those for piezometric surface, layers, 3D pressure head or 3D materials) will need to be modified in a 

GIS or other software. Decreasing the number of slip directions or increasing the radius increment will also 

reduce runtime. 
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Figure 5.1. Graphs showing examples of computer runtime and approximate memory requirements using Scoops3D. A, 
Comparison of runtime, number of trial surfaces, and number of search-lattice nodes related to the horizontal and vertical 
search-lattice resolution, described as a multiplier of the DEM cell size. The runtimes are based on variations of Scoops3D 
example file Q_seadry.scp (section 7.5). Analyses were performed on an Intel Xeon W3690, 3.47 GHz processer running the 
Windows 7 operating system. B, Approximate computer memory needed for differing sizes of DEMs, assuming the horizontal 
spacing of the search-lattice nodes equals the DEM cell size (nsrchres = 1). The vertical lattice spacing is a factor of ksmax 
(defined as the integer of ((zsmax-zsmin)/zsrchres) +1). Lattices with larger ksmax values have more nodes. 

If computer memory requirements are halting execution, the user may decrease the extent and (or) 

resolution of the DEM, resulting in a reduced number of DEM cells (fig. 5.1B) as well as a reduced number of 

cells in any associated raster grids and (or) 3D files. The coarse-to-fine search option also requires more memory. 

At the cost of increased runtime, the user may select a simple search instead. Alternatively, if the coarse-to-fine 

search option is selected, memory requirements can be reduced by decreasing the vertical extent (if appropriate) 

or vertical resolution of the search lattice. Modification of the horizontal extent or resolution of the search lattice 

only modestly reduces memory requirements. If an extensive, high-resolution lattice is necessary for a thorough 

search, the user can run several analyses using adjacent regions (laterally and [or] vertically) of the search lattice 

and then combine the results by creating a composite factor-of-safety map containing the minimum values from 

the multiple runs. In addition, the user can reduce memory requirements by not selecting several of the optional 

output files; creating a 3D subsurface F file (isubsurf) uses the most memory. Not selecting the search quality 

files (isqout) and relative F file (irelfos) will slightly reduce memory requirements. 
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Note, in contrast to 64-bit operating systems, 32-bit computer operating systems typically have a 

significantly smaller memory limit for a single task, such as executing Scoops3D. 

5.3. Control Factors 

Although all of the controlling factors listed in table 5.1 play a role in a Scoops3D analysis, several items 

(subsurface conditions, size limits, extent of DEM) relate directly to the physical set-up of the problem, whereas 

others (for example, search lattice resolution and extent) influence the thoroughness of the search process. In the 

following sections, we first discuss those factors involved with the physical set-up of the problem and then 

discuss the factors controlling the solution and search quality. 

5.3.1. Subsurface Conditions 

Subsurface conditions, such as material strength and pore-water pressures, are typically defined by the 

problem of interest. Nevertheless, these factors influence the size and location of the computed critical surfaces, 

which may compel the user to modify the other factors listed in table 5.1. The user should be aware of these 

effects when selecting subsurface values; slight modifications of some factors may lead to more satisfactory 

results. For example, strength parameters have a large effect on the depth of the least stable, or critical, trial 

surface and thus influence potential failure volume and surface area. This can be seen using the non-dimensional 

ratio λ, an index of cohesive to frictional strength: 

 
tan
c

H
=λ
γ φ

, (5.1) 

where c is cohesion, γ is material unit weight, H is hillslope height, and ϕ is angle of internal friction (Janbu, 

1954). 

Critical surfaces obtained for different values of λ, given a 10 m high, 30° embankment (example 

provided in section 6.2.1) are shown in figure 5.2. For larger values of λ (relatively more cohesive strength), the 

critical surface is deeper and the associated volume greater. For dry, cohesionless materials (λ = 0), the critical 

surface is always shallow with minimal volume. Thus, the user should be aware that using purely frictional 

strength with no pore pressures will result in shallow critical surfaces and the least-stable areas will likely merely 

reflect steep areas in the topography. Moreover, least-stable potential failure masses in friction-dominated 

materials will tend to approach, and may be constrained by, the user-defined lower size limits for potential 

failures. 
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Figure 5.2. Cross section showing critical potential failure surfaces for a dry embankment with different values of λ. The 10 m 
high, 30° embankment is described in section 6.2.1. Strength properties and λ values are defined in table 6.3, with the 
addition of a critical surface for λ= 0 (c = 0 kPa, ϕ = 10°, and γ = 17 kN/m3). Materials with relatively less cohesion (lower λ) 
have shallower critical surfaces with smaller volumes. The potential failure surface for λ = 0 is the critical surface with a 
volume larger than 100 m3; smaller volume restrictions yield smaller and slightly less stable potential failures. 

High pore-water pressures at depth can lead to larger, deeper critical surfaces. Computed factors of safety 

can be quite sensitive to pore pressures and excessively high pressures can occasionally lead to unrealistically low 

values of factor of safety when using Bishop’s simplified method of analysis. Potentially unrealistic, high 

pressures can stem from selection of a large value of ru, a piezometric surface above the ground surface (perhaps 

affecting only part of the domain), or locally high pressures in a 3D pressure-head file. Thus, the user should 

exercise diligence when incorporating pore-pressure effects and be aware of any local anomalies in stability 

resulting from locally high pore pressure (see section 5.3.7). 
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5.3.2. Potential Failure Size Limits 

Before performing a Scoops3D analysis, the user must select the minimum and maximum potential 

failure sizes (either volumes or areas) to be analyzed. These limits may be identified on the basis of field 

observations of past failures or selected on the basis of sizes of interest to the user. 

If the user wants to find the ultimate minimum factor of safety for each DEM cell, we recommend a 

search that is not constrained by the size limits. If a restrictive size range is selected, the critical surfaces may be 

outside of this range. Constraints on the critical surfaces can be identified using the critical-size check file 

(<filein>_critcheck_out.asc), one of the optional search quality output files. This file contains an array indicating 

whether the critical potential failure for each DEM cell was restricted by the user-defined size limits (either 

volume or area, depending on the primary criterion selected). Section 4.5.3.2.1 provides a description of the 

values in this file. Examples displaying three different critical-size check files for searches that are: (A) restricted 

by the maximum size limit, (B) restricted by the minimum size limit, and (C) unrestricted in the area of interest, 

are shown in figure 5.3. If the user is only concerned with a very specific size range, it may be acceptable to have 

some critical potential failures at the size limits. 

Our experience is that the potential failure size range for a given analysis typically should vary no more 

than about 1–2 orders of magnitude, provided the range brackets the critical sizes, otherwise a thorough search 

may require excessive effort to compute the stability of numerous trial surfaces between the minimum and 

maximum sizes. If the user wants to analyze more potential failure size ranges, we suggest performing multiple 

analyses, each with a different size range. 

In addition, size limits for potential failures can greatly affect the required DEM resolution as well as the 

search resolution and extent needed for a thorough analysis. For example, large potential failures may only need a 

coarse (low) resolution DEM with a relatively large search-lattice extent. In this case, a finer (higher) resolution 

DEM would provide good factor-of-safety solutions, but might lead to excessive computation time. Conversely, 

small potential failures may need a higher-resolution search and DEM to provide accurate results. These issues 

are discussed further in sections 5.3.4 and 5.3.6. 

Another possible problem related to the potential failure size is the number of valid subsets, in the user-

specified size range, found for a given search-lattice node and radius (fig. 3.3). For a given radius, Scoops3D may 

find multiple trial surfaces affecting different parts of the DEM (section 3.2.1). In some cases, it is possible to 

exceed the number of subsets currently allowed in Scoops3D. If the number of subsets exceeds 10, the user will 

receive a warning message, but Scoops3D will not halt execution. This warning indicates that a single sphere 

creates more than 10 separate valid trial surfaces. An occasional occurrence of this message is not of concern, but 

if this message occurs repeatedly then parts of the DEM may not have been thoroughly analyzed. In practice, this 

situation is rare but may indicate a problem with DEM resolution or range of potential failure sizes. 
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Figure 5.3. Maps illustrating restrictions on the size of the critical surfaces for potential failure masses found in three different 
Scoops3D analyses. Volume was selected as the primary size criterion. Data portrayed are contained in critical-size check 
output files (<filein>_critcheck_out.asc). Examples are derived from the Mount St. Helens example R (see section 7.6) by 
modifying the range of potential failure volumes. The 100 m contour lines are derived from the DEM. Critical surfaces found 
for the red DEM cells are at the user-defined maximum volume (critcheck = 2); those in blue are at the minimum volume 
(critcheck = 1). A, Case with vmax for potential failures set too small and numerous critical sizes are at the maximum size 
limit, vmax (vmin = 0.5×108 m3 and vmax = 0.2×109 m3).  B, Case with vmin for potential failures set too large and 
numerous critical sizes are at the minimum size limit, vmin (vmin = 1×109 m3 and vmax = 5×109 m3). C, Case with no size 
restrictions in the areas of interest (vmin = 0.1×109 m3 and vmax = 3.5×109 m3, example R_sthel.scp). Note that the edges 
of the DEM are considered less important and commonly have size restrictions. Maps created using Esri ArcMap software.  
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5.3.3. DEM Extent 

The extent of the DEM to be analyzed is also part of the initial physical set-up. Typically, the user is 

interested in assessing the stability of a specific region. Two issues are germane when selecting a DEM: (1) the 

overall extent and (2) the amount of buffer around the area of interest. Performing a thorough search of a DEM 

with many cells may be computationally intensive, both in computer runtime and memory usage (fig. 5.1). 

Because the sizes of the computational arrays used by Scoops3D are controlled by the number of DEM cells, 

overall memory usage expands as the DEM extent increases. The user may need to decrease the extent of the 

DEM to fit within the memory limits of their computer and (or) to permit reasonable runtimes. If the user wants 

to assess large areas, it may be necessary to perform several analyses with smaller, overlapping DEMs and then 

merge the results. Alternatively, the user may perform a preliminary analysis with a coarse DEM and then further 

examine areas of interest using smaller, finer resolution DEMs. 

In addition, the user should ensure that the DEM includes cells that extend beyond the primary area of 

interest – a buffer area, typically near the boundaries of the domain. This buffer is needed for two reasons. To 

accurately compute stability for a range of potential failure sizes, the DEM needs to include terrain beyond the 

precise area of interest. In addition, cells near the DEM boundaries may be included only in a limited number of 

trial surfaces, as any trial surface that intersects the boundaries is discarded. Thus, DEM cells near the boundaries 

are not fully analyzed for least-stable surfaces, and the user should be aware that computed factors of safety for 

these boundary cells might not be the minimums compared to those determined using a more extensive DEM. 

Commonly, we have found that the buffer area should be a minimum of 10 DEM cells, although the extent for a 

particular analysis depends on DEM cell size, material strength, and potential failure size limits. 

5.3.4. DEM Resolution 

Potential failure masses with too few active columns (defined by the DEM cells) result in poor 

approximations of the potential failure geometry, slip surface area, and volume, and thus poorer calculations of 

factor of safety. Increasing the resolution of the DEM provides more active columns (from both full and partial 

columns) for a given trial surface and thereby increases the accuracy of factor of safety, as well as volume and 

area, calculations. We have found that, for most homogeneous slopes, Scoops3D needs a trial surface that 

includes at least ~200 active columns to provide adequate results in computed factor of safety (within 1 percent) 

and volume (within 2 percent) compared to a solution using tens of thousands of columns (fig. 5.4 and  

section 6.6). However, trial surfaces with ~100 active columns may provide adequate factor-of-safety values. 

Note that Scoops3D can find reasonable factors of safety even with coarser DEM grids; however, these coarse 

grids may reduce the accuracy of computed potential failure sizes. Potential failures in steep terrain, with only 

cohesive strength, or with complex subsurface distributions of material properties and pore-water pressures may 
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require more active columns (at least 300 to 500) within the potential failure mass to provide accurate solutions of 

both factor of safety and volume (see section 6.6). 

 

 
Figure 5.4. Graph showing an example of the differences in computed 3D factor of safety, volume, and horizontal area as the 
number of active columns varies. Example uses the potential failure mass with the global minimum factor of safety from the 
Mount St. Helens example R (section 7.6). Differences are relative to values obtained with a very high-resolution DEM, where 
the potential failure mass contains 10,106 active columns. Vertical line denotes 200 active columns. Differences in all results 
are <1 percent for potential failure masses with >200 active columns. 

By performing an initial analysis, the user can readily examine whether the DEM has sufficient resolution 

to provide potential failure masses with a user-defined minimum number of active columns (set by the parameter 

limcol; the Scoops3D-i default is 100). The main output file (<filein>_out.txt, section 4.5.1.1) lists the number of 

potential failure masses with active column totals less than limcol and the column warning output file (<filein> 

_ncollerr_out.txt, section 4.5.2.2) lists details regarding all trial surfaces (not just the critical surfaces) that 

contain less than the specified number of active columns. Note that Scoops3D does not halt execution if a surface 

has fewer active columns. If many surfaces contain less the desired number of active columns, it may be helpful 

to examine the optional search quality file (<filein>_numcols_out.asc), containing a raster grid recording the 

number of columns included in the critical surface affecting each DEM cell (fig. 5.5), to see whether a large 

number of critical surfaces contained too few active columns, particularly in areas of interest. 
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Figure 5.5. Map showing the number of active columns intersected by the critical surfaces for each DEM cell. Data portrayed 
are contained in the number of columns output file for Seattle example P (file name: P_seadry_numcols_out.asc); see  
section 7.5. DEM cells highlighted in blue have a critical surface affecting less than 100 active columns. Factors of safety and 
volumes for these critical surfaces may not be as accurate as critical surfaces with more active columns. Map created using 
QGIS software. 

Some surfaces with too few active columns will be unlikely to alter the overall results greatly, 

particularly if they are just trial surfaces and not critical surfaces. If there are large numbers of critical surfaces 

with too few active columns, however, then the resolution of the DEM is likely too low. To correct this, the user 

can either obtain a different, higher resolution DEM with smaller cell sizes or resample the original DEM to a 

higher resolution (smaller cell size). Although resampling may improve the accuracy of the factor-of-safety 

solutions, it will not provide any more actual topographic detail and the resulting DEM is merely smoothed; this 

effect may or may not be desirable depending on the likelihood of the smoothed topography being important to 

potential failures. Note that it usually better to resample from the original DEM rather than further resample an 

already resampled DEM. If the DEM resolution is modified, all associated files (other raster grids and 3D arrays) 

should be modified as well.  
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On the other hand, if most of the critical surfaces contain more than a thousand active columns, 

Scoops3D is likely performing extra computational work. This may be acceptable if the user has a fast computer 

with sufficient memory. If not, resampling the DEM to a coarser overall resolution will improve computational 

efficiency. Obtaining an optimal DEM resolution for a particular setting may require a bit of trial and error, and is 

dependent on the potential failure sizes of interest. 

5.3.5. Search-Lattice Extent 

A thorough search requires that the search lattice is of sufficient lateral and vertical extent so that all 

areas of interest are encompassed by trial surfaces with the lowest computed factor of safety. A 3D search in 

Scoops3D involves more than just determining the global (or overall) minimum factor of safety – local minima 

must be determined for each DEM cell of interest to the user. However, if Scoops3D is performing a search with 

an excessively large lattice, the user may want to trim the lattice extent so that unnecessary effort will not be 

expended computing the stability of trial surfaces that are not critical surfaces.  Typically, a coarse-to-fine search 

(the recommended option) with a small amount of “excess” lattice will not greatly affect run time, as most of the 

excess nodes will be ignored. If the user wants to search an irregularly shaped search lattice, a search file can be 

used to define the horizontal extent of the lattice (section 4.4.2.1.3), thereby limiting computational effort. A 

common problem is a lattice that is too restrictive for a thorough search. Below, we first suggest reasonable initial 

settings for the lattice extent and then describe tools that enable the user to assess the thoroughness of the search 

for a given lattice extent. 

A reasonable initial estimate for the horizontal extent of the search lattice is an extent equal to that of the 

DEM (Scoops3D-i option – “Use extents from DEM header”). The horizontal extent can be adjusted in 

subsequent runs if needed. There are cases, commonly with large trial surfaces or steep slopes near a DEM 

boundary, where the horizontal extent of the search lattice should extend beyond the DEM limits (fig. 5.6). 

The upper vertical limit to the search lattice can be more difficult to define. To provide a thorough search, 

we have found that the upper limit of the search lattice should typically extend 2 to 10 times the relief of the 

topography. Flatter slopes commonly need higher vertical limits, relative to their topographic relief (fig. 5.7). We 

suggest that the user initially use a lattice that extends an amount twice the topographic relief above the highest 

point in the topography (for example, if the relief is 1000 m and the highest elevation is 4000 m, then the upper 

vertical limit of the search lattice would be at an elevation of 6000 m). For a lower limit, we suggest an initial 

estimate of approximately half of the relief above the lowest point in the topography (3500 m for the example 

described above). The user may need to revise these lattice limits after examining the optional output files 

described below. 
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Figure 5.6. Perspective view of a cone illustrating a critical search-lattice node beyond the horizontal limits of the DEM. 
Factor-of-safety (F) values for part of the search-lattice nodes (using the ilattice output option) are shown in colors. Cone is 
1,000 m high and slopes 50°; the critical surface for the overall least-stable surface (global minimum) is outlined in red. 
Details of the cone example are described in section 6.2.2. Image created using VisIt software. 

 

 
Figure 5.7. Perspective views of two DEMs showing the location of the critical search-lattice node relative to topographic 
relief. For each DEM, one slice through the search lattice highlights the node with the overall least-stable surface (global 
minimum F); F values for search-lattice nodes obtained using the ilattice output option. A, 10 m high, 60° embankment, 
critical node for global minimum is located at an elevation of ~15 m (~1.5X the relief). B, 10 m high, 10° embankment, critical 
node for global minimum is located at an elevation of ~45 m (~4.5X the relief). Note that gentler topography (B) commonly 
requires a search lattice that extends higher (relative to the topographic relief) to encompass nodes for the global minimum F. 
Details of the embankment examples are described in sections 6.2.1 and 6.3.1. Images created using VisIt software. 
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When performing an initial analysis, the user can instruct Scoops3D to provide two optional files for 

examining whether the search lattice is too restrictive. One of the search quality files (created when isqout = 1) is 

a raster grid highlighting any DEM cells that have a critical surface generated from a lattice node on the boundary 

of the search lattice (<filein>_boundcheck_out.asc). This file can be viewed in grid visualization software or a 

GIS. Ideally, all critical surfaces in areas of interest should be unrestricted by the extent of the search lattice 

(values in the boundary check file should equal 0). Non-zero values indicate which side of the lattice potentially 

restricted the search (table 4.7). Examples related to vertical boundary restrictions are shown in figure 5.8. If the 

search is restricted, then the user should expand the appropriate sides of the lattice for a more thorough search. 

The increased lattice extent will require additional computational effort and memory, but may be necessary for a 

thorough analysis. Note that cells near the edge of the DEM (in the buffer area) are not fully analyzed even when 

restrictions to the search lattice are eliminated. If the buffer area is important, then the extent of the DEM should 

be expanded. 

Another output option (icritlattice) triggers the creation of a 3D search-lattice file 

(<filein>_critfoslattice_out.3D) highlighting the critical surfaces (section 4.5.3.4.1). Examining this file using 3D 

visualization software allows the user to determine whether any critical nodes in the lattice are on or near a lattice 

boundary. Critical nodes on a lattice boundary suggest that the user needs to expand the search lattice on that 

boundary. Ideally, all critical nodes for areas of interest in the DEM should have a few nodes not associated with 

a critical surface between them and the boundaries of the search lattice. If there are excessive null values near the 

lattice boundaries, the user may be able to trim the search lattice on those boundaries. 

 
Figure 5.8. Images illustrating restrictions on the vertical extent of the search lattice for three different Scoops3D analyses. 
Examples are modifications of the Mount St. Helens example R (input file name: R_sthel.scp); see section 7.6. Left-side 
diagrams portray 3D critical search-lattice data (<filein>_critfoslattice_out.3D) above a perspective view of the DEM and right-
side diagrams portray grid data from the search-lattice boundary check files (<filein>_boundcheck_out.asc) with 100 m 
contour lines. Boundary check values are assigned when critical surfaces are on the edge of the search lattice. A, Case 
where minimum elevation of the search lattice is too high (zsmin is too large), as reflected in boundcheck_out values of 1 for 
important areas of the DEM. B, Case where maximum elevation of the search lattice is too low (zsmax is too small), as 
reflected in boundcheck_out values of 9 for important areas of the DEM. C, Case where there are no search lattice boundary 
restrictions for important areas of the DEM (unmodified example R_sthel.scp). Note that some areas near the boundary of the 
DEM, deemed unimportant, may be restricted. Perspective images of critfoslattice files created using VisIt software and maps 
of boundcheck files created using Esri ArcMap software. 
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5.3.6. Search Resolution 

Search resolution is a major factor that controls the thoroughness of a Scoops3D search. We define search 

resolution to include the horizontal and vertical search-lattice node spacing, the radius increment for creating a 

sequence of spherical trial surfaces at a given node, and the number of potential slip directions analyzed for each 

trial surface. Ideally, adequate values for these parameters allow the creation of thousands or millions of trial 

surfaces encompassing all parts of the DEM. This, in turn, permits a thorough search for the minimum F at each 

DEM cell. With a higher resolution search (closely spaced lattice nodes, small radius increments, and multiple 

slip directions), Scoops3D will generate more tightly spaced trial surfaces and thus increase the chances of 

finding the trial surface with the minimum factor-of-safety for each DEM cell. 

Increased search resolution increases computational effort and memory requirements. Thus, the user may 

want to adjust the resolution to provide results that are acceptable for a given project; for example, a preliminary, 

quick analysis may need only a coarse-resolution search whereas a more precise analysis may need a high-

resolution search. Volumes associated with the critical potential failure masses may vary considerably when 

comparing results from high-resolution and low-resolution searches. For many searches, trial surfaces with 

similar factors of safety can lead to a large range in volumes (Reid and others, 2000). The user may need a high-

resolution search to create map results with smoothly varying volumes or areas. 

We have found that for our study cases, the coarse-to-fine search option (3.2.2) provides an adequate 

search; this option greatly reduces runtime and it is the default option in Scoops3D-i. The user will likely select 

this option for most analyses, except perhaps for cases in which memory limitations are more critical than 

computer runtime. For cases with very intricate topography and (or) strengths or pore pressures that vary greatly, 

the simple search option may be warranted to provide a thorough search. With both search options, search 

resolution involves four parameters: (1) the horizontal multiplier, (2) the vertical spacing, (3) the increment in the 

spherical radius, and (4) the number of slip directions analyzed for each trial surface. With the coarse-to-fine 

search option, the horizontal and vertical resolutions are for the fine lattice; the resolution of the coarse starting 

lattice is a multiple of the fine spacing. All these options can be adjusted from the Scoops3D-i Search 

Configuration window and are fully described in section 4.4.1.1.9.1. With the coarse-to-fine search, the coarse-

to-fine multiplier (multres) will also affect runtime, but the optimal value is specific to the individual analysis. 

We found that a value of multres = 8 worked well for the study cases presented in chapters 6 and 7. If runtime 

optimization is desired, we recommend that the user compare runs, using a small, representative portion of the 

search lattice, with varied coarse-to-fine multipliers including values somewhat smaller (for example, 2 or 4) and 

larger (for example, 12 or 16) than the recommended values of 6 or 8 (section 3.2.2). 
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If computational speed and memory requirements are not a limitation, the user could, for example, define 

a high-resolution lattice, using a horizontal multiplier equal to 1 and vertical spacing equal to the DEM cell size, 

with a radius increment equal to half the cell size. With this high-resolution search, Scoops3D will likely find 

values near the ultimate minima, provided that the DEM resolution is appropriate for the size range of the trial 

failures (section 5.3.4). 

If excessive runtime is an issue (as it may be with large, detailed analyses), then the user will need to 

reduce the lattice resolution even though this reduction may somewhat decrease the chances of finding the 

ultimate minima for each DEM cell. In this case, we suggest that the user start by using a relatively sparse 

spacing for the fine lattice (perhaps a horizontal multiplier of 4 and vertical spacing equal to 4 times the DEM cell 

size). By systematically performing Scoops3D analyses using progressively finer lattice resolutions, the user can 

compare factor-of-safety and size results with those from a high-resolution lattice and select a lattice resolution 

appropriate for the project (fig. 5.9). In addition, if the user wants more vertical resolution and is concerned about 

computational speed, we suggest decreasing the radius increment rather than increasing the vertical resolution. 

For each additional node in the search lattice, Scoops3D must first identify a potential failure mass near the 

minimum size criteria, which takes more computational effort than creating a potential failure mass in the 

appropriate size range with a new radius. 

Examples of a trial-and-error approach with relatively low-, intermediate-, and high-resolution searches 

lattices are shown in figure 5.9. At first glance, the low-resolution results (fig. 5.9F and G; Fmin =1.18) may seem 

adequate; however, the global minimum identified for the low-resolution search is 10 percent higher (fig. 5.9H) 

than the minimum for the high-resolution search (fig. 5.9A and B; Fmin =1.07). Both the factor-of-safety and 

volume maps for the low-resolution search (fig. 5.9F and G) have irregular and splotchy transitions between the 

color bands; this is an indication of a lower quality search. 

Although overall patterns of stability can be readily obtained with low-resolution searches, the poor 

quality of the search may lead to poor estimates of factor of safety and volume for specific potential failures. 

When a high-resolution search is not practical, a good compromise is an intermediate-resolution search  

(fig. 5.9C and D). When even the intermediate-resolution search requires excessive computer runtime, a low-

resolution search can be used to compare scenarios (for example, different strengths or water conditions). The 

user can then refine the DEM resolution and search lattice extent as needed and perform a complete analysis with 

the intermediate-resolution search. The optimal search resolution to choose will depend on the user’s needs and 

may take some trial and error to obtain. 
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Figure 5.9. Maps showing factor-of-safety and volume results from three Scoops3D analyses with three different search 
resolutions. Examples use variations of Seattle example Q (input file name: Q_seawet.scp); see section 7.5. Factors of safety 
from <filein>_fos3d_out.asc files and volumes from <filein>_fosvol_out.asc files. A, Factors of safety with high-resolution 
search, Fmin = 1.07, VFmin = 3048 m3. B, Critical volumes with high-resolution search. C, Factors of safety with intermediate-
resolution search, Fmin = 1.09, VFmin = 3239 m3. D, Critical volumes with intermediate-resolution search. E, Percent difference in 
factors of safety for intermediate-resolution compared with high-resolution results. F, Factors of safety with low-resolution 
search, Fmin = 1.18, VFmin = 3238 m3. G, Critical volumes with low-resolution search. H, Percent difference in factors of safety, 
F, for low-resolution compared with high-resolution results. VFmin is critical volume. Percent difference in F is defined as (100* 
(F-Fhighres)/Fhighres). High-resolution search uses the parameters: horizontal multiplier, nsrchres = 1; vertical resolution, 
zsrchres = 10 ft; dr = 10 ft. Intermediate-resolution search uses the parameters: horizontal multiplier, nsrchres = 2; vertical 
resolution, zsrchres = 20 ft; dr = 10 ft. Low-resolution search uses the parameters: horizontal multiplier, nsrchres = 5; 
vertical resolution, zsrchres = 50 ft; dr = 10 ft. Details of the number of search-lattice nodes, number of trial surfaces, and 
computer runtime for the three search resolutions are shown in figure 5.1A. Maps created using Esri ArcMap software. 

 
One additional component of search resolution is the number of slip directions analyzed for each trial 

surface. Scoops3D always analyzes trial surfaces with potential slip in the azimuthal direction of the overall fall 

direction. It is possible, however, that other slip directions may result in a minimum F for a given trial surface, 

especially in domains with complex topography and (or) spatially variable material properties and pore pressure 

conditions. The user can select options to analyze other slip directions as well (section 4.4.1.1.9.1) and compare 

the results with those from the overall fall direction analyses. Selecting other slip directions will slightly increase 

computer runtime but will not affect memory requirements. 

5.3.7. Poor Solutions 

Bishop’s simplified method can sometimes converge to incorrect factor-of-safety values. Typically this 

occurs in only a few cases, particularly those in which the trial surface intersects the ground surface at a steep 

angle or where very high pore-fluid pressures act on the slip surface. For most problems, Bishop’s simplified 

method will provide correct values. The method used in Scoops3D for computing an initial value of F helps 

prevent incorrect convergence (section 2.3.2). In some instances, however, the method will fail to converge to a 

solution and Scoops3D ignores these. In very rare situations, the method will converge but calculate a factor of 

safety that is too low, and these spurious low values end up being retained in the results from Scoops3D. 
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The user can detect these spurious values in two ways. (1) The factor-of-safety results from Bishop’s 

simplified method can be compared with those from the Ordinary (Fellenius) method for the same critical 

surfaces (results from both are output when Bishop’s simplified method is selected). When Bishop’s method is 

functioning adequately, the solutions will be somewhat similar to each other (typically within ~50 percent). Note 

that the Ordinary method will always provide a solution to a given trial surface – the method is not subject to 

convergence issues. (2) The factor-of-safety results (in map view) from Bishop’s simplified method can be 

examined for very localized low factors of safety. Spurious F values are commonly surrounded by much larger 

values; an example is shown in figure 5.10A. 

Spuriously low factor-of-safety values typically occur when values of mα (as defined in section 2.3.2)  

are close to zero. Thus, mα can be used as a filter to remove poor Bishop’s simplified values from the factor-of-

safety results produced by Scoops3D. The absminma parameter in the Scoops3D main input parameter file  

(see section 4.4.1.1.8; Scoops3D-i option under Options/Advanced Parameters) controls this filter. Any  

trial surfaces with an absolute value of mα less than absminma will be ignored in the search performed by 

Scoops3D. Typically, other valid trial surfaces will “fill in” any gaps in the analysis left by filtering these surfaces 

(fig. 5.10B). 

 
Figure 5.10. Maps showing results with spuriously low factors of safety and results with filtering. A, Areas with local spuriously 
low factors of safety obtained using Bishop’s simplified method of analysis. B, Same areas after spurious values have been 
discarded using the mα filter (absminma = 0.05 in this case). DEM and strength values are from Seattle example Q (input file 
name: Q_seawet.scp) as described in section 7.5, with the addition of high pore-water pressures from scenario 3 of Brien and 
Reid (2007). Contour interval is 10 m. Maps created using Esri ArcMap software. 
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Selecting an appropriate mα value for filtering, however, can entail some trial-and-error analysis. Setting 

this filter to a large value could unnecessarily exclude valid trial surfaces whereas setting it to a low value might 

allow poor results to be retained. Other researchers have set constant controls on mα ranging from 0.001 to 

0.00001 (for example Krahn, 2004; O. Hungr Geotechnical Research Inc., 2010). We have analyzed some 

problems in which a mα filter of 0.05 eliminates clearly poor solutions without otherwise affecting the solution of  

critical surfaces. Scoops3D provides two output files that can be used to help assess the effects of a mα filter. The 

filtered surfaces file (<filein>_filter_out.txt) lists all trial surfaces that either failed to converge or that were 

filtered (section 4.5.2.3). The filtered surfaces location file (<filein>_filtergrid_out.asc) is a raster grid showing 

the number of times surfaces were filtered or failed to converge at each DEM cell (section 4.5.2.4). An example 

map created from this file is shown in figure 5.11. The user can examine this file to determine whether excessive 

trial surfaces were filtered from areas of interest in the DEM. 

 

 
Figure 5.11. Map showing an example of number of filtered surfaces locations. Data contained in the 
<filein>_filtergrid_out.asc output file. Filtered surfaces either did not converge using Bishop’s simplified method or were 
eliminated by the mα filter. DEM and strength values are from Seattle example Q (input file name: Q_seawet.scp) described in 
section 7.5, with the addition of high pore pressures from scenario 3 of Brien and Reid (2007) (see also fig. 5.10). Contour 
interval is 10 m. Map created using Esri ArcMap software.  
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Chapter 6. Testing and Verification of Scoops3D 
In this chapter, we present the results of verification tests using Scoops3D. Computer code verification is 

a demonstration of the ability of the software code to solve its governing equations correctly (Konikow and 

Bredehoeft, 1992) or essentially to evaluate whether the model performs as intended (Post and Votta, 2005). Our 

verification of Scoops3D includes comparison of the computed factor of safety, F, and volume for a given trial 

surface, and (or) the overall global critical surface with minimum F, with results from published 3D analytical 

solutions and other 2D and 3D slope-stability programs. When possible, we compare 3D solutions for both the 

Ordinary (Fellenius) and Bishop’s simplified methods. Our testing consists of: 

• Comparison with exact 3D analytical solutions for simple spherical trial surfaces with cohesion only. 

• Comparison with 3D analytical solutions for log-spiral potential slip surfaces. 

• Benchmark comparisons for 3D Bishop’s simplified method with results from CLARA-W, a 3D 

slope stability program (O. Hungr Geotechnical Research Inc., 2010) for homogeneous, non-

homogeneous, and piezometric surface scenarios. CLARA-W comparisons include examples taken 

from 3D analytical solutions and 3D extensions of commonly used 2D benchmark cases (for 

example, Arai and Tagyo, 1985; Donald and Giam, 1995). 

• Benchmark comparisons of 2D examples using Scoops3D and CLARA-W, as well as other published 

results (Rocscience Inc., 2010; Feng and Fredlund, 2012). 

• Demonstration of the equivalence of results computed using either raster grids or full 3D material 

property and pressure-head files. 

• Assessment of the minimum number of active columns required for accurate estimation of potential 

failure volume and factor of safety. 

• Symmetry tests to demonstrate the ability of Scoops3D to compute factors of safety for potential 

failure masses with slip directions not aligned with the DEM coordinate axes. 

• Assessment of Scoops3D’s ability to incorporate the effects of unsaturated suction stresses. 

We evaluated differences in factor of safety, F, and potential failure volume, V, computed with Scoops3D 

against other solutions for a given benchmark example using: 

 % 100SCOOPS Benchmark

Benchmark

F Fdifference F
F

 −
=  
 

, and (6.1) 

 % 100SCOOPS Benchmark

Benchmark

V Vdifference V
V

 −
=  
 

, (6.2) 
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where 

 FSCOOPS  is the factor of safety computed by Scoops3D, 

 FBenchmark  is the factor of safety computed by other slope-stability software or analytical solutions, 

 VSCOOPS  is the volume computed by Scoops3D, and 

 VBenchmark  is the volume computed by other slope-stability software or analytical solutions. 

 

Although it is difficult to evaluate all possible combinations of options available in Scoops3D, we chose a 

wide variety of verification examples, including analysis of the stability of homogeneous straight and curved 

slopes, layered slopes, and slopes subjected to earthquake loading and pore-water pressures. Table 6.1 

summarizes our examples and comparison methods. We provide input and output files for selected verification 

examples in the Scoops3D examples folder, as discussed in chapter 7. 

 

Table 6.1. Summary of verification examples, limit-equilibrium methods, parameters tested, and references for comparison 
solutions. 
 
[‘O’ indicates Ordinary (Fellenius) method, ‘B’ indicates Bishop’s simplified method, c is material cohesion, φ is material 
angle of internal friction, ru is pore-pressure ratio, and eq is horizontal pseudo-acceleration coefficient from earthquake 
loading] 
 

Sections Description  Method 
Material  
strength 
(c andφ) 

 Additional 
parameters Reference 

Scoops3D comparison with 

Analytical 
3D 

CLARA-
W 3D 

CLARA-
W 2D 

Published 
2D 

6.1, 
6.3.1 

Uniform slope O, B Homogeneous, 
c only 

 Gens and others  
(1988) 

x x x  

6.2.1,  
6.3.1,  
6.4.1  

Homogeneous 
embankment 

O, B Homogeneous, 
c and φ 

 Leshchinsky and 
others (1985) 

x x x  

6.4.1 Wet homogeneous 
embankment 

B Homogeneous, 
c and φ 

ru    x  

6.2.2,  
6.3.1 

Homogeneous 
cones 

O, B Homogeneous, 
c and φ 

 Baker and 
Leshchinsky 
(1987) 

x x x  

6.2.3,  
6.3.1 

Wet homogeneous 
cones 

O, B Homogeneous, 
c and φ 

ru Leshchinsky and 
Mullet (1987) 

x x x  

6.3.2,  
6.4.1,  
6.4.2 

Embankment B Homogeneous and  
non-homogeneous 

eq 3D extension of 
Donald and Giam 
1995) 

 x x x 

6.3.3,  
6.4.1,  
6.4.2 

Embankment B Homogeneous and 
non-homogeneous 

Piezometric 
surface 

3D extension of 
Arai and Tagyo 
1985)  

 x x x 
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6.1. Comparison with Exact 3D Analytical Solutions 

There are many published examples with analytical solutions for slope stability, but very few examples 

for a 3D spherical trial surface. We chose an example for a uniform slope with a purely cohesive, homogeneous, 

isotropic soil (Gens and others, 1988) that was also used by Hungr and others (1989) to verify the CLARA-W 

software. We compared Scoops3D results with the 3D analytical solution for a spherical slip surface on a 2:1 

straight slope (26.6°) (fig. 6.1) with the following parameters, where the solution for F is not dependent on a 

particular system of units: 

R = 1   is the radius of the sphere (L), 

z = 0.5   is the perpendicular distance from center of sphere to ground surface (L), 

c = 0.1   is cohesion (ML-1T-2), 

γ = 1.0   is unit weight (ML-2T-2), and 

ϕ = 0.0  is angle of internal friction. 

 

 
Figure 6.1. Schematic diagram showing 2D cross section through the slope and trial surface used in the purely cohesive 
example. Example analyzed is a 3D version of a 2:1 (26.6°) straight, uniform slope. 

The 3D analytical solution for factor of safety is F = 1.402 (Hungr and others, 1989; Michalowski and 

Drescher, 2009). The slip surface volume can be computed using the volume equation for a spherical cap, 

yielding a value of 0.654 cubic length units. Note that this trial surface is not the critical surface for the slope; we 

use this for consistency with other publications. 

The factors of safety, F, computed using both the Ordinary and Bishop’s simplified methods in Scoops3D 

are within 0.14 percent of the 3D analytical solution (table 6.2). Scoops3D estimates a volume of 0.655 cubic 

length units; this is 0.15 percent greater than the volume of a comparable spherical cap. 
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Table 6.2. Comparison of computed 3D factor of safety, F, from Scoops3D with the 3D analytical solution for the purely 
cohesive example.  
 
[The Scoops3D potential failure mass contains 150,292 columns] 
 

Analytical solution Scoops3D Percent difference from  
analytical solution 

3D F F_Bishop F_Ordinary F_Bishop F_Ordinary 
1.402 1.400 1.400 -0.14 -0.14 

 

  

6.2. Comparison with 3D Analytical Solutions for Log-Spiral Slip Surfaces 

To our knowledge, there are no published 3D analytical solutions for spherical trial surfaces with soils 

having both cohesive and frictional strength. There are, however, some 3D analytical chart solutions that use 

variational principles to obtain minimum F values for log-spiral shaped potential slip surfaces in generic cones 

(Baker and Leshchinsky, 1987; Leshchinsky and Mullett, 1987) and embankments (Leshchinsky and others, 

1985). We compared results from Scoops3D with these 3D analytical solutions. Because the slip surfaces are 

logarithmic spirals rather than spheres, we do not expect Scoops3D to perfectly match the analytical solutions. 

Nevertheless, the analytical solutions cover a wide range of slope angles and strength values and are useful for 

assessing whether Scoops3D provides reasonable results in a variety of circumstances. We compared dry, 

homogeneous embankment examples and homogeneous cone examples under both dry and wet conditions, 

specified by the pore-pressure ratio, ru. 

For comparison with the 3D analytical solutions, we performed extensive searches using Scoops3D to 

identify the potential failure masses with the global minimum F computed with both the Ordinary and Bishop’s 

simplified methods. For dry cones, we also compared the volume of the potential failure mass having the global 

minimum F identified by Scoops3D with the volume of the log-spiral surface related to the 3D analytical 

solution. Analytical solutions for the volume of the global minimum F with wet cones were not available for 

comparison. 
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6.2.1. Homogeneous, Dry Embankments with 3D Analytical Solutions for Log-Spiral Slip Surfaces 

We compared Scoops3D results with Leshchinsky and others (1985) 3D analytical solutions for log-spiral 

shaped potential slip surfaces in dry embankments with 30° and 60° slopes and a range of c and φ values  

(table 6.3). We used embankments with a height, H, of 10 m and material properties that covered a wide range of 

ratios of cohesive to frictional strengths (table 6.3), as characterized by the dimensionless ratio λ, (equation 5.1) 

Table 6.4 compares Scoops3D results with the 3D analytical solutions for dry embankments. In all cases, 

factors of safety calculated by Scoops3D for both the Ordinary and Bishop’s simplified methods are lower than 

the analytical solutions due to differences in the shape of the trial surfaces; however, all of the analytical solutions 

are within ~9 percent of Scoops3D Bishop’s method results and within ~11 percent of the Ordinary method 

results. In section 6.3.1, we compare 3D results from Scoops3D and the CLARA-W software using spherical trial 

surfaces for these same 30º and 60º dry embankments. 

 

Table 6.3. List of material properties and calculated λ values for the dry embankment comparison tests.  
 
[The embankment has height, H = 10 m. Parameters for materials: c is cohesion, φ is angle of internal friction, and γt is total 
unit weight. º, degree; kN, kilonewton; kPa, kilopascal; m, meter] 

 
λ γt (kN/m3) φ (°) c (kPa) 

1.00 20 30 116. 

0.125 19 20 8.64 

0.025 17 10 0.75 
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Table 6.4. Comparison of Scoops3D factor-of-safety results with 3D analytical chart solutions for dry embankments, given different values of λ.  
 
[Analytical solutions are from Leshchinsky and others (1985) charts for log-spiral slip surfaces. Solutions in Scoops3D are for the spherical trial surface with the 
global minimum F using either Bishop’s simplified method or the Ordinary method. Note that the critical potential failure masses (global minimum) are slightly 
different for the Ordinary and Bishop’s simplified methods, thus the volumes differ] 
 
[º, degree; m, meter] 

 

λ 
 

Slope 
(°) 

Chart solution Scoops3D Scoops3D Percent difference from 
chart solution (Leshchinsky and 

others, 1985) 
Global minimum using 

Bishop's method 
Global minimum using 

Ordinary method 
3D F F_Bishop Volume (m3) F_Ordinary Volume (m3) F_Bishop F_Ordinary 

1.00 60 5.19 4.72 582 4.88 729 -9.0 -6.1 

0.125 60 0.80 0.75 326 0.75 341 -6.4 -6.7 

0.025 60 0.20 0.19 163 0.19 152 -3.7 -6.6 

1.00 30 6.83 6.38 4,489 6.14 5,407 -6.6 -10.1 

0.125 30 1.41 1.32 1,157 1.26 1,286 -6.4 -10.8 

0.025 30 0.42 0.41 522 0.40 555 -1.3 -4.5 
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6.2.2. Homogeneous, Dry Cones with 3D Analytical Solutions for Log-Spiral Slip Surfaces 

We also compared Scoops3D results with Baker and Leshchinsky’s (1987) 3D analytical solution for 

logarithmic spiral potential slip surfaces in dry cones with a height, H = 1000 m, three different slope angles, and 

a range of c and ϕ values. The material properties cover a wide range of λ values (table 6.5). We compared 

Scoops3D factor of safety and volume of the global minimum spherical trial surface for each combination of 

slope angle and λ to the 3D analytical solution for logarithmic spiral slip surfaces with dry conditions (table 6.6). 

Input files for the 30° cone example are provided in the Scoops3D examples folder (Scoops3D examples K 

through O, section 7.4). 

Scoops3D solutions for the factor of safety, F, using Bishop’s simplified method are within ~1 to 2 

percent of Baker and Leshchinsky’s (1987) solutions (table 6.6), with the largest difference correlating with the 

largest discrepancy in volume. The Ordinary solution underestimates F in all cases, typically by a few percent but 

by as much as ~6 percent in one case. Computed volumes for the Scoops3D spherical trial surface with the global 

minimum F are typically within 9 percent of the volumes for Baker and Leshchinsky’s log spiral slip surfaces, but 

differences are as large as ~28 percent for a 30° slope with low λ. Large differences in volume can arise from the 

shape differences between the Scoops3D spherical surfaces and the analytical solution logarithmic spirals; thus 

some difference in results should be expected. 

Table 6.5. List of material properties and calculated λ values used in the dry cone comparison tests. 
 
[The cones have height, H = 1000 m. Parameters for materials: c is cohesion, φ is angle of internal friction, and  γt  is total 
unit weight. º, degree; kN, kilonewton; kPa, kilopascal; m, meter] 

 
λ γt ( (kN/m3) φ (°) c (kPa) 

1.00 21 40 17,630 

0.125 20 30 1,444 

0.0625 19 25 553.8 

0.025 19 20 172.9 
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Table 6.6. Comparison of Scoops3D factor-of-safety and volume results with 3D analytical chart solutions for dry, homogeneous cones, given different values of λ. 
 
[Analytical solutions are from Baker and Leshchinsky’s (1987) charts for log-spiral slip surfaces. Scoops3D solutions are for a spherical trial surface with the 
global minimum factor of safety (F) using either Bishop’s simplified method or the Ordinary method. Note that the critical potential failure masses (global 
minimum) are slightly different for the Ordinary and Bishop’s simplified methods, thus the volumes (V) may differ. º, degree; m, meter] 

 

λ Slope (°) 
Chart solution 

(Baker and Leshchinsky, 1985) 
Scoops3D 

Global minimum using Bishop's 
method 

Scoops3D 
Global minimum using Ordinary 

method 
Percent difference from 

chart solution 

3D F Volume (m3) F_Bishop Volume (m3) F_Ordinary Volume (m3) F_Bishop F_Ordinary V_Bishop 

1.00 70 7.596 6.6728×107 7.595 6.5951×107 7.590 6.5951×107 -0.01 -0.08 -1.16 

0.125 70 1.155 4.4670×107 1.156 4.4615×107 1.144 4.5547×107 0.09 -0.95 -0.12 

0.0625 70 0.651 3.5098×107 0.651 3.4986×107 0.639 3.5968×107 0.00 -1.84 -0.32 

1.00 50 9.326 2.4774×108 9.231 2.5601×108 9.155 2.6215×108 -1.02 -1.83 3.34 

0.125 50 1.564 1.4525×108 1.567 1.4584×108 1.516 1.5030×108 0.19 -3.07 0.40 

0.025 50 0.533 7.0783×107 0.536 6.4447×107 0.516 7.4994×107 0.56 -3.19 -8.95 

1.00 30 11.259 1.1561×109 11.200 1.3002×109 10.864 1.4034×109 -0.52 -3.50 12.47 

0.125 30 2.329 5.1208×108 2.300 5.4531×108 2.190 6.2039×108 -1.25 -5.97 6.49 

0.025 30 0.889 1.9478×108 0.907 2.5012×108 0.878 2.8446×108 2.02 -1.24 28.41 
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6.2.3. Homogeneous, Wet Cones with 3D Analytical Solutions for Log-Spiral Slip Surfaces 

We added pore-pressure effects to the cone examples presented in the previous section and compared 

Scoops3D results with Leshchinsky and Mullett’s (1987) 3D analytical solution for wet cones. Again, the 

analytical solutions are for potential slip surfaces with the shape of logarithmic spirals. We used the same cone 

specifications and λ values shown in table 6.5. Pore-pressure effects were specified by the pore-pressure ratio, ru. 

We compared results from each combination of slope angle and λ value for two pore-pressure ratios: ru = 0.1 and 

ru = 0.4 (a relatively high value) in table 6.7. 

Scoops3D solutions for factor of safety, F, using Bishop’s simplified method are all within ~2 percent of 

the 3D analytical chart solutions (table 6.7). For steeper cones and (or) high pore pressures, the Ordinary method 

overestimates F by as much as 9 percent. Again, some differences should be expected, as the shape differs 

between log-spiral slip and spherical trial surfaces. 
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Table 6.7. Comparison of Scoops3D factor-of-safety and volume results with 3D analytical chart solutions for wet, homogeneous cones, given different values of 
λ. 
 
[Analytical solutions are from Leshchinsky and Mullett’s (1987) charts for log-spiral slip surfaces. Scoops3D solutions are for the spherical trial surface with the 
global minimum F using either Bishop’s simplified method or the Ordinary method. Note that the critical potential failure masses (global minimum) are slightly 
different for the Ordinary and Bishop’s simplified methods, thus the volumes may differ slightly. The parameter ru is pore-pressure ratio. º, degree; m, meter] 

λ ru Slope 
(°) 

Chart solution Scoops3D Scoops3D 
Percent difference from 

chart solution 
(Leshchinsky 
and Mullett, 

1987) 
Global minimum using 

Bishop's method 
Global minimum using 

Ordinary method 

3D F F_Bishop Volume (m3) F_Ordinary Volume (m3) F_Bishop F_Ordinary 
1.00 0.1 70 7.390 7.416 6.5951×107 7.411 6.5951×107 0.35 0.28 

1.00 0.4 70 6.888 6.875 6.5825×107 6.890 6.6593×107 -0.19 0.03 

0.125 0.1 70 1.036 1.032 4.3538×107 1.019 4.5115×107 -0.39 -1.64 

0.125 0.4 70 0.669 0.652 4.0575×107 0.711 4.8483×107 -2.54 6.28 

0.0625 0.1 70 0.550 0.551 3.2612×107 0.533 3.5968×107 0.18 -3.09 

0.0625 0.4 70 
 

Most surfaces did not converge 0.308 4.0171×107 --- --- 

1.00 0.1 50 8.996 9.014 2.5601×108 8.936 2.6883×108 0.20 -0.67 

1.00 0.4 50 8.334 8.352 2.6928×108 8.308 2.7467×108 0.22 -0.31 

0.125 0.1 50 1.435 1.439 1.4584×108 1.382 1.6000×108 0.28 -3.69 

0.125 0.4 50 1.064 1.053 1.5448×108 1.021 1.7642×108 -1.03 -4.04 

0.025 0.1 50 0.462 0.461 6.8255×107 0.436 7.8454×107 -0.22 -5.63 

0.025 0.4 50 0.243 0.238 6.7243×107 0.231 8.5218×107 -2.06 -4.94 

1.00 0.1 30 10.913 10.886 1.3468×109 10.536 1.4510×109 -0.25 -3.45 

1.00 0.4 30 10.049 9.914 1.4595×109 9.564 1.6831×109 -1.34 -4.83 

0.125 0.1 30 2.134 2.133 5.7374×108 2.013 6.5433×108 -0.05 -5.67 

0.125 0.4 30 1.644 1.626 6.6610×108 1.480 8.2440×108 -1.09 -9.98 

0.025 0.1 30 0.812 0.815 2.5012×108 0.782 3.0526×108 0.37 -3.69 

0.025 0.4 30 0.536 0.536 2.9151×108 0.488 3.9167×108 0.00 -8.96 
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6.3. Comparison with CLARA-W 3D Benchmark Solutions 

We benchmarked solutions from Scoops3D against those from CLARA-W, a 2D and 3D slope-stability 

program (O. Hungr Geotechnical Research Inc., 2010) that is capable of using spherical trial surfaces that exactly 

match Scoops3D trial surfaces. CLARA-W does not have an option for the Ordinary method; therefore, we 

compared 3D solutions using only Bishop’s simplified method. In our comparisons, we first performed an 

extensive search in Scoops3D to identify the trial surface with the global minimum F using Bishop’s simplified 

method. We then used the rotational center and radius of that global minimum trial surface to define the same 

spherical trial surface in CLARA-W. Note that CLARA-W permits slip rotation in only one direction, which must 

be aligned with the DEM grid axes; therefore, we aligned the grids appropriately for the comparisons. We 

compared the factor of safety and volume for identical surfaces computed by each program. 

We compared Scoops3D and CLARA-W results for a variety of cases, including the 3D analytical 

examples of homogeneous embankments and cones described in section 6.2. We supplemented these examples 

with an additional, more gently sloping, 10° embankment, an example that does not have a chart solution in 

Baker and Leshchinsky (1987). To test additional features of Scoops3D, we examined embankment examples 

commonly used for verification of 2D factor of safety calculations (Arai and Tagyo, 1985; Donald and Giam, 

1995; Rocscience Inc., 2010; Feng and Fredlund, 2012) that we extended into 3D for comparison with CLARA-

W results. These additional tests assessed the effects of earthquake loading, non-homogeneous material properties 

defined by layers, and a piezometric surface describing the subsurface pore-pressure distribution. 

6.3.1. Homogeneous Slopes Analogous to 3D Analytical Solutions 

Using the examples described in section 6.2, we compared the volumes and 3D factors of safety 

computed by Bishop’s simplified method in Scoops3D with results from CLARA-W for homogeneous slopes, 

including a uniform slope with dry, purely cohesive soil, dry embankments, and dry and wet cones (table 6.8). 

For each case, both programs used identical spherical trial surfaces. Because CLARA-W provides F results to 

only two decimal places, we use this precision to calculate the differences. The 3D results on identical trial 

surfaces using the two software packages, Scoops3D and CLARA-W, provide factors of safety and volumes that 

differ by at most ~1 percent for all of our test cases; most examples have a discrepancy of 0.01 percent or less 

(table 6.8).
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Table 6.8. Comparison of Scoops3D and CLARA-W results for homogeneous uniform slopes, embankments, and cones, given different values of λ. 
 
[Bishop’s 3D factors of safety (F) and volumes (V) are for the global minimum spherical trial surface identified by Scoops3D. Factors of safety for the more 
rigorous Spencer method, computed by CLARA-W, are also shown. The designation “No conv.” means the solution for F did not converge in this case; the 
parameter ru is pore-pressure ratio. º, degree; m, meter; λ, lambda] 

 

λ ru Slope 
(°) 

Scoops3D CLARA-W 3D Comparison with CLARA-W 

F_Bishop Volume (m3) F_Bishop F_Spencer Volume (m3) Percent 
difference F 

Percent 
difference V 

Straight, uniform slope 
 

  
  

  
  

∞ 0 26.6 1.40 0.655 1.40 No conv. 0.65 0.0 0.77 

Homogeneous embankments 

1.00 0 60 4.73 547.3 4.72 No conv. 547.2 0.2 0.03 

0.125 0 60 0.75 335.3 0.75 0.76 334.6 0.0 0.20 

0.025 0 60 0.19 153.3 0.19 No conv. 153.4 0.0 -0.06 

1.00 0 30 6.38 4,576 6.38 6.38 4578 0.0 -0.05 

0.125 0 30 1.32 1,124 1.32 1.32 1123 0.0 0.05 

0.025 0 30 0.41 526.9 0.41 0.41 528.6 0.0 -0.33 

1.00 0 10 10.07 5.69639×104 10.07 10.07 5.68980×104 0.0 0.12 

0.125 0 10 3.01 1.65894×104 3.01 No conv. 1.65960×104 0.0 -0.04 

0.025 0 10 1.15 7953 1.15 1.15 7949 0.0 0.04 

Homogeneous cones 
1.00 0 70 7.60 6.59505×107 7.59 No conv. 6.59503×107 0.1 0.00 

0.125 0 70 1.16 4.46153×107 1.15 No conv. 4.46134×107 0.9 0.00 

0.0625 0 70 0.65 3.47357×107 0.65 0.65 3.47328×107 0.0 0.01 

1.00 0.1 70 7.42 6.59505×107 7.41 No conv. 6.59503×107 0.1 0.00 

0.125 0.1 70 1.03 4.35381×107 1.03 No conv. 4.35403×107 0.0 -0.01 

0.0625 0.1 70 0.55 3.46348×107 0.55 0.55 3.46343×107 0.0 0.00 
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λ ru Slope 
(°) 

Scoops3D CLARA-W 3D Comparison with CLARA-W 

F_Bishop Volume (m3) F_Bishop F_Spencer Volume (m3) Percent 
difference F 

Percent 
difference V 

Homogeneous cones—Continued 

1.00 0.4 70 6.88 6.58248×107 6.88 No conv. 6.58253×107 0.0 0.00 

0.125 0.4 70 0.68 5.00932×107 0.68 0.67 5.00932×107 0.0 0.00 

1.00 0 50 9.23 2.56006×108 9.22 No conv. 2.56021×108 0.1 -0.01 

0.125 0 50 1.57 1.45837×108 1.57 1.55 1.45849×108 0.0 -0.01 

0.025 0 50 0.54 6.44472×107 0.54 0.53 6.44540×107 0.0 -0.01 

1.00 0.1 50 9.01 2.56006×108 9.00 No conv. 2.56021×108 0.1 -0.01 

0.125 0.1 50 1.44 1.45837×108 1.44 1.43 1.45849×108 0.0 -0.01 

0.025 0.1 50 0.46 6.82550×107 0.46 0.46 6.82627×107 0.0 -0.01 

1.00 0.4 50 8.35 2.69278×108 8.34 No conv. 2.69288×108 0.1 0.00 

0.125 0.4 50 1.05 1.54475×108 1.05 1.03 1.54488×108 0.0 -0.01 

0.025 0.4 50 0.28 1.38057×108 0.28 0.29 1.38066×108 0.0 -0.01 

1.00 0 30 11.20 1.30024×109 11.21 11.19 1.30041×109 -0.1 -0.01 

0.125 0 30 2.30 5.45313×108 2.30 2.29 5.45373×108 0.0 -0.01 

0.025 0 30 0.91 2.50123×108 0.91 0.90 2.50143×108 0.0 -0.01 

1.00 0.1 30 10.89 1.30024×109 10.90 10.88 1.30041×109 -0.1 -0.01 

0.125 0.1 30 2.13 5.73742×108 2.13 2.12 5.73809×108 0.0 -0.01 

0.025 0.1 30 0.82 2.50123×108 0.82 0.81 2.50143×108 0.0 -0.01 

1.00 0.4 30 9.91 1.45968×109 9.93 10.74 1.45985×109 -0.2 -0.01 

0.125 0.4 30 1.63 6.66101×108 1.63 1.62 6.66178×108 0.0 -0.01 

0.025 0.4 30 0.54 2.91509×108 0.54 0.54 2.91562×108 0.0 -0.02 
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6.3.2. Additional Embankment Examples – Homogeneous Properties, Non-Homogeneous Properties, and 
Earthquake Loading 

Donald and Giam (1995) developed a set of example problems that are commonly used for verification of 

2D slope-stability software (Rocscience Inc., 2010; Feng and Fredlund, 2012). We extended these examples to 

represent spherical trial surfaces in 3D embankments, and included cases with earthquake loading and non-

homogeneous material properties defined by layers. We compared Scoops3D and CLARA-W 3D results for each 

example using identical spherical trial surfaces encompassing at least 1,847 active columns. Three cases (Donald 

and Giam’s [1995] examples 1a, 1c, and 1d) are described below and comparison results are shown in table 6.11. 

Input files for these examples are provided in the Scoops3D examples folder (Scoops3D examples F through J, 

section 7.3). Note that in section 6.4, we also use Scoops3D to compute 2D solutions for comparison with the 2D 

solutions of these benchmark tests. 

The first case (1a in Donald and Giam [1995]) consists of a 10 m tall homogeneous embankment with a 

2:1 slope (~26.6°) and the material properties shown in table 6.9. 

Table 6.9. List of material properties and calculated λ value for the 2:1 slope, homogeneous embankment example.  
 
[Embankment has height, H = 10 m. From example 1a in Donald and Giam (1995). Parameters for materials: c is cohesion, φ 
is angle of internal friction, and γt is total unit weight. º, degree; kN, kilonewton; kPa, kilopascal; m, meter] 

 
λ γt (kN/m3) φ (°) c (kPa) 
0.04 20 19.6 3 

 

The second case (1c in Donald and Giam [1995]) has the same ground surface configuration as the simple 

homogeneous embankment, with the addition of three soil layers, each having different material properties  

(fig. 6.2). The material properties are listed in table 6.10 and our 3D extension of the example is shown in  

figure 6.3. 
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Figure 6.2. 2D cross section through the soil layers in the 2:1 slope, non-homogeneous embankment example. The 
embankment has height, H = 10 m. From example 1c in Donald and Giam (1995). 

 

 
Figure 6.3. A 3D perspective view of soil layers in the 2:1 slope, non-homogeneous 3D embankment example.  This 
represents a 3D extension of example 1c in Donald and Giam (1995). 

Our third example (1d in Donald and Giam [1995]) is identical to the layered embankment described 

above (table 6.10 and fig. 6.3) with the addition of earthquake loading, defined as a horizontal seismic pseudo-

acceleration coefficient (eq) of 0.15 oriented in the direction of slip. 

We compare the 3D factors of safety computed using Bishop’s simplified method in Scoops3D and 

CLARA-W for the three Donald and Giam (1995) embankment examples in table 6.11. Because CLARA-W 

provides only two decimal places for factor of safety, we use this precision for computation of the percent 

difference in F. Given this level of precision, there is no difference between the two software packages for these 

three cases (table 6.11). 
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Table 6.10. List of material properties and calculated λ values for the 2:1 slope, non-homogeneous 3D embankment 
example.  
 
[Taken from example 1c in Donald and Giam (1995). Parameters for materials: c is cohesion, φ is angle of internal friction, 
and γt is total unit weight. º, degree; kN, kilonewton; kPa, kilopascal; m, meter]    

Soil 
layer λ γt (kN/m3) φ (°) c (kPa) 

1 0 19.5 38 0 

2 0.06 19.5 23 5.3 

3 0.10 19.5 20 7.2 

 

Table 6.11. Comparison of Scoops3D and CLARA-W results for the 2:1 slope, homogeneous and non-homogeneous 3D 
embankment examples.  
 
[Factors of safety (F) computed using 3D Bishop’s simplified method. Embankments are 3D extensions of Donald and 
Giam’s (1995) examples for a homogeneous embankment (1a), non-homogeneous embankment (1c), and non-homogeneous 
embankment with earthquake loading, eq (1d)] 
 

Donald and 
Giam's (1995) 

example # 
Material 

properties eq Scoops3D 
F 

CLARA-W 
F 

Percent 
difference from 

CLARA-W 
1a Homogeneous 0 1.04 1.04 0.0 

1c Non-homogeneous 0 1.51 1.51 0.0 

1d Non-homogeneous 0.15 1.09 1.09 0.0 

 
 

6.3.3. Additional Embankment Examples - Homogeneous Properties, Non-Homogeneous Properties, and 
Piezometric Surface 

Arai and Tagyo (1985) also developed a set of example problems that are commonly used for verification 

of 2D slope stability software (Rocscience Inc., 2010; Feng and Fredlund, 2012). This set of examples includes 

material properties with higher cohesive strength than the Donald and Giam (1995) embankment configuration 

(section 6.3.2) and the addition of a piezometric surface.  We extended these examples into 3D and used identical 

spherical trial surfaces, containing at least 6454 active columns, to compare Scoops3D and CLARA-W results. 

Input files for these examples are provided in the Scoops3D examples folder (Scoops3D examples A through E, 

section 7.2). Note that in section 6.4, we also compare 2D solutions computed in Scoops3D with the 2D 

benchmark solutions from Arai and Tagyo (1985). 

The first Arai and Tagyo (1985) example (1) consists of a 20 m tall homogeneous embankment with a 3:2 

slope (~33.7°) and the material properties shown in table 6.12. 
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Table 6.12. List of material properties and calculated λ value for the 3:2 slope, homogeneous embankment example.  
 
[The embankment height, H = 20 m. Example 1 in Arai and Tagyo (1985). Parameters for materials: c is cohesion, φ is angle 
of internal friction, and γt  is total unit weight. º, degree; kN, kilonewton; kPa, kilopascal; m, meter] 

 
λ γt (kN/m3) φ (°) c (kPa) 
0.41 18.82 15 41.65 

 
 

The second example (2) has the same configuration as that defined for the simple homogeneous 

embankment example (1), but with the addition of three layers, each having different material properties  

(fig. 6.4). The material properties are shown in table 6.13 and our 3D extension of the example is shown in  

figure 6.5. 

 
Figure 6.4. 2D cross section of soil layers for the 3:2 slope, non-homogeneous embankment example. Embankment height,  
H = 20 m. Example 2 in Arai and Tagyo (1985). 

Table 6.13. List of material properties and calculated λ values for the 3:2 slope, non-homogeneous embankment example.  
 
[Embankment height, H = 20 m. Example 2 in Arai and Tagyo (1985). Parameters for materials: c is cohesion, φ is angle of 
internal friction, γps is partially saturated unit weight, γs is saturated unit weight, and γt is total unit weight. º, degree; kN, 
kilonewton; kPa, kilopascal; m, meter] 

 
Layer λ γt = γps = γs (kN/m3) φ (°) c (kPa) 

1 0.37 18.82 12 29.4 

2 0.30 18.82 5 9.8 

3 0.93 18.82 40 294 
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Figure 6.5. A 3D perspective view of soil layers for the 3:2 slope, non-homogeneous 3D embankment example. Embankment 
height, H = 20 m. This represents a 3D extension of example 2 in Arai and Tagyo (1985). 

Example 3 in Arai and Tagyo (1985) is identical to the homogeneous embankment (example 1) described 

above (table 6.12), but with the addition of a piezometric surface exiting at about the midpoint of the slope  

(fig. 6.6). Our 3D extension of this example is shown in figure 6.7. Pore-water pressure at any depth below the 

piezometric surface was computed using a hydrostatic assumption (section 2.4). 

 
Figure 6.6. A 2D cross section of homogeneous 3:2 embankment example with a piezometric surface. Embankment height, H 
= 20 m. Example 3 in Arai and Tagyo (1985). 
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Figure 6.7. A 3D perspective view of 3:2 slope, homogeneous 3D embankment example with a piezometric surface. 
Embankment height, H = 20 m. This represents a 3D extension of example 3 in Arai and Tagyo (1985). 

We used Bishop’s simplified method to compare the 3D factors of safety computed by Scoops3D and 

CLARA-W for the three embankment examples of Arai and Tagyo (1985). Results are shown in table 6.14. 

Again, given the level of precision provided by CLARA-W, there is no difference between results from 

Scoops3D and CLARA-W for these three cases. 

Table 6.14. Comparison of Scoops3D and CLARA-W results for the 3:2 slope 3D embankment examples.  
 
[Factors of safety computed using 3D Bishop’s simplified method.  Embankments are 3D extensions of Arai and Tagyo’s 
(1985) examples for a homogeneous embankment (example 1), non-homogeneous embankment (example 2), and 
homogeneous embankment with a piezometric surface (example 3)] 
 

Arai and Tagyo's 
(1985) example 

number 
Material 

properties 
Piezometric 

surface 
Scoops3D 

F 
CLARA-W 

F 
Percent 

difference from 
CLARA-W 

1 Homogeneous no 1.60 1.60 0.0 

2 Non-homogeneous no 0.54 0.54 0.0 

3 Homogeneous yes 1.27 1.27 0.0 
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6.4. Comparison with 2D Benchmark Solutions 

Although Scoops3D was developed for the primary purpose of calculating 3D factors of safety 

throughout a 3D domain, it also computes a 2D factor of safety for a cross section through the approximate  

center of a 3D potential failure mass when the user selects the single trial surface option. Note that Scoops3D 

computes 2D solutions using a slightly different procedure than that typically used by 2D method of slices 

software (section 2.6). We compared the 2D factor of safety from Scoops3D with the 2D solution from CLARA-

W, both using Bishop’s simplified method, for a cross section through several of our 3D examples. We also 

compared 2D Ordinary and Bishop’s simplified method solutions computed in Scoops3D with several 2D 

benchmark solutions (Arai and Tagyo, 1985; Donald and Giam, 1995; Rocscience Inc., 2010; Feng and Fredlund, 

2012). 

6.4.1. CLARA-W 2D Benchmark Solutions 

Using a subset of the 3D benchmarking examples (section 6.2), we compared the 2D Bishop’s factor of 

safety calculated by Scoops3D to the 2D solution from CLARA-W (O. Hungr Geotechnical Research Inc., 2010). 

For comparison with CLARA-W results, we used identical circular trial surfaces based on a slice through the 

estimated center of the 3D mass with a sphere center and radius identified previously through an extensive search 

for the 3D global minimum F. 

For these scenarios, the factors of safety and areas computed using Scoops3D and CLARA-W are shown 

in table 6.15. Because CLARA-W only provides results with two decimal places, we use this precision for 

calculation of the differences. For most examples, the 2D factor of safety computed in Scoops3D is within 1.5 

percent of the 2D factor of safety calculated by CLARA-W. Two examples, with F << 1 (wet with slope = 60°) 

have differences of ~7 and 15 percent. Such low values of F have little physical meaning and can lead to large 

percent differences when compared with other similar low values of F. 

6.4.2. Published 2D Benchmark Solutions 

A number of 2D benchmark solutions are commonly used for verification of 2D slope stability (Arai and 

Tagyo, 1985; Donald and Giam, 1995; Rocscience Inc., 2010; Feng and Fredlund, 2012). We compared the published 

2D F for examples described in our 3D comparisons (sections 6.3.2 and 6.3.3) with 2D values of F computed using 

the 2D Ordinary and Bishop’s simplified methods in Scoops3D. The benchmark 2D F values were derived from the 

following 2D software packages: SVSlope (Feng and Fredlund, 2012) and Slide (Rocscience Inc., 2010) that are 

reported in the SVSlope verification manual (Feng and Fredlund, 2012). We used CLARA-W (O. Hungr Geotechnical 

Research Inc., 2010) to supplement the comparisons. Computations of 2D Bishop’s simplified F in Scoops3D showed 

a maximum difference of ~1.4 percent compared to other software packages (table 6.16) and computations of the 

Ordinary method F showed a maximum difference of ~0.4 percent (table 6.17). 
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Table 6.15. Comparison of 2D solutions from Scoops3D and CLARA-W for homogeneous embankments and cones, given different values of λ.  
 
[Bishop’s 2D factors of safety (F) and cross-sectional areas are computed for a slice through the center of the 3D critical surface identified by Scoops3D. Dry and 
wet scenarios with the same slope angle and 𝜆 are calculated using the same trial surface, and have the same cross-sectional area. Parameter ru is pore-pressure 
ratio. º, degree; m, meter] 
 

λ  ru Slope (°) 
Scoops3D  CLARA-W Comparison with CLARA-W 

2D F Area (m2) 2D F Area (m2) Percent 
difference 2D F 

Percent difference 
area 

Homogeneous embankments  
1.00 0 60 3.86 49.66 3.92 49.99 -1.5 -0.66 
0.025 0 60 0.18 15.83 0.18 15.54 0.0 1.87 
1.00 0.1 60 3.72 49.66 3.77 49.99 -1.3 -0.66 
0.025 0.1 60 0.14 15.83 0.15 15.54 -6.7 1.87 
1.00 0.4 60 3.28 49.66 3.33 49.99 -1.5 -0.66 
0.025 0.4 60 0.034 15.83 0.04 15.54 -15.0 1.87 
1.00 0 10 9.10 794.84 9.15 794.85 -0.5 0.00 
0.025 0 10 1.13 178.17 1.13 178.09 0.0 0.04 
1.00 0.1 10 8.63 794.84 8.68 794.85 -0.6 0.00 
0.025 0.1 10 1.02 178.17 1.02 178.09 0.0 0.04 
1.00 0.4 10 7.22 794.84 7.27 794.85 -0.7 0.00 
0.025 0.4 10 0.70 178.17 0.70 178.09 0.0 0.04 

Homogeneous cones         1.00 0 30 8.51 1.13464×106 8.53 1.13399×106 -0.2 0.06 
0.125 0 30 1.94 5.87655×105 1.95 5.87060×105 -0.5 0.10 
0.025 0 30 0.82 3.22151×105 0.82 3.21631×105 0.0 0.16 
1.00 0.1 30 8.21 1.13464×106 8.24 1.13399×106 -0.4 0.06 
0.125 0.1 30 1.78 5.87655×105 1.79 5.87060×105 -0.6 0.10 
0.025 0.1 30 0.73 3.22151×105 0.73 3.21631×105 0.0 0.16 
1.00 0.4 30 7.32 1.13464×106 7.35 1.13399×106 -0.4 0.06 
0.125 0.4 30 1.31 5.87655×105 1.31 5.87060×105 0.0 0.10 
0.025 0.4 30 0.47 3.22151×105 0.47 3.21631×105 0.0 0.16 
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Table 6.16. Comparison of 2D results using Bishop’s simplified method in Scoops3D and other software packages for published 2D benchmark examples.  
 
[Other software includes Slide (Rocscience Inc., 2010), SVSlope (Feng and Fredlund, 2012), and CLARA-W (O. Hungr Geotechnical Research Inc., 2010). For 
comparison with CLARA-W, 2D Bishop’s F computed inScoops3D was rounded to two digits after the decimal. Parameter eq is earthquake loading. º, degree] 

 

Example Material properties eq or water 
2D Bishop's F Percent difference 2D Bishop's F Software for comparison Scoops3D Slide SVSlope CLARA-W Slide SVSlope CLARA-W 

3:2 (~33.7 °) embankment from Arai and Tagyo (1985):  
Arai and 
Tagyo 1 

Homogeneous None 1.409 1.411 1.41 1.409 0.00 -0.14 0.0 

Arai and 
Tagyo 2 

Non-homogeneous None 0.421 0.423 0.42 0.417 -0.95 -1.42 0.0 

Arai and 
Tagyo 3 

Homogeneous Piezometric 
surface 

1.117 1.120 1.11 1.113 -0.36 -0.63 0.0 

2:1 (~26.6 °) embankment from Donald and Giam (1995): 
Donald and 
Giam 1a 

Homogeneous None 0.987 0.989 0.99 0.988 0.10 -0.10 0.0 

Donald and 
Giam 1c 

Non-homogeneous None 1.405 1.405 1.40 1.397 -0.57 -0.57 0.0 

Donald and 
Giam 1d 

Non-homogeneous eq = 0.15 1.015 1.014 1.01 1.009 -0.59 -0.49 0.0 
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Table 6.17. Comparison of 2D results using the Ordinary method in Scoops3D and other software packages for published 2D benchmark examples.  
 
[Other software includes Slide (Rocscience Inc., 2010) and SVSLOPE (Feng and Fredlund, 2012). Parameter eq is earthquake loading. º, degree] 

 

Example Material 
properties eq 

2D Ordinary F Percent difference 2D 
Ordinary F Software for comparison Scoops3D Slide SVSlope Slide SVSlope 

2:1 (~26.6 °) embankment from Donald and Giam (1995): 
Donald and 
Giam 1a 

Homogeneous None 0.947 0.945 0.944 -0.36 -0.15 

Donald and 
Giam 1c 

Non-homogeneous None 1.232 1.231 1.227 -0.43 -0.35 

Donald and 
Giam 1d 

Non-homogeneous eq = 0.15 0.884 0.884 0.881 -0.34 -0.34 
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6.5. Testing of 3D Material Property and Pressure-Head Files 

We tested the ability of Scoops3D to correctly utilize 3D distributions of material properties and pressure 

heads. Scoops3D can incorporate complex 3D distributions that cannot be replicated using only discrete layers. 

Because these complex 3D features are not commonly available in other software packages, there are no 

published 3D benchmark examples for comparison. To test these capabilities, we made use of two benchmark 

examples: (1) non-homogeneous material properties defined by layers (sections 6.3.2 and 6.3.3), and (2) 

groundwater conditions described by a piezometric surface (section 6.3.3). In both these cases, our original 

benchmark versions incorporated 3D data as layers (in ASCII raster files), in which the data are defined by either 

the elevation of the bottom of a layer or the elevation of a piezometric surface. Taken together, these layers 

represent a simplified form of 3D data and define properties throughout a 3D domain. To test the equivalence of 

these approaches, we created identical 3D distributions using 3D files, and then compared both approaches using 

examples that we already benchmarked with CLARA-W (section 6.3). 

6.5.1. Comparison of Layer Files with 3D Material Properties File 

Using our 3D extensions of the Arai and Tagyo (1985) example (2) (section 6.3.3) and the Donald and 

Giam (1995) example (1c) (section 6.3.2) with non-homogeneous properties defined by stratigraphic layers, we 

created 3D material property files equivalent to these layers by assigning properties to a 3D array. Extensive 

searches for the global minimum F using each of the two methods for specifying 3D material properties yielded 

the same results (table 6.18). Input files used for this comparison are provided in the Scoops3D examples folder 

(sections 7.2 and 7.3. Scoops3D examples C and I). 

6.5.2. Comparison of Piezometric Surface with 3D Pressure-Head File 

Using our 3D extension of the Arai and Tagyo (1985) example (3) (section 6.3.3) with a piezometric 

surface, we created an equivalent 3D pressure head file by assuming hydrostatic conditions beneath the 

piezometric surface. This 3D file contains pressure head at two locations (rather than a full 3D array) within each 

column underlying a DEM cell: (1) hp = 0 at the water table, and (2) hp = ht – hz, at a depth below the water table, 

where ht = total head, hp = pressure head, and hz = elevation head. This configuration also tests the ability of 

Scoops3D to linearly interpolate pore pressure between known locations of pressure head. Our results from an 

extensive search for the global minimum F identify the same critical surfaces with the same factors of safety for 

both the Ordinary and Bishop’s simplified methods (table 6.19).
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Table 6.18. Comparison of computed 3D factor of safety in Scoops3D using the same material properties described in either layer files or a 3D material property 
file.  
 
[Factor of safety (F) computed with both 3D Bishop’s simplified and Ordinary methods.º, degree] 

 

Example 
Scoops3D F with material properties 

described in layer files 
Scoops3D F with material properties 

described in 3D material properties file 
Percent difference 

F 
F_Ordinary F_Bishop F_Ordinary F_Bishop Ordinary Bishop 

3:2 (~33.7 °) embankment from Arai and Tagyo (1985): 
Arai and Tagyo example 2 0.563 0.539 0.563 0.539 0.00 0.00 

2:1 (~26.6 °) embankment from Donald and Giam (1995): 
Donald and Giam example 1c 1.372 1.514 1.372 1.514 0.00 0.00 

 

Table 6.19. Comparison of computed 3D factor of safety in Scoops3D using the same groundwater configuration defined in either a piezometric surface file or a 
3D pressure-head file.  
 
[Factor of safety (F) computed with both 3D Bishop’s simplified and Ordinary methods] 
 

Example 

Scoops3D F with groundwater 
configuration described in 

piezometric surface file 

Scoops3D F with groundwater 
configuration described in 3D 

pressure head file 
Percent difference F 

F_Ordinary F_Bishop F_Ordinary F_Bishop Ordinary Bishop 
Arai and Tagyo (1985) example 3 1.180 1.274 1.180 1.274 0.00 0.00 
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6.6. Number of Columns Tests 

In addition to the verification tests discussed above, we assessed the sensitivity of Scoops3D calculations 

to the number of active columns in a potential failure mass. The accuracy of any solution determined by a 

discretization method is dependent on the level of discretization. Software packages for 2D limit-equilibrium 

analysis commonly have guidelines for the minimum number of slices to include in a trial surface. For 3D slope-

stability analyses that use a method-of-columns limit-equilibrium analysis, the number of columns contained in a 

potential failure mass can affect the accuracy of results, such as total volume, potential failure surface area, and 

factor of safety, F. For example, Lam and Fredlund (1993) found that computation of F using their methods was 

inaccurate for potential failure masses with fewer than 400 columns. On the other hand, the user’s guide for 

CLARA-W recommends using more than 1000 columns (O. Hungr Geotechnical Research Inc., 2010) to obtain 

accurate results and Huang and others (2002) found that more than 9,000 columns were required for a good 

solution using their methods. The approaches described by all of these investigators appear to involve 

calculations that use only columns with all four corners fully contained within the potential failure mass (that is, 

full columns). 

Scoops3D utilizes partial (trial surface encompassing only 2 or 3 corners of a column) as well as full 

columns in stability computations, thus potentially reducing the number of active columns required for accurate 

results. However, Scoops3D analyses are typically designed to search for potential failures spanning a large range 

of volumes and (or) areas throughout a DEM, commonly entailing millions of potential failure masses containing 

a wide range of numbers of active columns. 
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To provide guidance about the desired numbers of active columns in a potential failure mass, we 

compared Scoops3D solutions for factor of safety, F, and volume computed with varying numbers of active 

columns in the potential failure mass for examples with differing topography, slope angles, and λ values (as 

defined in section 6.2), including cases of purely cohesive (λ = ∞) strength properties. Cases with more cohesive 

strength are sensitive to the accuracy of the computed trial slip surface area. Cases with more frictional strength 

are sensitive to the accuracy of the computed normal force on the base of the columns (a function of column 

weight and volume). For all tests, we compared the differences in computed F and volume, V, to a reference 

solution containing many active columns (designated as maxcol): 

 max

max
% 100col

col

F Fdifference F
F

 −
=  
 

, and (6.3) 

 

 max

max
% 100col

col

V Vdifference V
V

 −
=  
 

, (6.4) 

where 

 F  is the factor of safety computed by Scoops3D for current number of active columns, 

 F max col is the factor of safety computed by Scoops3D with a large number of active columns, 

 V  is the volume computed by Scoops3D for current number of active columns, and 

 V max col is the volume computed by Scoops3D with a large number of active columns. 

 

A common benchmark example used for number of columns testing is the analytical solution for a purely 

cohesive soil (Lam and Fredlund, 1993; Huang and others, 2002), as discussed in section 6.1. We compared 

factors of safety computed by Scoops3D for identical trial surfaces, but with decreasing numbers of active 

columns, to those obtained using an extremely high-resolution DEM (cell size = 0.00375 length units and maxcol 

= 150,292 columns) as the reference (fig. 6.8). For the potential failure mass using the high-resolution DEM, 

Scoops3D calculated F = 1.400, or ~0.1 percent less than the analytical solution of 1.402. Using the high-

resolution DEM, the calculated volume was 0.655 cubic length units, which compares well with the volume of 

0.654 cubic length units in an equivalent spherical cap. As the DEM decreased in resolution (fewer active 

columns in the potential failure mass), the value of F calculated by Scoops3D fluctuated relative to the analytical 

and high-resolution solutions from Scoops3D (fig. 6.8). For this example, our results indicate that at least 300 to 

500 active columns are needed to obtain estimates of F, volume, and horizontal area within ~1 percent of the 

analytical solution. 
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Figure 6.8. Graphs showing effects of number of active columns on computed 3D factor of safety, volume, horizontal area, 
and slip surface area for the purely cohesive example. Each case uses the same spherical potential failure mass as described 
in section 6.1. A, Computed 3D factor of safety, F, using Bishop’s simplified method, versus number of active columns in the 
potential failure mass. The gray lines show the 3D analytical solution (solid gray) ±1 percent and ±2 percent (dotted gray) for 
comparison. The Scoops3D solution with a very high resolution DEM (solid black) for a potential failure mass containing 
150,292 columns is 1.400 or 0.1 percent less than the analytical solution of 1.402. B, Percent difference in F, volume, 
horizontal area, and slip surface area versus number of active columns in the potential failure mass. Differences are relative 
to values obtained with the very high resolution DEM, as described above. 

In addition to the analytical solution example for a purely cohesive soil, we analyzed the number of 

active column requirements for several of the embankment (height = 10 m) and cone (height = 1,000 m) 

examples described in section 6.2. For each example, the number of active columns in the reference solution was 

a function of the ground surface slope and potential failure size. The maximum number of active columns in the 

reference solutions ranged from 2,622 to 230,612. Percent differences from these reference solutions for factor of 

safety, F, and volume are shown in figure 6.9. 
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Figure 6.9. Graphs showing percent differences in Scoops3D results versus number of active columns in a potential failure 
mass for a variety of scenarios. Scenarios shown in A (factor of safety) and B (volume) are for low or moderately sloping 
topography (30° or less) or steeply sloping topography (50°–60°) with low λ, require at least ~200 active columns (vertical 
line) for results within 1 percent of the reference solutions. Scenarios shown in C (factor of safety) and D (volume) are for 
steeply sloping topography (50°–70°) or moderately sloping topography (30°) with cohesion only require at least 300 active 
columns (vertical line) for results within 1 percent of the reference solutions. Results use Bishop’s simplified method of 
analysis. For the embankments, λ = 0.025 (low) and 1.0 (high). For the 30° cones, λ = 0.025 (low), 1.0 (high) and ∞ (cohesive 
strength only). For the 70° cones,  λ = 0.0625 (low) and 1.0 (high). Material properties for low and high λ values are shown in 
tables 6.3 and 6.5. Results using greater than 2,000 active columns (including the reference solutions) are not shown. 
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We found that the number of active columns required for a reasonable solution for F varied with 

topography (embankments versus cones), ground surface slope, and λ (figs. 6.8 and 6.9). For low or moderately 

sloping topography (10º to 30º) or steeper topography with low λ values, Scoops3D analyses using as few as 200 

active columns provided solutions within 1 percent of reference solutions that use significantly more active 

columns (fig. 6.9A and B). More active columns (300 to 500) were required for cases with very steep slopes (70º), 

steep slopes with high λ values, or cases with cohesive strength only. These column values are lower than those 

advocated by some other researchers (for example, Huang and others, 2002; O. Hungr Geotechnical Research 

Inc., 2010); we attribute this to Scoops3D’s inclusion of partial columns, which provides a better estimation of 

volume and potential failure surface area than if these columns were excluded. Because Scoops3D counts partial 

columns as full columns when determining the number of active columns in a potential failure mass, the actual 

discretization in Scoops3D may be coarser than an equivalent example from the published studies using other 

models. 

Increasing the number of active columns provides a better estimation of volume and F, but for many 

cases even a low number of active columns (<100) produced values of F within 2 percent of the reference 

solution. On the other hand, the accuracy of the volume calculation typically decreased rapidly when fewer than 

200 active columns were used in the analysis. Therefore, we recommend using a DEM resolution that will 

encompass at least 200 active columns for potential failure masses with a size near the minimum specified by the 

user. Although some cases (for example, those with steep slopes or high λ values) may require a larger number of 

active columns (300 to 500 in some cases) to provide accurate results, preliminary assessments with fewer active 

columns may be useful. 

To ensure that a sufficient number of active columns are contained in all potential failure masses to 

provide reasonably accurate results, it is crucial to select an adequate DEM resolution. A DEM resolution that 

provides more than 500 active columns (or more than 200 in many cases) in the smallest potential failure masses 

will provide reasonable estimates of F and potential failure size. If runtime and (or) computer memory 

requirements are of concern (section 5.2), however, it may be desirable to minimize the DEM resolution and 

therefore reduce the number of active columns in a given potential failure mass (section 5.3.4). To help assess 

DEM resolution adequacy, Scoops3D allows the user to select a desired minimum number of active columns 

(limcol) to be included in a potential failure mass. Any potential failure mass with fewer active columns will still 

be included in the analysis but will be flagged so the user can assess their importance to the overall results 

(section 4.5.2.2). The user can then adjust the discretization level of the problem domain or the range of potential 

failure sizes to be considered based on this knowledge. 
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6.7. Symmetry Tests 

Scoops3D has the ability to compute factors of safety of potential failure masses regardless of the 

orientation of their potential slip direction relative to the x- and y-axes of the DEM. This ability differs from that 

of most other slope stability software packages, which commonly require the user to align the topography (or 

presumed slip direction) to the coordinate axes. For example, the 3D CLARA-W software (O. Hungr 

Geotechnical Research Inc., 2010) requires the slope to increase in elevation from left to right (the y-axis in 

CLARA-W), in alignment with the grid. Because Scoops3D can analyze potential failure masses with slip 

directions at any orientation relative to the DEM coordinate axes, it can fully search a DEM. 

To assure that Scoops3D can accurately compute the factor of safety, F, regardless of slip direction, we 

created factor-of-safety maps for a symmetric cone. These examples compute F for more than 80,000 potential 

failure masses. Ideally, F computed at identical elevations would be the same regardless of orientation relative to 

the axes of the coordinate system. Our symmetry tests show that only small discrepancies in F (< 0.1 to 0.2 

percent) occur at different locations around the cone. The pattern of variability depends on λ values (fig. 6.10). 

 
Figure 6.10. Perspective and map views of cones showing the results of the symmetry tests. Factor of safety shown for each 
DEM cell is computed relative to the global minimum factor of safety Fmin using Bishop’s simplified method. A, Perspective 
view of 30° cone DEM with height, H = 1000 m. B, Plan view showing F results for a cone with low λ = 0.025. C, Plan view 
showing F results for a cone with high λ = 1.0. Material properties for low and high λ values are shown in table 6.5. 
Perspective view created using VisIt software and maps created using Esri ArcMap software. 
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6.8. Tests of Partially Saturated Suction Effects 

As discussed in section 2.2, Scoops3D can include the effects of suction stress from partially saturated 

earth materials in its computation of slope stability. In partially saturated (or unsaturated) materials, pore-water 

pressures are negative relative to atmospheric pressure, and they impart a suction stress. We are not aware of 

analytical solutions for 3D slope stability with suction stresses that would enable a direct comparison with 

Scoops3D results. To test the reasonableness of Scoops3D inclusion of suction stress, we examine the variation in 

factor of safety, F, with differing water contents (or suction stresses), computed using two hypothetical soils with 

different properties. Given these soils, as uniform water content changes, computed F should directly reflect 

variations in suction stress; that is, peaks in suction stress should lead to more stable slopes with higher values of 

F. We evaluate suction effects using van Genuchten (1980) and Fredlund and Xing (1994) soil-water 

characteristic curves (SWCC) for the two soils. We also compare our Fredlund and Xing SWCC results with 

those calculated using the SVSlope software (Fredlund and others, 2009). 

Our suction stress analyses use three straight 10-m high embankments with slopes of 10º, 30º and 50º. 

Properties for the two soils, including both van Genuchten and Fredlund and Xing SWCC shape parameters are 

shown in table 6.20. One set of hypothetical values is typical of sand and the other is typical of clay. The soil-

water characteristic curves and suction-stress curves for the two materials, for both approaches are shown in 

figure 6.11. Note that the sand suction-stress curve has a pronounced peak at a matric suction of about 8 kPa (for 

this material).  
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Table 6.20. List of parameters for two materials (sand and clay) used in the partially saturated suction tests.  
 
[Parameters for materials: c is cohesion, φ is angle of internal friction, γs is saturated unit weight, θr is residual volumetric 
water content, and θs is saturated volumetric water content. º, degree; kN, kilonewton; kPa, kilopascal; m, meter] 

 
Parameter Sand Clay 

c (kPa) 1 15 

φ (°) 34 28 

γs (kN/m3) 20 18 

θs 0.35 0.5 

van Genuchten parameters   

van Genuchten θr 0.05 0.1 

van Genuchten α (kPa-1) 0.1 0.01 

van Genuchten n 5 2 

Fredlund and Xing parameters   

Fredlund and Xing θr 0.092 0.22 

Fredlund and Xing a (kPa) 8.69 68.97 

Fredlund and Xing n 6.82 3.61 

Fredlund and Xing m 0.844 0.417 

Fredlund and Xing ѱr (kPa)  16.8 316 
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Figure 6.11. Graphs showing soil-water characteristic curves (water content versus matric suction) and suction-stress curves 
for two materials, sand and clay, used in the suction tests. The graphs show water content and suction stress using two 
different equations (van Genuchten, 1980; Fredlund and Xing, 1994). Material parameters are listed in table 6.20. Note 
different x- and y-axis scales. Suction stress is the product of matric suction and the effective degree of saturation, Se (see 
equation 2.8). A, Sand. B, Clay. 

Using Scoops3D, we examined the effect of variations in suction stress by constructing a series of 

scenarios, each having uniform values of effective degree of saturation, Se, matric suction, and suction stress. The 

scenarios cover the various combinations of the two soils and three embankment slopes. We compared the 

relative effects on slope stability in two ways. For both the van Genuchten and Fredlund and Xing curves, we 

used a fixed trial surface for each scenario that was identified by Scoops3D as the least-stable (critical) surface 

for the corresponding dry embankment. This same fixed trial surface was then analyzed for each suction-stress 

scenario. For the van Genuchten curves, we also allowed Scoops3D to search for the critical surface (minimum F) 

for each value of matric suction. 

Results from these two approaches are shown in figure 6.12. As might be anticipated, factors of safety on 

the critical surfaces are slightly lower than those on the fixed trial surfaces. For both sand and clay materials, 

computed factors of safety with varying matric suctions follow the same patterns as their respective suction-stress 

curves (fig. 6.11). In sand, a peak in stability (higher factor of safety) occurs with a matric suction of about 8 kPa 

for both SWCC methods. In the clay with a van Genuchten SWCC, stability continues to increase with increasing 

matric suction, as the scenarios shown are wetter than residual water content, θr. For the clay with a Fredlund and 

Xing SWCC, the suction-stress curve has a different shape and stability effects are reduced in drier scenarios. For 
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both sand and clay with Fredlund and Xing curves, factors of safety for scenarios with suctions greater than 

residual, ψr, matric suction is equal to zero, therefore, factors of safety are equal to the value with no matric 

suctions. For all cases, the same patterns occur in embankments with different slopes, with overall lower factors 

of safety for steeper embankments. 

 
Figure 6.12. Graphs showing computed 3D factor of safety and matric suction for partially saturated sand and clay in three 
different embankments with different soil-water characteristic curve (SWCC) approaches. Embankments have slopes of 10º, 
30º, and 50º. Fixed values for each case use a trial surface based on the least-stable dry trial surface whereas critical values 
result from a search for the minimum F given the different matric-suction conditions. A, Sand, using van Genuchten SWCC. B, 
Clay using van Genuchten SWCC. C, Sand using Fredlund and Xing SWCC. D, Clay using Fredlund and Xing SWCC. 
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Table 6.21. Comparison of 3D factor-of-safety (F) results using Bishop’s simplified method in Scoops3D and SVSlope for partially saturated embankments.  
 
[Results are for a fixed trial surface based on the least-stable trial surfaces in dry embankments with slopes of 10º, 30º, and 50º. kN, kilonewton; kPa, kilopascal; 
m, meter] 

 
Matric suction 

(kPa) 
Unit 

weight 
(kN/m3) 

Scoops3D Bishop's F SVSlope Bishop's F Percent difference F 
10 degree 

embankment 
30 degree 

embankment 
50 degree 

embankment 
10 degree 

embankment 
30 degree 

embankment 
50 degree 

embankment 
10 degree 

embankment 
30 degree 

embankment 
50 degree 

embankment 

Sand              

No matric suction  17.47 4.109 1.374 0.748 4.109 1.376 0.751 -0.01 -0.15 -0.40 

2 19.97 4.310 1.534 0.882 4.310 1.539 0.890 0.00 -0.34 -0.90 

4 19.93 4.530 1.709 1.029 4.531 1.718 1.041 -0.02 -0.55 -1.20 

5 19.90 4.635 1.792 1.098 4.636 1.803 1.114 -0.02 -0.61 -1.40 

7 19.68 4.797 1.920 1.206 4.797 1.935 1.225 -0.01 -0.76 -1.56 

8 19.43 4.817 1.936 1.219 4.818 1.951 1.239 -0.03 -0.76 -1.60 

9 19.08 4.777 1.904 1.193 4.778 1.919 1.212 -0.03 -0.76 -1.60 

10 18.70 4.689 1.835 1.134 4.691 1.848 1.152 -0.04 -0.71 -1.54 

12 18.09 4.476 1.666 0.993 4.477 1.675 1.005 -0.02 -0.56 -1.24 

15 17.62 4.223 1.465 0.824 4.224 1.470 0.831 -0.01 -0.34 -0.81 

20 17.47 4.109 1.374 0.748 4.109 1.376 0.751 -0.01 -0.15 -0.40 

Clay              

No matric suction 15.30 5.033 2.260 1.599 5.038 2.262 1.599 -0.11 -0.11 0.01 

2 18.00 4.883 2.168 1.520 4.888 2.169 1.520 -0.10 -0.06 0.03 

10 17.98 5.283 2.413 1.732 5.289 2.416 1.732 -0.12 -0.12 -0.03 

70 17.35 7.597 3.838 2.974 7.611 3.843 2.974 -0.18 -0.13 -0.02 

100 16.74 7.765 3.942 3.065 7.780 3.947 3.065 -0.19 -0.14 -0.01 

200 15.71 6.734 3.306 2.508 6.744 3.309 2.505 -0.15 -0.08 0.10 

300 15.34 5.286 2.415 1.733 5.288 2.415 1.728 -0.04 0.01 0.31 

900 15.30 5.033 2.260 1.599 5.038 2.262 1.599 -0.11 -0.11 0.01 
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Using the Fredlund and Xing SWCC approach, we also compared factor-of-safety results from Scoops3D 

with SVSlope, both using Bishop’s simplified method of analysis. The results, for three different embankments 

and two soils, are shown in table 6.21. Most of the differences are within 1 percent; some scenarios with steeper 

embankments differ by ~1.6 percent. All of our test results suggest that Scoops3D is able to properly incorporate 

the effects of suction stress into its stability computations. 

6.9. Discussion 

Our testing and verification of Scoops3D demonstrates general agreement between Scoops3D results, 3D 

analytical solutions, and 3D benchmark solutions for both computed factors of safety and potential failure 

volumes. The 3D benchmark solutions using CLARA-W show the best agreement with the Scoops3D results 

(typically less than 0.1 percent difference in factor of safety and volume). This agreement is expected, as 

CLARA-W uses the same factor of safety formulation for Bishop’s simplified method and allows direct 

comparisons for identical spherical trial surfaces. Likewise, comparisons of 2D factors of safety for single trial 

surfaces agreed well (typically within 1 percent) with CLARA-W, as well as with solutions to benchmark 

examples published in 2D software verification manuals (Rocscience Inc., 2010; Feng and Fredlund, 2012). 

Our testing also showed: 

• Compared to 3D analytical chart solutions, factors of safety computed by Scoops3D using Bishop’s 

simplified method are within 1 to 9 percent for embankments and 0 to 2 percent for cones. These 

differences are likely due to differences in the assumed trial surface shape (log-spiral in the chart 

solutions vs. spherical in Scoops3D). 

• Results of examples comparing material layers with an equivalent 3D material property file agreed 

for our benchmark examples (section 6.5.1). 

• Results of examples comparing a piezometric surface file with an equivalent 3D pressure head file 

agreed for our benchmark examples (section 6.5.2). 

• Scoops3D typically provides good estimates of potential failure volume and factor of safety using as 

few as ~200 active columns in a potential failure mass (section 6.6). Cases with high λ values (more 

cohesive strength) or steep slopes may require more (~300 to 500) active columns. 

• For potential failure masses with slip directions that are not aligned to the coordinate axes, Scoops3D 

computes factors of safety to within 0.1 to 0.2 percent regardless of slip orientation (section 6.7). 
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Chapter 7. Examples 
In this chapter, we provide multiple examples that illustrate many of the capabilities of Scoops3D. Files 

in the examples can: 

• Aid the user in learning to run Scoops3D and examine output files. Once Scoops3D is installed, our 

examples should execute without any user modifications to the files. 

• Serve as templates to help the user construct new files for scenarios similar to a particular example. 

The examples include a wide variety of situations with proper formats for the main parameter input 

files, ASCII raster grid files, and 3D input files for Scoops3D. 

• Allow the user to compare previous results with those generated using their current computer system. 

This is especially valuable if the user recompiles Scoops3D to execute on their system. 

All input and output files for each example are contained in the Scoops3D examples folder. Examples include 

some of the generic topographies (embankments and cones) used for testing and verification of Scoops3D 

(chapter 6), including our 3D extension of published 2D verification examples (Arai and Tagyo, 1985; Donald 

and Giam, 1995). We also include several real-world topographies based on DEMs from two regions in 

Washington State, USA – the Mount St. Helens volcano edifice and a section of coastal bluffs in Seattle. These 

are derived from previously published work (Reid and others, 2000; Brien and Reid, 2007; Brien and Reid, 2008). 

The examples illustrate a variety of scenarios describing the 3D domain underlying the DEM (table 7.1). 

They include three variations of material properties: (1) homogeneous, (2) non-homogeneous defined in layer 

files, and (3) non-homogeneous defined in a 3D material property file. Examples include three variations of 

groundwater configurations: (1) a pore-pressure ratio, ru, (2) a piezometric surface file, and (3) a 3D pressure-

head file. Also included are examples of three different search methods: (1) box, (2) single surface, and (3) file 

search. Some of our box searches of generic topographies (embankments and cones) represent special situations 

wherein we seek to identify only the global minimum factor of safety (rather than assess stability everywhere) in 

a symmetric topography for testing purposes. For these situations, it is adequate to search a single 2D vertical 

cross section through the lattice above the center of the DEM. This type of search can identify the global 

minimum factor of safety in symmetric topography; however, it does not utilize the ability of Scoops3D to 

identify the least-stable surface for every DEM cell. A more complete search (not just a vertical cross section) is 

recommended for DEMs that represent real-world topography. 
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Table 7.1. Summary of Scoops3D examples, including main parameter input files, DEMs and configuration parameters.  
 
[Full DEM search = ‘No’ indicates a Box search of a 2D vertical cross section above the center of the DEM. This type of search does not utilize the ability of 
Scoops3D to identify the least-stable surface for every DEM cell and is not recommended for DEMs that represent real-world topography. H is embankment 
height and eq is earthquake loading. m, meter] 

 

Section 
Description, 

reference, and  
DEM file name 

Name of subfolder Example Main parameter input file 
(.scp) 

Material properties 
and method of 
specification 

Groundwater 
configuration and 

method of specification 
eq Search 

method 
Full 
DEM 

search 
7.2 Arai and Tagyo 

embankment 
configurations 

AraiTagyo A A_emb20 Homogeneous  None 0 Box No 

 embankment, H 
=20 m, 3:2 slope 

 B B_emb20nonhomog Non-homogeneous, 
layers 

None 0 Box No 

 (Arai and Tagyo, 
1985) 

 C C_emb20nonhomog3D Non-homogeneous, 
3D file 

None 0 Box No 

 emb20DEM.asc  D D_emb20wet Homogeneous  Piezometric surface file 0 Box No 

      E E_emb20wet3D Homogeneous  3D pressure-head file, 
derived from 
piezometric surface 

0 Box No 

7.3 Donald and Giam 
embankment 
configurations 

DonaldGiam F F_emb10 Homogeneous  None 0 Box No 

 embankment, H = 
10 m, 2:1 slope 

 G G_emb10single Homogeneous  None 0 Single No 

 (Donald and Giam, 
1995) 

 H H_emb10nonhomog Non-homogeneous, 
layers 

None 0 Box No 

 emb10DEM.asc  I I_emb10nonhomog3D Non-homogeneous, 
3D file 

None 0 Box No 

      J J_emb10nonhomogeq Non-homogeneous, 
layers 

None 0.15 Box No 

7.4 Symmetric cone 
configurations 

cone K K_conehi Homogeneous  None 0 Box No 

 cone, H = 1000 m, 
30 degree slope 

 L L_conemed Homogeneous  None 0 Box No 

 Scoops3D manual 
(section 6.2.2) 

 M M_conelo Homogeneous  None 0 Box No 

 cone1000DEM.asc  N N_conemedfullsearch Homogeneous  None 0 Box Yes 

      O O_conemedru Homogeneous  Pore-pressure ratio (ru) 0 Box No 
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Section 
Description, 

reference, and  
DEM file name 

Name of subfolder Example Main parameter input file 
(.scp) 

Material properties 
and method of 
specification 

Groundwater 
configuration and 

method of specification 
eq Search 

method 
Full 
DEM 

search 
7.5 southwestern 

Seattle, 
Washington  

Seattle P P_seadry Non-homogeneous, 
layers 

None 0 File Yes 

 (Brien and Reid, 
2007) 
seaclipDEM.asc 
 

 Q Q_seawet Non-homogeneous, 
layers 

3D pressure-head file, 
derived from 
groundwater flow 
model 

0 File Yes 

7.6 Mount St. Helens, 
Washington  

StHelens R R_sthel Homogeneous  None 0 Box Yes 

 (Reid and others, 
2000) 

        

  sthel_res100mDEM.asc                
.
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The sections below provide a description of each example, followed by an explanation of the input files. 

For each example, the main parameter input file (.scp file) is located in a subfolder within the Scoops3D 

examples folder (as listed in table 7.1). Within each of these subfolders, an input subfolder contains all additional 

Scoops3D input files. Also, for each example, a folder containing all original input and output files is located in 

the folder labeled examples/original_files. 

All Scoops3D input files can be viewed in a text editor; however, we recommend opening the main 

parameter input files (.scp files) in the graphical user interface (GUI) program Scoops3D-i (File > Open). Other 

input files (such as ASCII raster files and 3D files) can also be viewed from Scoops3D-i by selecting View > 

ASCII Text File or by using a text editor of the user’s choice. We suggest that users examine several of the 

examples using the methods described in section 7.1 to gain insight into the capabilities of Scoops3D and to aid 

in construction of their own analyses. Examples demonstrating specific Scoops3D options can be found by 

examining table 7.1. 

7.1. Running an Example 

To illustrate how to use the examples, we show screenshots from Scoops3D-i that demonstrate opening, 

viewing, and running Scoops3D example C (C_emb20nonhomog3D.scp) in the AraiTagyo folder. This dry, non-

homogeneous, 20-m high, 3:2 embankment example is a 3D extension of a commonly used 2D verification 

example, described in the testing section (sections 6.3.3 and 6.5.1; Arai and Tagyo (1985), example 2), and 

demonstrates the use of a 3D material properties file (section 4.4.2). Before running this example, the user should 

be familiar with the operation of Scoops3D-i (section 4.3). 

When viewing the files, be careful not to select File > Save as this action will overwrite the original 

example file. If the user would like to save modifications, use File > Save As and assign a new file name and (or) 

location for the modified file to avoid overwriting the original example. 

7.1.1. Opening and Viewing a .scp File 

After launching Scoops3D-i, select File > Open from the main window menu bar, navigate to the 

appropriate folder (directory) containing the Scoops3D examples folder and locate the subfolder AraiTagyo. 

Within this subfolder select the file C_emb20nonhomog3D.scp and click Open. The main Scoops3D-i window 

displays information contained in the .scp input file (fig. 7.1). The top two sections of the window display a 

description of the file, DEM file name, and information about the DEM. The Subsurface Conditions section of 

the window shows that this example uses a 3D material properties file with no groundwater and no earthquake 

loading. The Stability Analysis section of the window shows that this example uses Bishop’s simplified method, 

and the extent of the search lattice is defined by a box. 
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The example can be run directly from this window; however, we step through the various components of 

the example to illustrate features and file formats that could aid the user in constructing their own files. 

 

 
Figure 7.1. Screenshot of the main Scoops3D-i window after opening example C. This example (file name: 
C_emb20nonhomog3D.scp) uses a 3D material properties file, no groundwater configuration, no earthquake loading, Bishop’s 
simplified limit-equilibrium method, and the box search method. 
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The details of the subsurface parameters specified for this example can be examined by clicking the 

Subsurface Parameters button. The Subsurface Parameters child window shows the parameters for the 3D 

material properties file, including a valid file name associated with the example, the method of interpreting the 

vertical distribution of properties, and selection of the parameters contained in the 3D material properties file  

(fig. 7.2). In this example, all of the material properties (cohesion, angle of internal friction, and total unit weight) 

are contained in the 3D material properties file (and are therefore set to the default value of -1 in the .scp file, see 

section 4.4.1.1.4.2). Deselecting any of the check boxes would require the user to provide a valid value for the 

specified parameter in the boxes below the Remaining uniform properties as well as creation of a new 3D 

material properties file containing only the parameters needed in the 3D material properties file. Click Cancel to 

return to the main window without making changes. 

 
Figure 7.2. Screenshot of Subsurface Parameters child window for example C. File name for example: 
C_emb20nonhomog3D.scp. Parameters for the 3D material properties file, including the 3D material properties file name, the 
method of interpreting the vertical distribution of properties, and identification of the parameters contained in the 3D material 
properties file are shown. 

After returning to the main Scoops3D-i window (fig. 7.1), select View > ASCII Text File from the main 

window menu bar. Navigate to the input subfolder within the AraiTagyo subfolder and select the 3D material 

properties file emb20mat3D.txt. Clicking Open will show a File Viewer window displaying the contents of the 

3D material properties file (fig. 7.3). This file demonstrates the file format and required header information for a 
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3D input file using ‘ijz’ coordinates (section 4.4.2.2.1). Click the close button at the top of the File Viewer 

window and return to the main Scoops3D-i window (fig. 7.1). 

 
 

Figure 7.3. Screenshot of File Viewer window showing the contents of the 3D material properties file used in example C. File 
name for example: emb20mat3D.txt. 
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Next, click the Search Configuration button to examine the details of the search configuration. The 

radio buttons in the Search Configuration child window show that volume is the selected size criteria (fig. 7.4). 

Scoops3D will search for potential failures between the minimum (within a tolerance) and maximum volume 

specified. Other parts of the window show the number of slip directions, and the extent and resolution of the 

search lattice (the user may need to expand the window on their screen to see all fields). Note that the resolution 

of the horizontal extent is specified as a multiplier of the DEM resolution and this example searches only a 2D 

cross section through the center of the DEM (so minimum j = maximum j = 67). This is a special search used to 

locate the global minimum factor of safety for a uniform embankment. See section 6.3.3 for a description of the 

problem setup. For a thorough search of a DEM, the horizontal extent typically should match or exceed the limits 

of the DEM. Click Cancel to return to the main window without making changes. 
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Figure 7.4. Screenshot of Search Configuration child window for example C. File name for example: 
C_emb20nonhomog3D.scp. Parameters for the box search include minimum and maximum sizes for the selected  
size criteria, number of slip directions, and vertical and horizontal spacing and extents of the 3D search lattice. See  
section 4.3.3.5.1 for description of Advanced button options. 
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7.1.2. Running the Example and Viewing Output 

After returning to the main Scoops3D-i window (fig. 7.1), the file can be checked for completeness and 

run in Scoops3D. To run the example in Scoops3D, select Run > Run Scoops3D from the main window menu 

bar. With this selection, Scoops3D-i automatically checks the input file for completeness before launching 

Scoops3D. 

As Scoops3D executes, the command tool (Windows) or terminal (Macintosh) window displays the 

progress of the Scoops3D simulation, including the input file name, search node, search iteration number, percent 

completed of each search iteration, and number of trial surfaces analyzed (fig. 7.5). When the run is completed, 

“Successful execution …” with Scoops3D version number, date, and time are displayed in the window. 

 

 

  

Figure 7.5. Screenshot of terminal window showing a Scoops3D run using example C. File name for example: 
C_emb20nonhomog3D.scp. 
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Upon successful execution of Scoops3D, output files for this example are placed in the subfolder labeled 

C_emb20nonhomog3D _output. The summary output file can be viewed using Scoops3D-i by selecting View > 

Scoops3D Output File from the main window menu bar. The file contents are displayed in a File Viewer 

window (fig. 7.6). Use the scroll bar to go to the bottom of this file, where information is shown about the global 

minimum F identified in this Scoops3D analysis in the section labeled “3D POTENTIAL FAILURE - GLOBAL 

MINIMUM” (fig. 7.6B). The least-stable surface (global minimum) identified in this Scoops3D analysis has a 

Bishop’s factor of safety of 0.5389 and a volume of 1.07433×104 m3. Other details about the potential failure 

mass are provided in this section of the file. When finished viewing the contents, click the close button at the top 

of the File Viewer window. 

                                                                                                           

  

A              B 

Figure 7.6. Screenshots of summary output file created after successful completion of a Scoops3D run of example C. Output 
file name: C_emb20nonhomog3D _out.txt and input file name: C_emb20nonhomog3D.scp. A, Beginning lines contained in 
output file. B, Ending lines contained in output file. 
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Other Scoops3D output files can be viewed by selecting View > ASCII Text File and selecting the 

appropriate file from the navigation window. Many of these files are best viewed using a GIS or 2D or 3D 

visualization software (section 4.5). 

The same procedure can be used to examine and run any of the examples listed in table 7.1. The user can 

identify examples of specific interest or open the files sequentially to become familiar with some of Scoops3D 

features and related files. Select File > Open to open another example, then open the Subsurface Parameters 

and Search Configuration windows and note how different scenarios require different input parameters and 

files. Several examples demonstrate the required files and file formats for complex scenarios (layer files, 3D 

subsurface properties, or 3D pore pressures). 

7.2. Arai and Tagyo Embankment Configurations 

The first set of examples uses a 20-m high embankment configuration with a 3:2 (33.7°) slope and 

material properties as described in section 6.3.3. We include five main parameter input files (examples A through 

E) that are 3D extensions of problems commonly used for verification of 2D slope stability software (Arai and 

Tagyo, 1985; Rocscience Inc., 2010; Feng and Fredlund, 2012). The five main parameter input files demonstrate: 

(A) homogeneous material properties, (B) non-homogeneous material properties with boundaries defined in layer 

files, (C) a 3D material property file, (D) a piezometric surface file, and (E) a 3D pressure head file (table 7.1). 

These five examples are variations of the three scenarios defined in testing section 6.3.3 (table 6.14): 

homogeneous (Arai and Tagyo [1985], example 1), non-homogeneous (Arai and Tagyo [1985], example 2), and 

homogeneous with a piezometric surface (Arai and Tagyo [1985], example 3). The scenario with non-

homogeneous material properties is used to demonstrate two different ways of describing non-homogeneous 

material properties in Scoops3D, requiring different input files: layer files (example B) or a 3D material property 

file with irregular vertical spacing (example C). These two approaches produce the same results. The 

homogeneous scenario with the addition of pore-water pressures defined as a piezometric surface is used to 

demonstrate two methods of describing the groundwater configuration: a piezometric surface file (example D) or 

a 3D pressure-head file (example E). Again, in this case both of these approaches produce the same results. For 

more explanation, see details of Scoops3D testing of 3D material property files and 3D pressure-head files in 

sections 6.5.1 and 6.5.2. 

For examples A through E, the search is a special case of a box search wherein only a 2D cross section 

above the center of the embankment (minimum j = maximum j) is searched. This search is appropriate to identify 

a minimum factor of safety in symmetric topography such as an embankment; however, it will not provide a 

thorough search of a DEM that represents real-world topography. 
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There are five main parameter input files (described below) for the Arai and Tagyo embankment 

configurations, and tables 7.2 and 7.3 list the additional input files and their relation to the main parameter input 

files: 

A_emb20.scp - homogeneous material properties (Arai and Tagyo [1985], example 1), 

B_emb20nonhomog.scp - non-homogeneous material properties (Arai and Tagyo [1985], example 2), 

subsurface material properties are defined in the main parameter input file and elevations for the bottom 

of each material are defined in layer files, 

C_emb20nonhomog3D.scp - non-homogeneous material properties (Arai and Tagyo [1985], example 2), 

subsurface material properties and elevations are defined in a 3D material properties file formatted for 

Scoops3D with ijz coordinates, 

D_emb20wet.scp - homogeneous material properties with piezometric surface file (Arai and Tagyo 

[1985], example 3), and 

E_emb20wet3D.scp - homogeneous material properties with piezometric surface (Arai and Tagyo [1985], 

example 3), described in a 3D pressure-head file formatted for Scoops3D with ijz coordinates. 

 

Table 7.2. List of additional input files for Scoops3D examples A through E.  
 
[These examples use a 20-m high, 3:2 embankment configuration (Arai and Tagyo, 1985). Files are contained in the input 
subfolder of the AraiTagyo folder. m, meter] 

 
File name File type Description 

emb20DEM.asc Grid Ground-surface elevations (DEM), 20 m high embankment with 3:2 
slope 

emb20layer_1.asc Grid Bottom elevation of layer 1 

emb20layer_2.asc Grid Bottom elevation of layer 2 

emb20mat3D.txt 3D  3D material property file defining the material properties equivalent to 
the layer files (ijz coordinates, see section 4.4.2.2.1). 

emb20piezo.asc Grid Elevation of the piezometric surface 

emb20phead3D.txt 3D  3D pressure head file defining a piezometric surface below each DEM 
cell (ijz coordinates, see section 4.4.2.2.1) 
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Table 7.3. Relation between main parameter input files and additional Scoops3D input files needed for Scoops3D examples A 
through E.  
 
[Main parameter (.scp) files are contained in the AraiTagyo folder and the additional files are contained in the input 
subfolder] 
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7.3. Donald and Giam Embankment Configurations 

Our second set of examples uses a configuration that is also a 3D extension of examples often used for 

verification of 2D slope stability software (Donald and Giam, 1995; Rocscience Inc., 2010; Feng and Fredlund, 

2012). Examples F through J use a 10-m high embankment with a 2:1 (26.6°) slope and material properties as 

described in section 6.3.2. The five main parameter input files demonstrate: (F) homogenous material properties, 

(G) homogenous material properties with a single trial surface, (H) non-homogenous material properties with 

boundaries defined in layer files, (I) a 3D material property file, and (J) seismic loading (table 7.1). 

The five Scoops3D input files include variations of the three scenarios defined in section 6.3.2  

(table 6.11): homogeneous (Scoops3D examples F and G; Donald and Giam [1995] example 1a), non-

homogeneous (Scoops3D examples H and I, Donald and Giam [1995] example 1c), and non-homogeneous with 

seismic loading (Scoops3D example J; Donald and Giam [1995] example 1d). With the exception of one single 

trial surface analysis (example G), the search method for these files is a special case of a box search with a 2D 

cross section above the center of the embankment. For a more detailed explanation of this type of search, see the 

Arai and Tagyo embankment configurations (section 7.2). 

Two examples have main parameter input files with a simple homogeneous scenario and illustrate two 

methods of analysis: one uses a search lattice with a special case of a box search defining a 2D cross section 

(example F), and one uses a single trial surface (example G). This single surface is the global minimum from the 

search of the 2D cross section in example F. 
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Two other examples have main parameter input files and non-homogeneous material properties to 

demonstrate different methods of describing non-homogeneous properties in Scoops3D: one uses layer files 

(example H) and one uses a 3D material property file with irregular vertical spacing in ijz coordinates (example 

I). The 3D file for example I mimics the material distribution contained in the layer files of example H. The final 

example, J, uses non-homogeneous material properties with the addition of seismic loading. 

There are five main parameter input files for the Donald and Giam embankment configurations 

(described below); tables 7.4 and 7.5 describe the additional input files and their relation to each of the main 

parameter input files: 

F_emb10.scp - homogeneous material properties (Donald and Giam [1995], example 1a), 

G_emb10single.scp - homogeneous material properties (Donald and Giam [1995], example 1a), search 

method is a single surface identified as the global minimum from example F, 

H_emb10nonhomog.scp - non-homogeneous material properties (Donald and Giam [1995], example 1c), 

subsurface material properties are defined in the main parameter input file, and elevations for the bottom 

of each material are defined in layer files, 

I_emb10nonhomog3D.scp - non-homogeneous material properties (Donald and Giam [1995], example 

1c), subsurface material properties and elevations are defined in a 3D material properties file formatted 

for Scoops3D with ijz coordinates, and 

J_emb10nonhomogeq.scp - non-homogeneous material properties (Donald and Giam [1995], example 

1c), subsurface material properties are defined in the main parameter input file, elevations for the bottom 

of each material are defined in layer files with addition of horizontal seismic loading (Donald and Giam 

[1995], example 1d). 

  



 

 208 

Table 7.4. List of additional input files for Scoops3D examples F through J.  
 
[Examples use a 10-m high, 2:1 embankment configuration (Donald and Giam, 1995). Files are contained in the input 
subfolder of the DonaldGiam folder] 
 

File name File type Description 
emb10DEM.asc Grid Ground-surface elevations (DEM), 10 m high embankment with 2:1 slope 

emb10layer_1.asc Grid Bottom elevation of layer 1 

emb10layer_2.asc Grid Bottom elevation of layer 2 

emb10mat3D.txt 3D  3D material property file defining the material properties equivalent to the layer 
files (ijz coordinates, see section 4.4.2.2.1). 

 

Table 7.5. Relation between main parameter input files and additional Scoops3D input files needed for Scoops3D examples F 
through J.  
 
[Main parameter (.scp) files are contained in the DonaldGiam folder and the additional files are contained in the input 
subfolder] 
 

  emb10DEM.asc emb10layer_1.asc emb10layer_2.asc emb10mat3D.txt 
F_emb10.scp x 

   
G_emb10single.scp x 

   
H_emb10nonhomog.scp x x x 

 
I_emb10nonhomog3D.scp x 

  
x 

J_emb10nonhomogeq.scp x x x 
 

 

7.4. Symmetric Cone Configurations 

These five examples use main parameter input files (examples K through O) with a 1000-m high cone 

having a 30° slope and a wide range of material strengths, as presented in section 6.2.2. The examples illustrate 

three different sets of values for homogeneous material properties, two types of searches, and the use of a 

groundwater configuration described by a pore-pressure ratio, ru (table 7.6). 

These examples demonstrate how the parameters for a thorough search can vary depending on the λ value 

(equation 5.1) of the material properties (sections 5.3.1 and 5.3.5). The examples use three different combinations 

of material properties listed in table 6.5; relatively high cohesive strength or high λ (example K; λ = 1.0), 

intermediate λ (examples L, N, O; λ = 0.125), and low λ (example M; λ = 0.025) (table 7.6).
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Table 7.6. Summary of main parameter input files for cone configurations with different values of λ (Scoops3D examples K through O).  
 
[Input files are contained in the cone folder. m, meter] 

 

Example Main parameter input file λ Groundwater 
configuration 

Full DEM 
search 

Vertical extent of 
search lattice (m) 
(zsmin, zsmax) 

Volume criteria 
(vmin, vmax) (m3) 

K K_conehi.scp 1.00 None No 1,000–2,000 1×107 m3 – 1×1010  

L L_conemed.scp 0.125 None No 1,200–2,200 1×106 m3 – 1×109 

M M_conelo.scp 0.025 None No 1,900–2,800 1×106 m3 – 1×109 

N N_conemedfullsearch.scp 0.125 None Yes 1,200–2,200 1×106 m3 – 1×109 

O O_conemedru.scp 0.125 Pore-pressure ratio, ru No 1,200–2,200 1×106 m3 – 1×109 
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For the scenario with the lowest λ (cohesive strength is low relative to frictional strength), we expect a 

smaller, shallower trial surface for the global minimum (example M). Thus, the rotational center for this 

minimum surface will be located at a relatively high elevation compared to the scenarios with larger values of λ, 

and example M has a higher vertical extent for its search lattice (table 7.6). Likewise, example M, with lower λ, 

uses smaller minimum and maximum volume limits for its search. In contrast, example K has a higher λ value 

with higher minimum and maximum volume limits. The difference in search parameters can be seen by 

comparing the two files K_cone30hi.scp and M_cone30lo.scp. The files may be viewed side by side in a text 

editor, or by opening the Search Configuration window in Scoops3D-i for each .scp file. Determination of the 

optimal search values is usually found by trial and error, but tips for performing an optimal search are contained 

in chapter 5. 

We provide two variations of a box search for the intermediate λ value examples: a search of a 2D cross 

section above the center of the cone (example L) and a more thorough search of the full cone-shaped DEM 

(example N). The first search is designed to identify the global minimum F in symmetric topography, whereas the 

second search will identify the minimum F for every DEM cell but requires more computational time. For a more 

detailed explanation of the cross-section search, see the Arai and Tagyo embankment in section 7.2. Our final 

variation using intermediate λ (example O) demonstrates the addition of pore-water pressure effects using a pore-

pressure ratio, ru. 

There are five main parameter input files for these cone examples, as summarized below. All 

configurations use a 1,000-m high cone DEM with a 30° slope (cone1000DEM.asc). Note that the vertical extent 

of the searches and the volume limits vary depending on λ. There are no additional input files. 

K_conehi.scp - λ = 1.0, search for global minimum F using 2D cross section, vertical extent of search 

lattice ranges from 1,000 to 2,000 m, volume limits range from 1×107 m3 to 1×1010 m3, 

L_conemed.scp - λ = 0.125, search for global minimum F using 2D cross section, vertical extent of search 

lattice ranges from 1,200 to 2,200 m, volume limits range from 1×106 m3 to 1×109 m3, 

M_conelo.scp - λ = 0.025, search for global minimum F using 2D cross section, vertical extent of search 

lattice ranges from 1,900 to 2,800 m, volume limits range from 1×106 m3 to 1×109 m3, 

N_conemedfullsearch.scp - λ = 0.125, thorough search of entire DEM, and 

O_conemedru.scp - λ = 0.125, = 0.2, search for global minimum F using 2D cross section, vertical 

extent of search lattice ranges from 1,200 to 2,200 m, volume limits range from 1×106 m3 to 1×109 m3. 
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7.5. Seattle DEM Examples 

We provide two examples (P and Q) that illustrate the use of stratigraphic layers for the Duwamish Head 

region of southwestern Seattle, Washington, with and without 3D pore-pressure head data. The stratigraphic 

layers represent a 3D geologic model (Brien and Reid, 2007; 2008) derived from geologic mapping of the region 

(Troost and others, 2005). The groundwater configuration is derived from a 3D groundwater flow simulation 

using the model, MODFLOW-2000 (Harbaugh and others, 2000). The output from this groundwater flow model 

was interpreted to create a 3D pressure-head file for Scoops3D (Brien and Reid, 2007; 2008). Input files for these 

examples include a 10-ft resolution DEM, layer files, a 3D pressure-head file, and a search file to limit the 

horizontal extent of the initial coarse search lattice. 

The examples contain two scenarios: non-homogeneous material properties using layer files with no 

groundwater (example P) and the same case with a groundwater configuration defined in a 3D pressure head file 

(example Q). In both scenarios the area of interest is the steep coastal bluffs, and therefore the horizontal search 

extent is limited in two ways: (1) the DEM is clipped from the original rectangular DEM to include only the area 

of interest, and (2) the initial coarse search is limited by a search file that restricts the search space to the area of 

interest. 

There are two main parameter input files for the Seattle scenarios (summarized below); tables 7.7 and 7.8 

describe the additional input files and their relation to the main parameter input files: 

P_seadry.scp – non-homogeneous material properties, subsurface material properties are defined in the 

main parameter input file; elevations for the bottom of each material are defined in layer files; initial 

coarse search is restricted by a search file and 

Q_seawet.scp – non-homogeneous material properties, subsurface material properties are defined in the 

main parameter input file; elevations for the bottom of each material are defined in layer files; 

groundwater configuration is specified in a 3D pressure-head file; initial coarse search is restricted by a 

search file. 
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Table 7.7. List of additional input files for the Scoops3D Seattle examples P and Q.  
 
[Files are contained in the input subfolder of the Seattle folder. The .prj file provides coordinate system information for the 
user, but is not used by Scoops3D] 
 

File name File 
type Description 

seaclipDEM.asc Grid Ground-surface elevations (DEM), southwest Seattle (clipped to region of 
interest) 

seaclipDEM.prj Text Coordinate system and projection information for DEM 

sealayer_1.asc Grid Bottom elevation of layer 1 

sealayer_2.asc Grid Bottom elevation of layer 2 

sealayer_3.asc Grid Bottom elevation of layer 3 

seaphead3D.txt 3D  3D pressure-head file 

seasearch.asc Grid Horizontal locations for initial coarse search-lattice nodes 

 

 

Table 7.8. Relation between main parameter input files and additional Scoops3D input files needed for Scoops3D Seattle 
examples P and Q.  
 
[Files are contained in the input subfolder of the Seattle folder] 
 

  seaclipDEM.asc sealayer_1.asc sealayer_2.asc sealayer_3.asc seaphead3D.txt seasearch.asc 
P_seadry.scp x x x x  x 

Q_seawet.scp x x x x x x 

 

7.6. Mount St. Helens DEM Example 

We also include an example (R) that uses a real-world DEM for Mount St. Helens, Washington, prior to 

the May 18, 1980, collapse and eruption. The DEM represents the topography of the deformed volcano edifice 

(bulge on north flank) as it existed a few days prior to its catastrophic collapse (see Reid and others [2000] for 

details). Deformed topography is based on topographic contours derived from aerial photographs taken on May 

12, 1980. The example configuration uses homogeneous material properties with no groundwater. Output files 

from this example are used for illustration in section 4.5.1. 
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This example demonstrates the advantages of resampling the original DEM to a coarser resolution to 

reduce runtime. Whereas the original 30-m DEM provides higher resolution topography, it is unnecessary to use 

topography with this level of detail to search for large (0.10 to 3.5 km3) potential failure masses. To reduce 

computer memory requirements and runtime, and still provide a sufficient number of columns for accurate 

computation of factors of safety and volumes, we resampled the 30-m DEM to 100 m using the ArcMap toolbox 

resample tool with cubic convolution option (http://www.esri.com/software/arcgis). Both DEMs are provided in 

the input subfolder of this example for comparison and their names are listed in table 7.9. There is one main 

parameter input file for the St. Helens example: 

R_sthel.scp - homogeneous material properties, search parameters optimized for a balance between good 

solution quality and faster runtime, uses the 100-m resolution DEM (file name: sthel_res100mDEM.asc). 

 

Table 7.9. List of different resolution DEMs of the Mount St. Helens edifice showing north flank deformation prior to the 1980 
collapse.  
 
[Files are contained in the input subfolder of the StHelens folder. The 100-m DEM is used in example R. The .prj file 
provides coordinate system information for the user, but is not used by Scoops3D] 
 

File name File type Description 
sthel_res30mDEM.asc Grid Ground-surface elevations (DEM), Mount St. Helens, 30-m 

resolution 

sthel_res100mDEM.asc  Grid Ground-surface elevations (DEM), Mount St. Helens, 100-m 
resolution 

sthelDEM.prj Text Coordinate system and projection information for DEM 
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Glossary of Selected Terms 
Active column: A column (full or partial) that is used for the computation of volume, area, and factor of safety, F, 
of a potential failure mass. Full columns include all four corners of a digital elevation model (DEM) cell whereas 
partial columns, located around the edges of the potential failure mass, include two or three corner nodes. (See 
section 2.1). 

Critical node, or critical lattice node: A point in the three-dimensional (3D) search lattice that defines the rotational 
center of the critical surface for a given DEM cell. (See section 3.2.2). 

Critical size (volume or area): Size of the potential failure mass associated with a given critical surface. Critical 
size is specified in units of either volume or horizontal area depending on the user-specified primary size 
criterion. (See section 3.2). 

Critical surface, or critical trial surface: The trial surface with the lowest factor of safety, F, for a given DEM cell. 
A DEM that has been thoroughly searched will be affected by many critical surfaces. (See section 3.2). 

Global minimum F: Factor of safety, F, for the least-stable (lowest value of F) critical surface found during a 
Scoops3D search. (See section 3.2). 

Overall fall direction: Azimuthal direction defined by the average ground-surface slope of all full columns 
contained within a potential failure mass. Scoops3D always computes a factor of safety for potential slip  
in this direction. The user may specify other potential slip directions relative to the overall fall direction.  
(See sections 2.1 and 4.4.1.1.9.1). 

Parameter-line pair or line pair: Data input structure in the main parameter input file for Scoops3D. The first line 
of each line pair contains descriptor text; the first word of this line is the parameter-line ID. The second line of 
each pair contains the data. Both lines must be present for valid input. (See section 4.4.1). 

Potential failure mass: The predefined mass used for calculating factor of safety, F, in a limit-equilibrium slope-
stability analysis. In Scoops3D, a potential failure mass is composed of the 3D columns (both full and partial) 
above a trial surface and beneath the DEM surface. For a given search, potential failure masses must have sizes 
(volume and [or] area) within user-specified limits. (See sections 2.1 and 4.4.1.1.10). 

Rotational center: Location of the center of a sphere (above a DEM) used to create a trial surface underlying a 
DEM. A given sphere may intersect the DEM in multiple locations, thereby creating multiple trial surfaces. Each 
rotational center may be used to form multiple spheres of different radii. Typically, rotational centers are located 
at nodes within a search lattice.  Note that Scoops3D computes moment equilibrium of a potential failure mass 
that rotates around a horizontal axis through the rotational center. (See sections 2.3 and 3.2). 

Search lattice:  Orthogonal 3D array of rotational center nodes (points) located above a DEM. Each node is 
centered above a DEM cell and typically represents the rotational center for multiple trial surfaces. Horizontal 
and vertical lattice-node spacing is specified by the user. Scoops3D assesses the stability of all parts of a DEM by 
systematically analyzing the slope stability of trial surfaces created at each node in the search lattice. (See 
sections 3.2 and 4.4.1.1.9). 

Trial surface, or trial slip surface: The predefined potential failure or slip surface used for calculating factor of 
safety, F, in a limit-equilibrium slope-stability analysis. Scoops3D uses trial surfaces composed of parts of a 
sphere defined by a rotational center, and assumes rotational slip. (See chapter 2 and section 4.4.1.1.9). 
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